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Загальні відомості 
 
 

 

− - Виріб має маркування ЄС «CE-0124» 

відповідно до Директиви Ради ЄС 

93/42/EEC щодо медичних виробів та 

виконує основні вимоги Додатка I цієї 

Директиви. 

 

Виріб є пристроєм класу IIб (Медичне 

обладнання). 

 
-  Інструкція з використання - невід'ємна 

частина пристрою. Вона завжди має 

зберігатися поруч з пристроєм. Вивчення 

інструкції - обов'язкова умова належного 

функціонування обладнання і правильної 

роботи з ним. 

 
-  Безпека оператора, зазначена точність 

вимірювань і робота без перешкод можуть 

бути гарантовані тільки при використанні 

оригінальних виробів і компонентів. Крім того, 

тільки приналежності, перераховані в цій 

інструкції, схвалені компанією PTW-Freiburg, і 

тільки вони або інші приналежності, 

використання яких явно дозволено компанією 

PTW-Freiburg, можуть використовуватися в 

комбінації з пристроєм. Безпечна робота і 

належні робочі характеристики системи не 

гарантуються, якщо використовуються 

приналежності або витратні матеріали інших 

виробників. 

 
-  Компанія PTW-Freiburg не може нести 

відповідальність за збитки, що виникли в 

результаті використання аксесуарів та 

витратних матеріалів інших виробників або в 

результаті ігнорування користувачем 

інструкцій і інформації, наведених в цій 

інструкції. 

- Гарантійний період складає 1 (один) рік з дня 

поставки. На цей термін не впливають 

ремонти, охоплені положеннями гарантії. 

 
-  Компанія PTW-Freiburg вважає себе 

відповідальною за безпеку, надійність і робочі 

характеристики даного пристрою тільки в 

тому випадку, якщо його збірка, підключення, 

остаточне регулювання, зміна або ремонт 

виконувалися компанією PTW-Freiburg або 

особами, уповноваженими компанією PTW- 

Freiburg, і якщо пристрій використовується 

відповідно до технічної документації. 

 
-  У випадку будь-яких питань щодо 

обслуговування, технічної підтримки або 

гарантії, слід звернутись до постачальника. 

 
-  Ця інструкція відповідає програмному 

забезпеченню VeriSoft (з номером версії, 

зазначеним на титульній сторінці) на дату 

друку інструкції. На пристрої, схеми, методи, 

програмне забезпечення та найменування, 

згадані в інструкції, всі права захищені. 

 
-  Windows є товарним знаком корпорації 

Microsoft. 

 
-  Компанія PTW-Freiburg залишає за собою 

право вносити зміни. 

Для отримання нових відомостей про 

конкретний виріб звертайтеся в компанію 

PTW або її місцеве торгове представництво. 

 
-  Програмне забезпечення для роботи з 

матрицею детекторів та верифікації планів 

IMRT та VMAT. 



 
 
 

 

 
-  Компанія PTW-Freiburg є зареєстрованим 

виробником згідно з законом ElektroG 

(Elektro- und Elektronikgeräte-Gesetz). 

Реєстр виробників / імпортерів і випущеного 

на ринок Німеччини обладнання (EAR). 

Реєстраційний номер DE15599992. 

 
-  Компанія PTW-Freiburg працює в строгій 

відповідності з системою управління якістю, 

яка постійно оновлюється відповідно до 

національних і міжнародних стандартів. 

 
Виробник: 

 
Компанія "PTW-Freiburg" Physikalisch- 

Technische Werkstätten Dr. Pychlau GmbH 

Lörracher Straße 7 

79115 Freiburg 

Germany 

/ ПТВ-Фрайбург Фюзікаліш-Техніше 

Веркштеттен Др. Пихлау ГмбХ 

Лоррахер Штрассе 7, 79115 Фрайбург, 

Німеччина / 

 
Tel .: +49 761 49055-0 

Факс: +49 761 49055-70 

info@ptw.de 

www.ptw.de 

 
Made in Germany/Виготовлено в Німеччині 

 
 

 
Уповноважений представник та імпортер в 

Україні: 
 

UA.TR.099 

 

ТОВ «Канберра Паккард» 

Адреса: вул. Грушевського, буд. 28/2, нежиле 

приміщення № 43, м. Київ, 01021, Україна 

Телефон: +38 (044) 2496317 

E-mail: cpua@cpce.net 
 

 

Дата останнього перегляду інструкції з 

використання: травень 2021 р. 
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1. Галузь застосування 
 

 
Програма VeriSoft є частиною системи PTW 

OCTAVIUS. 

 

 
Галузь застосування системи PTW 

OCTAVIUS 

 
Система PTW OCTAVIUS використовується 

для дозиметричних вимірювань на системі 

променевої терапії, наприклад медичному 

лінійному прискорювачі (linac), в електронних 

або фотонних пучках, на системі 

корпускулярної терапії або на терапевтичній 

системі з кобальтом-60. Система OCTAVIUS 

призначена для вимірювання розподілів дози і 

їх порівняння з даними, розрахованими 

системою планування променевої терапії 

(перевірка плану променевої терапії пацієнта), 

і (або) для проведення періодичних процедур 

забезпечення якості (QA), наприклад 

перевірок стабільності, відповідно до плану 

забезпечення якості, складеного 

відповідальним фахівцем з медичної фізики. 

 

 
Опис пристрою 

 
Система OCTAVIUS складається з 

двовимірного матричного детектора на основі 

іонізаційних камер, які рівномірно розподілені 

у вигляді матриці, і окремого інтерфейсу 

детектора, призначеного для збору даних. 

Цей матричний детектор можна поміщати як в 

статичний кубовидний або октагональний 

фантом, так і в лінійний фантом, що 

обертається. Для вимірювання 

випромінювання від джерел випромінювання, 

що рухаються, (наприклад, гентрі лінійного 

прискорювача, що обертається) фантом, який 

обертається, приводиться в обертання, 

синхронне з обертанням гентрі. Закріплений 

на гентрі інклінометр передає значення кута 

гентрі, які використовуються для 

вирівнювання обертового матричного 

детектора з гентрі. Система OCTAVIUS 

управляється програмою, яка відображає і 

обробляє дані. 

 

 
Показання 

 

Система OCTAVIUS призначена для збору 

даних про пучок випромінювання для 

перевірки плану променевої терапії пацієнта, 

створеного системою планування променевої 

терапії, а також у зв'язку з процедурами 

забезпечення якості роботи апарату в 

наступних цілях: 

 

- перевірка плану променевої терапії пацієнта з 

модуляцією інтенсивності (IMRTта VMAT); 

-  періодичні процедури забезпечення якості, 

наприклад перевірки стабільності; 

- аналіз даних пучка відповідно до міжнародних 

дозиметричних протоколів; 

-  вимірювання після ремонту або заміни 

основних компонентів системи променевої 

терапії. 
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Протипоказання 

 
Система OCTAVIUS призначена для цілей 

забезпечення якості і не повинна 

використовуватися в присутності пацієнта. 

 
Вона не повинна використовуватися в 

променевій діагностиці. 

Результати вимірювань призначені для 

перевірки плану променевої терапії пацієнта і 

не повинні використовуватися для управління 

системою променевої терапії за допомогою 

імпорту даних в план променевої терапії 

пацієнта. 

 

 
Можливі користувачі 

 
Система OCTAVIUS повинна 

використовуватися тільки кваліфікованим 

персоналом - як правило, фахівцем з медичної 

фізики, відповідальним за систему променевої 

терапії, або уповноваженою особою. 

Загальні відомості про застосування 

 
Програмне забезпечення VeriSoft призначене 

для наступної мети в променевої терапії: 

 
- Перевірка плану променевої терапії методом 

IMRT (променева терапія з модуляцією 

інтенсивності) шляхом порівняння плану, 

розрахованого системою планування 

променевої терапії (TPS), і вимірювань дози. 

 

 
Програма VeriSoft порівнює матриці виміряних 

доз (наприклад, матриці матричного детектора 

PTW) з відповідними розрахунковими 

матрицями (від систем планування 

променевої терапії) і перевіряє дозу IMRT. 

Розподіл доз і порівняння аналізуються 

чисельно і графічно. 

 
Додатковий програмний модуль DVH 4D може 

використовуватися для розрахунку гістограм 

об'ємного набору доз (DVH) на основі 

вимірювань за допомогою детектора 

OCTAVIUS 4D і порівняння цих гістограм з 

аналогічними гістограмами системи 

планування променевої терапії (TPS). 

 

Для вимірювань з програмою VeriSoft можуть 

використовуватися такі матричні детектори 

PTW: 

 
- OCTAVIUS Detector 729 

- OCTAVIUS Detector 729XDR 

- OCTAVIUS Detector 1000SRS 

- OCTAVIUS Detector 1500 

- OCTAVIUS Detector 1500XDR 

- OCTAVIUS Detector 1500MR 

- 2D-ARRAYseven29 

- 2D-ARRAYXDR 



 

 

Крім того, можна використовувати наступні 

приналежності PTW: 

 
-  Поворотний блок (стандартна або 

модульна версія) з блоком управління та 

інклінометром, наприклад апаратні 

компоненти системи OCTAVIUS 4D 

 
- Інклінометр 

 

 
Примітка. Відповідно до законодавства США 

продаж даного виробу дозволяється 

лише за призначенням або 

замовленням лікаря. 
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НЕБЕЗПЕЧНО 

ОБЕРЕЖНО 

ПОПЕРЕДЖЕННЯ 

УВАГА 

ПРИМІТКА 

 
 

 

2. Інформація з техніки безпеки 
 
 

 

Це символ попередження, що 

стосується техніки безпеки. Він 

використовується, щоб попередити 

користувача про потенційні небезпеки. 

Дотримуйтесь умов всіх повідомлень з 

техніки безпеки, які йдуть за цим 

символом, щоб уникнути можливого 

отримання травм або пошкодження 

обладнання. 

 
Всі повідомлення з техніки безпеки 

складаються з наступних компонентів: 

 
- Символ попередження, що стосується техніки 

безпеки, і сигнальне слово 

- Тип небезпеки 

- Джерело небезпеки 

- Наслідки 

- Заходи щодо запобігання небезпеки. 

Сигнальні слова 

 

Вказує загрозливу небезпеку. Якщо не вжити 

заходів щодо запобігання цієї небезпеки, то 

результатом буде смерть або тяжка травма. 
 

 

Вказує на небезпеку. Якщо не вжити заходів 

щодо запобігання цієї небезпеки, то 

результатом може бути смерть або тяжка 

травма. 
 

 

Вказує потенційну небезпеку. Якщо не вжити 

заходів щодо запобігання цієї небезпеки, то 

результатом може бути легка травма або 

травма середньої тяжкості. 
 

 

 

 

Вказує потенційну небезпеку. якщо не вжити 

заходів щодо запобігання цієї небезпеки, то 

результатом може бути пошкодження 

пристрою. 
 

 

Наводиться корисна інформація, яка 

допомогає максимально використовувати 

можливості обладнання. 
 

 



ОБЕРЕЖНО 

ОБЕРЕЖНО 

 
 
 
 

 

Інформація з техніки безпеки для 

програмного забезпечення 

 
 

Небезпеки, що виникають від інших 

компонентів системи. 

 
Неправильне використання 

 
Дотримуйтесь правил техніки безпеки, 

наведені в інструкціях з використання 

компонентів системи. 
 

 
 

Використання VeriSoft особами з недостатньою 

кваліфікацією. 

 
Неправильне використання 

 
Використовуйте VeriSoft лише в тому випадку, 

якщо ви знайомі з програмним забезпеченням і 

пройшли необхідне навчання або маєте досвід 

застосування таких програм, а також володієте 

достатньою компетенцією для прийняття 

рішень, пов'язаних з правильним 

застосуванням. 

 
Це включає в себе наступні дії: 

- визначення параметрів вимірювань і аналізу; 

- визначення рівнів допуску; 

- вибір протоколів корекції відповідно до різних 

стандартів; 

-  вибір або генерування таблиць поправок 

відповідно до різних стандартів; 

-  аналіз та перевірка достовірності результатів 

вимірювань та аналізу, отриманих за 

допомогою програмного забезпечення; 

-  представлення програмного забезпечення 

співробітникам відділення; 

-  інструктаж персоналу щодо виконання 

вимірювань. 

 

 

ПК з VeriSoft може впливати на передачу 

даних інших станцій в мережі. 

 
Мережеві проблеми! 

 
При комп'ютерному управлінні VeriSoft через 

інтерфейс Ethernet, підключайте прилад до 

мереж передачі даних тільки в тому випадку, 

якщо перебої в функціонуванні цих мереж не 

поставлять під загрозу безпеку пацієнтів, 

оператора або інших осіб. 

 
Підключення комп'ютера до мереж передачі 

даних повинне здійснюватися тільки 

мережевим адміністратором. 

 
Вимоги по підключенню медичних приладів 

до клінічних мереж передачі даних див. в 

стандартах EN 80001-1 (IEC 80001-1). 
 

 
 

ОБЕРЕЖНО 
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Вплив іншого програмного забезпечення. 

 
Неправильне функціонування! 

 
Якщо на комп'ютері будуть встановлені будь- 

які програми, крім VeriSoft або програм, 

схвалених PTW-Freiburg, компанія PTW- 

Freiburg не нестиме відповідальність за 

пов'язані з цим проблеми 

 
роботі комп'ютера. Крім того, компанія PTW- 

Freiburg не може гарантувати правильну 

роботу в тому випадку, якщо на комп'ютері 

були раніше встановлені програми інших 

виробників, які не були повністю видалені. 

 
Для правильного функціонування VeriSoft 

простежте за тим, щоб на комп'ютері була 

встановлена тільки одна версія даного 

програмного забезпечення. 
 

 

Використання в поєднанні з невідповідними 

системними компонентами. 

 
Неправильне використання 

 
Програмне забезпечення VeriSoft слід 

встановлювати тільки на комп'ютери, що 

відповідають вимогам стандарту EN 60950-1 

(IEC 60950-1). 

 
Переконайтеся, що ПК задовольняє 

мінімальним вимогам, зазначеним в розд. 3.1 

"Мінімальні системні вимоги". 

 
Комп'ютер не повинен використовуватися в 

безпосередній близькості від пацієнтів. 

 
Використовуйте VeriSoft тільки в поєднанні з 

обладнанням компанії PTW, зазначеним в 

розд. "Галузь застосування". 

Компанія PTW рекомендує регулярно робити 

резервні копії даних системи VeriSoft. 

 
Ці дані можуть розташовуватися, наприклад, в 

каталогах 

<PTW documents> \ VeriSoft \ Data і <PTW 

application files> \ VeriSoft \ VeriSoft \ 

BatchProcess 

 
(Див. Розд. 3.5 "Зберігання даних"). 

 

 

 

Дотримуйтесь вказівок інструкцій з 

використання всіх підключених компонентів. 

 

 
 

 
Символи на установчому диску CD / DVD 

 

 
Символ Опис 

 

  Див. Інструкцію з використання! 

 

Цей виріб атестовано знаком 

  відповідності нормам ЄС 

(знак «CE»). 
 

 

 
Виробник і дата 

виготовлення 
 

 
Номер за каталогом 

 

 

ПОПЕРЕДЖЕННЯ ПРИМІТКА 

 

 
UA.TR.099 

Національний знак відповідності 

медичних виробів вимогам 

Технічного регламенту щодо 

медичних виробів, затвердженого 

постановою Кабінету Міністрів 

України від 02.10.2013 №753 
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Обмеження відповідальності 

 
VeriSoft розроблялася і тестувалася з усією 

можливою ретельністю. Разом з тим, 

компанія PTW-Freiburg не може гарантувати, 

що програма повністю вільна від помилок. 

 
Компанія PTW-Freiburg ні в якому разі не несе 

відповідальності за наслідки, що виникли в 

результаті використання VeriSoft. Виняткову 

відповідальність за будь-які висновки, 

зроблені на основі проведених вимірювань 

і/або аналізу даних, несе користувач. 

 
Використовуючи VeriSoft, користувач 

автоматично приймає умови цієї угоди. 

 

 
Угода про оновлення і ліцензії 

 
Компанія PTW-Freiburg не зобов'язана 

оновлювати програмне забезпечення. 

При зверненні в компанію для отримання 

консультації повідомте версію програмного 

забезпечення, серійні номери периферійних 

пристроїв і дату покупки. 



 
 

 

3. Установка, запуск і завершення роботи 
програмного забезпечення VeriSoft 

 
 

 

3.1. Мінімальні системні 

вимоги 

 
Операційні системи: 

 
- Windows 7 Professional x32 / x64 

- Windows 8 / 8.1 Pro x32 / x64 

- Windows 10 Pro x32 / x64 

Повинні бути встановлені найсвіжіші пакети 

оновлень і поточні окремі оновлення. 

Повний перелік всіх операційних систем, 

схвалених для використання з цим 

програмним забезпеченням, див. в документі 

«Відомості про поточну версію» на 

установчому диску CD / DVD. 

 

 
.NET Framework 

 
.NET Framework 4.6.1 або вище 

(Автоматична установка під час 

налаштування) 

Необхідні версії .NET Framework будуть 

встановлюватись, якщо вони ще не 

встановлені в системі. 

 

 
Процесор: 

 
Багатоядерний процесор, 2,3 ГГц або вище 

 

 
Оперативна пам'ять: 

 
Мін. 4 ГБ оперативної пам'яті 

рекомендується 8 ГБ 

Жорсткий диск: 

 
Не менше 500 МБ вільного простору для 

VeriSoft і 

не менше 2 ГБ вільного простору для .NET 

Framework 4.6.1 

Може знадобитися більше вільного простору в 

залежності від загальної кількості і обсягу 

даних при завантаженні. 

 

 
Графіка: 

 
SXGA (1280 x 1024 пікселів) або більш висока 

роздільна здатність 

з включеним розміром шрифта за 

замовчуванням 

 

 
Програмне забезпечення: 

 
Програма перегляду файлів PDF 
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3.2. Установка 

 

На установчому диску CD / DVD програми 

VeriSoft знаходяться наступні установчі 

програми: 

 
- VeriSoft 

 
- Клієнтське додаток Track-it Import Client 

 
Для можливості експорту даних VeriSoft в базу 

даних Track-it обов'язково потрібно 

встановити Track-it Import Client після 

установки програми VeriSoft. 
 

 

Робота з неповною версією VeriSoft. 

 
Неправильне функціонування! 

 
Якщо під час або після установки програмного 

забезпечення буде потрібно перезапустити 

комп'ютер, слід обов'язково виконати 

перезапуск комп'ютера перед першим 

використанням програмного забезпечення, 

щоб гарантувати його правильну установку. 
 

 

Вимкніть антивірусну програму, режим 

енергозбереження і екранну заставку, щоб 

уникнути проблем під час установки ПО або 

вимірювань. 
 

 
 

Програма установки поставляється на диску 

CD / DVD. 

 
• Увійдіть в систему, використовуючи 

обліковий запис адміністратора. 

 
• Запустіть операційну систему Windows на 

комп'ютері і закрийте всі запущені 

програми. 

 
• Вставте диск CD / DVD в дисковод для CD 

/ DVD (наприклад, дисковод з позначенням 

D: \). 

 
• У Провіднику Windows відкрийте каталог на 

диску CD / DVD. 

 
• Почніть установку, запустивши файл 

setup.exe. 

 

➔ Установча програма запуститься і 

встановить програмне забезпечення на 

жорсткий диск комп'ютера. 

• Дотримуйтеся інструкцій на екрані. 



 
 
 

 

➔ На екрані з'явиться вікно Setup Type 

(Тип установки). 
 

 
Малюнок 1.  Вікно типу установки 

 
• У вікні Setup Type (Тип установки) виберіть 

тип установки Custom (Вибіркова) або 

Complete (Повна) (або програму VeriSoft). 

 
Компанія PTW-Freiburg рекомендує вибрати 

тип установки Complete (Повна), особливо в 

тому випадку, якщо ви використовуєте 

програму вперше. 

При виборі типу установки Complete (Повна), 

наявні програми будуть встановлені в каталог 

C:\Program Files(x86)\. 

 
Щоб задати інший каталог, виберіть тип 

установки Custom (Вибіркова). Програма 

установки рекомендує використовувати 

каталог C:\Program Files(x86)\ як кінцевий. 

Щоб задати інший каталог виберіть команду 

Change (Змінити). 

Підтвердіть вибір за допомогою кнопки OK. 

Якщо вказаний каталог ще не існує, він буде 

створений. 

 
• Натисніть кнопку Next (Далі), а у вікні, що 

з'явилося, натисніть кнопку Install 

(Встановити), щоб почати установку. 

 
➔ VeriSoft буде встановлений. 

➔ По завершенні установки з'явиться вікно 

Program Registration (Реєстрація 

програми). 

 

 
Малюнок 2.  Вікно реєстрації програми 

 
• У вікні Program Registration (Реєстрація 

програми) введіть відомості про користувача і 

ліцензійний код (див. наклейку на установчому 

диску CD/DVD). Підтвердіть введені дані, 

натиснувши кнопку Register (Реєстрація). 

 

Якщо дані, введені при установці, виявляться 

неправильними, на екрані з'явиться відповідне 

повідомлення. Вікно Program Registration 

(Реєстрація програми) буде залишатися 

відкритим, і в ньому можна буде повторно 

ввести реєстраційні дані або перервати 

реєстрацію програми, натиснувши кнопку 

Demo or existing license (Демонстрація або 

наявна ліцензія). У цьому випадку буде 

ліцензована демонстраційна версія 

програмного забезпечення, яку можна 

використовувати протягом 30 днів. 

Інформацію для ліцензування можна ввести в 

подальшому за допомогою центру управління 

ліцензіями PTW (див. Розд.4 "Ліцензування 

VeriSoft "). 
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Якщо на комп'ютері вже була встановлена 

попередня версія з діючою ліцензією, 

перервіть процес реєстрації, натиснувши 

кнопку Demo or existing license (Демонстрація 

або наявна ліцензія). В цьому випадку 

продовжить діяти ліцензія від колишньої 

встановленої версії. Пам'ятайте, що це 

стосується лише тих випадків, коли основний 

номер попередньої і нової версій збігається. 

 
• Встановіть клієнтську програму Track-it 

Import Client, якщо ви маєте намір 

експортувати дані VeriSoft в базу даних Track- 

it. 

3.3. Відновлення 

та видалення 

 
Можна видалити програму VeriSoft або 

відновити її, виправивши помилки установки. 

 
• Виберіть Start → Settings → Control panel 

(Пуск - Налаштування - Панель управління). 

 
• Двічі клацніть на пункті Add/Remove 

Programs (Установка й видалення програм). 

 
• Виберіть VeriSoft і натисніть кнопку Change 

(Змінити). 

 
➔ На екрані з'явиться вікно Program 

Maintenance (Обслуговування 

програми). 
 

 

Малюнок 3. Вікно обслуговування 
програми 

 
У вікні обслуговування програми 

пропонуються наступні варіанти: 

 
Modify Зміна параметрів 

(Змінити) установки 

 
Repair Перевірка і відновлення 

(Відновити) установки 

 
Remove Видалення програмного 

(Видалити) забезпечення 
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3.4. Резервне 

копіювання даних і 

відновлення резервної 

копії 

 
Щоб уникнути втрати даних, наприклад в разі 

поломки комп'ютера, рекомендується 

регулярно проводити резервне копіювання 

даних. 

 
Дані можуть перебувати, наприклад, в 

каталогах 

<PTW documents>\VeriSoft\Data і 

<PTW application files>\VeriSoft\VeriSoft\ 

BatchProcess. 
 

Щоб уникнути втрати даних при їх 

переміщенні, рекомендується використо- 

вувати для цього функції Copy/Paste 

(Копіювати / Вставити) і Delete (Видалити), а 

не функції Cut (Вирізати) і Paste (Вставити). 
 

 

 

3.5. Збереження даних 

 
Зберігаючи дані, обов'язково записуйте їх в 

загальнодоступні каталоги. Інакше дані будуть 

збережені в віртуальному каталозі 

(«віртуалізація»). Такі дані в обраному 

каталозі для зберігання не будуть доступні 

іншим користувачам або програмі Windows 

Explorer (Провідник). 

 
Якщо відповідні файли, що мають відношення 

до PTW, існують, вони будуть збережені в 

наступні каталоги: 

 
▪ <Файли додатків PTW> 

наприклад файли конфігурації або файли 

ініціалізації 

 
Каталог: 

C: \ ProgramData \ PTW 

 
▪ <PTW documents> 

наприклад, демонстраційні дані, дані 

вимірювань або дані аналізу 

 
Каталог: 

C: \ Users \ Public \ Public Documents \ PTW 
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3.6. Запуск 
 
• Натисніть кнопку Windows Start (Пуск) 

→ Programs (Програми) 

→ значок PTW 

→ VeriSoft 

→ VeriSoft. 

 
➔ В ліцензованій версії програмного 

забезпечення з'явиться вікно з ім'ям 

користувача і версією. Буде відкрито 

основне вікно (див. Розд.7 "Основне вікно"). 

У неліцензованій версії спочатку з'явиться 

вікно з кнопкою License (Ліцензія), за 

допомогою якої можна викликати Центр 

управління ліцензіями PTW. 

 
 
 

• Також можна запустити програмне 

забезпечення, використовуючи навігатор 

MEPHYSTO. 

 

3.7. Вихід 

 
Вихід з програми VeriSoft можна здійснити 

кількома способами: 

 
• Виберіть пункт меню File → Exit (Файл - 

Вихід). 

 
• Натисніть стандартне для Windows клавіші 

Alt + F4. 

 

• Двічі клацніть на значку програми в 

заголовку основного вікна. 

 

• Клацніть на стандартній кнопці Windows 

 в рядку заголовка основного вікна. 

Якщо в програмному забезпеченні є дані, які 

ще не були збережені, на екрані з'явиться 

відповідне повідомлення, і система 

запропонує зберегти ці дані. 
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4. Ліцензування VeriSoft 
 
 

 

4.1. Процедура ліцензування 

Ліцензування може здійснюватися двома 

способами: 

 
1. Відомості про ліцензії можна ввести під час 

установки програми. У цьому випадку програма 

буде автоматично ліцензована після установки. 

 
2. Якщо дані, введені під час установки, 

виявляться некоректними, на екрані з'явиться 

відповідне повідомлення і буде ліцензована 

демонстраційна версія програми, яку можна 

буде використовувати протягом 30 днів. У цьому 

випадку інформацію для ліцензування можна 

буде ввести пізніше через Центр управління 

ліцензіями PTW (PTW License Control Center). 

 

Пробний період використання для 

демонстраційної версії починається з дня 

установки. 
 

 
Розширені версії, оновлення та демонстраційні 

версії з вичерпаним терміном дії також можна 

при необхідності ліцензувати через Центр 

управління ліцензіями PTW. 

4.2. Центр 

управління 

ліцензіями PTW 

• Натисніть кнопку Windows Start (Пуск) 

→ Program Files 

→ PTW 

→ значок License Control Center (Центр 

управління ліцензіями). 

➔ На екрані з'явиться вікно центру 

управління ліцензіями PTW (див. 

малюнок 4). 
 

В діалоговому вікні License Control Center 

виводяться всі додатки компанії PTW, 

встановлені на комп'ютері в даний час. Якщо 

при натисканні на назві програми кнопка 

Register (Реєстрація) виявляється 

неактивною, це означає, що ліцензування 

необхідно виконати з самого додатка або що 

додаток вже ліцензовано. 
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Малюнок 4.  Центр управління ліцензіями PTW 
 
 

1 Перелік всіх ліцензованих програм PTW, 

включаючи номер версії і статус ліцензії. 

Registered for ... (Зареєстровано для ...) - 

правильна реєстрація та відомості про 

користувача 

Demo expired in ... days - число днів 

використання демонстраційної версії, що 

залишилися 

Demo expired - термін використання 

демонстраціонной версії закінчився 

Unregistered - незареєстрована версія 

програми 

2 Натисніть цю кнопку, щоб викликати 

діалогове вікно реєстрації 

 
3 Натисніть цю кнопку, щоб побачити 

розширені версії програмного 

забезпечення 

 
4 Натисніть цю кнопку, щоб закрити 

центр управління ліцензіями PTW 

 

 
 

 

 



 
 
 

 

4.3. Перевірка ліцензії 

 
• У вікні центру управління ліцензіями PTW 

виберіть VeriSoft, а потім натисніть кнопку 

Options (Розширені версії). 

 

➔ На  екрані  з'явиться  діалогове  вікно 

Options (Розширені версії): 
 

 
Малюнок 5.  Діалогове вікно розширених 

версій 

 
В діалоговому вікні Options (Розширені версії) 

показана базова версія і всі розширені версії 

програми (якщо є), а також їх статус ліцензії 

(див. також малюнок 4). 

 
Клацніть на базовій або на розширеній версії, 

а потім натисніть кнопку Modules (Модулі), 

щоб викликати вікно з інформацією про 

модулі: 
 

Малюнок 6. Вікно з інформацією про модулі 
для базової версії 

4.4. Реєстрація 

VeriSoft, розширеної 

версії або оновлення 

• У вікні центру управління ліцензіями PTW 

виберіть VeriSoft, потім натисніть кнопку 

Register (Реєстрація). 

 

➔ На екрані з'явиться діалогове вікно 

Register (Реєстрація). 

 
 

 

Малюнок 7.  Діалогове вікно Register 
(Реєстрація) 

 
• Введіть відомості про користувача і 

ліцензійний ключ (див. Наклейку на 

установчому диску CD / DVD). 

 
 

 

В інформаційному вікні Modules (Модулі) 

виводиться перелік всіх модулів, включених в 

базову або розширену версію, з номерами їх 

версій. 
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5. Визначення термінів 

 
Матричні детектори 

 
В цій інструкції з використання матричні детектори згруповані в сімейства; назви сімейств наведені 

на малюнку нижче. Точна назва окремого матричного детектора використовується тільки в тому 

випадку, коли потрібно вказати відмінні риси. 

 
 
 

OCTAVIUS Detector 729 
 

  

 
 

OCTAVIUS Detector 729 
 

  

 
OCTAVIUS Detector 729XDR 

  

 

 

OCTAVIUS Detector 1000SRS 
 

 

 

OCTAVIUS Detector 1500 
 

 

 
 

 

OCTAVIUS Detector  

OCTAVIUS Detector 1500XDR 
  

OCTAVIUS Detector 1500 
 

    

  

OCTAVIUS Detector 1500MR 
 

 

 

2D-ARRAYseven29 

 

  

 
 

2D-ARRAY 
 

  

2D-ARRAYXDR 
  

 

 

 

XDR-пристрої призначені для дозиметричних застосувань з протонним і важким іонізуючим 

випромінюванням. 

 
MR-пристрої підходять для використання в магнітних полях до 1,5 Тл. 



 
 
 
 

Поворотний блок 

 
Доступні наступні варіанти поворотного блоку: 

 
   

Стандартна або модульна Модульна версія з верхом Модульна версія з верхом 

версія зі стандартним верхом SRS (малий діаметр) LINAC QA 

(Великий діаметр)   

Застосування для вимірювань Застосування для вимірювань Вимірювання за допомогою 

OCTAVIUS 4D OCTAVIUS 4D, наприклад для матричного детектора з 

 перевірки плану променевої матеріалом потовщення 5 см 

 терапії з модуляцією інтенсив- над детектором 

 ності (IMRT) в області голови  

належність належність належність 

поворотний блок поворотний блок SRS поворотний блок планарний 

 
 

 
Вимірювання OCTAVIUS 4D 

 
Вимірювання OCTAVIUS 4D - це вимірювання 

з матричним детектором в поворотному блоці. 

 

 
Типи матриць 

 
Матриця матричного детектора: 

Матриця матричного детектора містить 

значення доз, отримані вимірюванням з 

матричним детектором. 

 
 

Матриця OCTAVIUS 4D: 

Матриця OCTAVIUS 4D - один з типів матриці 

матричного детектора. Матриця OCTAVIUS 4D 

є зріз об'ємного набору доз OCTAVIUS 4D 

(див. нижче), розрахований на основі значень 

доз в вимірюваннях OCTAVIUS 4D. 

 

 
Матриця, що не має відношення до 

детектора: 

Всі інші матриці, наприклад дані з системи 

планування променевої терапії, плівки і т.д. 
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Об'ємний набір доз 

 
Об'ємний набір доз - це набір даних, що 

складаються з декількох зрізів. 

VeriSoft розрізняє такі типи: 

 
Об'ємний набір доз OCTAVIUS 4D 

Об'ємні набори доз OCTAVIUS 4D 

розраховуються на основі вимірювань 

OCTAVIUS 4D. 

 
Об'ємний набір доз з системи планування 

променевої терапії (TPS) 

Об'ємний набір доз з системи TPS містить 

дані, експортовані з системи планування 

променевої терапії. 

 

 
Порівняльна матриця і референтна 

матриця 

 
Порівняльна матриця - це, як правило, дані 

системи планування променевої терапії, 

завантажені у вікно A матриці. 

 
Референтна матриця - це, як правило, 

виміряні дані, завантажені в вікно B матриці. 

 

Недостатня доза 

 
Значення дози референтної матриці нижче 

значення дози порівняльної матриці. 

 

 
Надмірна доза 

 
Значення дози референтної матриці вище 

значення дози порівняльної матриці. 

 
 

 

Якщо завантажені матриця матричного 

детектора і матриця, яка не має відношення 

до детектора, то матриця матричного 

детектора буде використовуватися як 

референтна матриця. 

 
Якщо завантажені матриця матричного 

детектора і матриця OCTAVIUS 4D, то 

матриця матричного детектора буде 

використовуватися як референтна матриця. 

 
Якщо завантажені дві матриці матричного 

детектора, дві матриці OCTAVIUS 4D або дві 

матриці, що не мають відношення до 

детектора, то матриця B буде викорис- 

товуватися як референтна матриця. 
 

ПРИМІТКА 



 
 

 

6. Короткий опис порядку дій 
 
 
 
 

 
Якщо обидві матриці будуть виражені в 

однакових одиницях, то можна легко отримати 

різницю, виконавши тільки дії, виділені 

напівжирним шрифтом. 
 

 
1. Запустіть програму VeriSoft 

 
2. Задайте параметри: 

меню Tools → Options (Сервіс - 

Параметри) 

 
3. Завантажте матрицю A 

порівняльна матриця в вікні A матриці 

(зазвичай це дані системи планування 

променевої терапії) 

 
- відкрийте матрицю або об'ємний набір 

доз: 

кнопка Open Data Set A (Відкрити набір 

даних A) 

 
або 

 
- відкрийте перелік матриць: 

меню File → Data Set A → Open List 

(Файл - Набір даних A - Відкрити перелік) 

 

4. Завантажте матрицю B 

референтна матриця в вікні B матриці 

(зазвичай це виміряні дані) 

 
- відкрийте збережену матрицю або 

об'ємний набір доз: 

кнопка Open Data Set B (Відкрити набір 

даних B) 

 
або 

 
- виміряйте матрицю з використанням 

матричного детектора: 

- задайте параметри: 

меню Tools → Measurement Options 

(Сервіс - Налаштування вимірювань) 

- виконайте вимірювання: 

кнопка Measure Data Set B 

(Вимірювання набору даних B) 

ПРИМІТКА 
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5. Виконайте обробку матриці: 

(Вкладка Edit або меню Edit → Data Set 

A/B (Правка - Набір даних A / B) 

 
- визначте ізоцентр вручну: 

кнопка Align Manually (Вирівнювання 

вручну) 

або 

визначте ізоцентр автоматично: 

меню Edit → Align Automatically (Правка 

- Вирівнювання автоматично) 

 
- визначте область інтересу: 

кнопка ROI (Область інтересу) 

 
- відніміть фон: 

кнопка Background (Фон) 

 
- проведіть калібрування: 

кнопка Calibrate (Вирівнювання) 

 
- виконайте нормалізацію: 

кнопка Normalize (Нормалізація) 

 
- виконайте поворот або дзеркальне 

відображення: 

кнопка Rotate / Flip / Mirror (Поворот / 

Переворот / Відображення) 

 
6. Встановіть графічні параметри 

 
- визначте ізодозні рівні і кольори: 

меню Graphics → Edit Contour Settings 

(Графіка - Зміна налаштувань контурів) 

 
- визначте кольори і стилі профілів: 

меню Graphics → Edit Contour Settings 

(Графіка - Зміна налаштувань контурів) 

 
7. Виведіть на екран положення камер (тільки 

в разі матриці матричного детектора): 

меню View → Overlay Measuring Positions 

(Вид - Накладення позицій вимірювання) 

8. Виведіть на екран матриці в вікнах 

матриць. Перейдіть між графічним 

(зображення у відтінках сірого, ізодоза, 3D) 

і табличним представленнями. 

 
9. Виведіть профілі у вікні результатів. 

Перейдіть між різними представленнями. 

 
10.  Проаналізуйте матриці у вікні результатів. 

Перейдіть між гістограмою і результатами 

 
11. Проаналізуйте матриці у вікні 

порівняння 

 
- виберіть режим порівняння і встановіть 

параметри порівняння: 

вкладка Compare (Порівняння) 

 
- перейдіть між графічним і табличним 

представленнями 

 
- виберіть режим порівняння Gamma 3D і 

порівняйте розподіли доз в об'ємі: 

вкладка Compare (Порівняння) і кнопка 

Calculate Volume Analysis (Розрахунок 

аналізу об'єму) 

 
- накладіть структури тіла пацієнта: 

вкладка RTView 

 
12.  Збережіть змінені матриці: 

кнопка Save (Зберегти) 

 
13. Вийдіть з програми VeriSoft. 



 
 

 

 
 

 
 

 
 

 

7. Основне вікно 
 
 
 
 
 
 
 
 
 
 
 
 

 

4 
6 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Малюнок 8.  Основне вікно програми VeriSoft 
 
 

1 Рядок заголовка 

 
2 Рядок меню 

 
3 Вкладка для виведення спливаючого вікна 

 
4 Вікно A матриці (порівняльна матриця, 

зазвичай це дані системи планування 

променевої терапії) з панеллю 

інструментів і рядком стану 

5 Вікно B матриці (референтна матриця, 

зазвичай це виміряні дані) з панеллю 

інструментів і рядком стану 

 
6 Вікно результатів з панеллю 

інструментів і рядком стану 

 
7 Вікно порівняння з панеллю інструментів 

і рядком стану 
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7.1. Опис значків 

 
7.1.1. Опис значків на панелі 

інструментів 

 
1. Загальні кнопки 

 
Завантаження матриці 

 

 
Вимірювання матриці з 

використанням матричного 

детектора 

 
Закриття матриці 

 

 
Збереження матриці 

 

 
Перехід до попереднього представ- 

лення в циклічному режимі важливих 

представлень 

 
Перехід до наступного представлення 

в циклічному режимі важливих 

представлень 

 
Експорт результатів порівняння в базу 

даних Track-it 

 
Розгортання графічного вікна до 

розміру вікна програми. 

З допомогою контекстного меню Print 

Preview (Попередній перегляд) або 

Print (Друк) можна надрукувати 

збільшений вигляд. 

 
Відновлення графічного вікна до 

вихідного розміру. 

2. Кнопка з переліком вибору 

 
- Значок, що відображається, показує поточний 

вибір. 

 
-  Під час кожного натискання кнопки 

вибирається наступна функція з переліку. На 

кнопці відображається відповідний значок, і 

буде виконуватися відповідна функція. 

 
-  Під час кожного натискання кнопки буде 

відображатися меню з усіма варіантами 

вибору для  кнопки. Після вибору функції на 

кнопці буде відображатися відповідний 

значок, і буде виконуватися відповідна 

функція. 

 

 
Вибір площини відображення. 

 

 фронтальна площина 

 сагітальна площина 

 поперечна площина 

Ці кнопки будуть активні, якщо завантажені 

дані об'ємного набору доз. Площину, що 

відображається за замовчуванням, можна 

налаштувати в меню Tools → Options (Сервіс - 

Параметри) на вкладці DICOM (див. 

Розд.23.3.5 "Налаштування для імпорту даних 

DICOM"). 



 
 
 
 

 

7.1.2. Опис значків у спливаючих 

вікнах 

 
Спливаюче вікно не закріплено. 

  Клацніть на цій кнопці, щоб закріпити 

спливаюче вікно, тобто щоб 

спливаюче вікно залишалося 

відображеним. Щоб відкрити інше 

спливаюче вікно, потрібно клацнути на 

відповідній вкладці. 

 
Спливаюче вікно закріплено. 

 
Клацніть на цій кнопці, щоб відкріпити 

спливаюче вікно. 

 
7.2. Контекстне меню 

 
Контекстні меню дозволяють викликати 

найбільш важливі функції, а також спеціальні 

функції. Щоб викликати контекстне меню, 

клацніть правою кнопкою миші. Програма 

пропонує різні контекстні меню для різних 

вікон. 
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8. Завантаження 
матриць 

 

8.1. Загальні 

відомості щодо 

завантаження 

 
Матриці можуть бути завантажені різними 

способами: 

 
- Завантаження окремих матриць 

- Додавання та завантаження матриць (тільки 

матриці матричного детектора) 

- Завантаження об'ємних наборів доз 

- Завантаження переліків матриць 

- Об'єднання і завантаження матриць (тільки 

матриці матричного детектора) 

- Складання та завантаження матриць (тільки 

матриці матричного детектора) 

 
Як альтернативу можна вставити дані з 

Провідника Windows за допомогою їх 

перетягування (функція Drag & Drop). 

 
Замість завантаження матриць можна також 

виміряти матриці з використанням матричного 

детектора (див. Розд. 10 "Вимірювання 

матриць") 

 
Якщо матриці доступні в форматі DICOM, 

можна також імпортувати їх безпосередньо з 

DICOM-каталогу або з мережевого DICOM- 

сервера (див. Розд. 9 "Імпорт матриць в 

форматі DICOM "). 

 
Зазвичай дані системи планування 

променевої терапії завантажуються в вікно A 

матриці, а виміряні дані завантажуються в 

вікно B матриці. 

 
При завантаженні даних наявні дані будуть 

перезаписані. Якщо наявні дані ще не були 

збережені, система видасть попередження і 

дозволить зберегти їх в разі потреби. 

 

 
Завантажена матриця буде відображена у 

відповідному вікні матриці як зображення у 

відтінках сірого з ізодозами. Початок 

координат позначено косим хрестом. 

Одночасно буде оновлено вікно результатів. 

Наприклад, буде відображено представлення 

профілю завантаженої матриці. 

 
 

Матриці, в яких значення не мають одиниць 

вимірювання, будуть представлені 

безрозмірними. 
 

 
 

Якщо початок координат завантажуваної 

матриці невідомий, програма VeriSoft 

визначить центр зображення як початку 

координат. 
 

 

 

В разі представлення зображень у відтінках 

сірого або ізодоз матриці матричного 

детектора завжди будуть відображатися 

розміром 27 x 27 см (детектор OCTAVIUS 

Detector1000SRS: 11 x 11 см) з дозволом 0,5 мм. 

Відсутні точки між двома виміряними 

значеннями  будуть визначатися 

інтерполяцією. Точки в приграничній області 

екстраполюються на основі сусідніх виміряних 

значень. Інтерпольовані  значення 

використовуються тільки для поліпшення 

візуалізації розподілу доз. Вони не будуть 

враховуватися для аналізу. 
 



 
 
 
 
 
 
 

 

Через обмеження просторового дозволу 

ізодози матричного детектора дають 

обмежену точність, і вони відображаються 

тільки як орієнтовні значення. Представлення 

ізодози, яке визначається вимірюванням з 

матричним детектором, не підходить для 

порівняння виміряних і розрахункових даних. 
 

8.2. Формати даних 

Програма VeriSoft здатна зчитувати матриці з 

наступними форматами: 

 

 
Формати PTW: 

 
- дані матричного детектора (*.mcc) 

Це включає також: 

- об'єднані дані матричного детектора 

- складені дані матричного детектора 

- секції даних матричного детектора 

(область інтересу) 

 
- дані OCTAVIUS 4D (*.xcc) 

 
- дані матричного детектора з кутами гентрі 

(*.xcc) 

 
- формат PTW: mcc (*.mcc) 

 
- формат експорту MEPHYSTO 7 (*.exp) 

 
- зображення FIPS Plus (*.img) 

 
- ASCII-матриці MEPHYSTO (*.dat) 

 
- формат зображень PTW (*.dat) 

 

 
Графічні формати: 

 
- TIFF (*.tif) 

ПРИМІТКА 
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Матриці доз різних систем планування 

променевої терапії: 

 
Нижче перераховані тільки системи 

планування, що вимагають спеціальних 

процедур. 

 
Якщо ваша система планування здатна 

експортувати об'єкти DICOM RTDose, слід 

завжди вибирати цю функцію для експорту. 

Крім того, слід мати на увазі, що потрібно 

експортувати той зріз об'ємного набору доз, 

який знаходиться в ефективній точці 

вимірювання матричного детектора. 

Можна також експортувати весь об'ємний 

набір доз. В цьому випадку ви можете вибрати 

потрібний зріз за допомогою повзунка у 

спливаючому вікні Slice (Зріз). 

 
- DICOM RTDose (*.dcm) 

 
- BrainLab BrainScan 5.x (*.axl, *.cor, *.sag, *.dat, 

*.flu) 

 
- Nucletron PLATO RTS версій 2.1 + 2.5 - 

сітковий файл доз (*.d*) 

Для цього файлу повинен існувати файл 

моделювання (*.s*) в тому ж каталозі. 

 
- CMS Focus RTP - файл виводу для контролю 

якості доз (*.txt) 

 
- Varian Cadplan> 6.2 (*.*еf*) 

Для цих файлів повинні існувати файли 

CART в тому ж каталозі (з ідентичними 

іменами файлів, але різними розширеннями, 

які служать покажчиками). 

 
- Philips Pinnacle3 версії 6.x (*.header) або 

(*/Ascii-файл без розширення для імені 

файлу) 

Для кожного файлу *.header повинен 

існувати файл зображення (*.img) в тому ж 

каталозі. 

- Leibinger Virtuoso (*.hed) 

Для цього файлу повинен існувати файл доз 

(*.sdc або *.dos) в тому ж каталозі. 

 
- Radionics 2D Table (*.smo) 

 
- 3D Line ERGO (*.exp) 

 
- DICOM RTImage (*.dcm) 

 
- TomoTherapy Hi • Art Export (*.header) 

Для кожного файлу *.header повинен 

існувати файл зображення (*.img) в тому ж 

каталозі. 

 
- K & S Diamond (*.txt) версія 5.0 або вище 

 
Номери версій відповідають даті створення 

інструкції з використання. У разі сумнівів 

звертайтеся в компанію PTW-Freiburg для 

отримання інформації про сумісність з новими 

версіями. 

 
 

 

8.3. Завантаження окремих 

матриць 

 
Див. Розд. 8.2 "Формати данних", де 

перераховані підтримувані формати файлів. 

 
• Для завантаження матриці A або 

матриці B клацніть на відповідній 

кнопці або виберіть меню File → Data 

Set A/B → Open (Файл - Набір даних A 

/ B - Відкрити). 

 
• Виберіть потрібний файл в стандартному 

діалоговому вікні Open (Відкрити). 

 

➔ Буде завантажена матриця. 

 
Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 



 
 
 

8.4. Завантаження матриць 

в форматі DICOM 

• Для завантаження матриці A або 

матриці B клацніть на відповідній 

кнопці або виберіть меню File → Data 

Set A/B → Open (Файл - Набір даних 

A/B - Відкрити). 

 
• Виберіть потрібний файл в стандартному 

діалоговому вікні Open (Відкрити). 

 

➔ На екрані з'явиться діалогове вікно 

DICOM Isocenter Position (Положення 

ізоцентра DICOM). 

 

Малюнок 9.  Діалогове вікно положення 
ізоцентра DICOM 

• Задайте параметри для визначення 

положення ізоцентра: 

- Коли встановлений прапорець параметра Use 

DICOM tag ... (Використовувати DICOM-тег), 

ізоцентрі не буде розташовуватися в центрі 

завантаженої матриці. Замість цього буде 

використовуватися інформація про ізоцентр, 

що міститься у файлі. 

 
- Коли встановлений прапорець параметра Use 

selected RTPlan file ...(Використовувати 

обраний файл RTPlan), на додаток до файлу 

DICOM RTDose буде завантажений файл 

DICOM RTPlan для розрахунку положення 

ізоцентра матриці. 

 
Кнопка для вибору файлу RTPlan. 

 

 

Якщо обрано параметр Use selected RTPlan 

file ... (Використовувати обраний файл RTPlan 

...), програма VeriSoft перевіряє відповідність 

файлів RTPlan і RTDose один одному, але ця 

перевірка не завжди можлива. 
 

• Коли встановлено прапорець параметра 

Autodetect RTPlan file (Автовизначення файлу 

RTPlan), програма VeriSoft буде автоматично 

шукати відповідний файл RTPlan в обраному 

каталозі. 

➔ Якщо знайдено лише один файл RTPlan, 

і цей файл може бути певно 

призначений, він буде завантажений. 

Інакше з'явиться відповідне 

повідомлення. 

• При знятті прапорця Show dialog on next 

DICOM data loading (Показати діалогове вікно 

при наступному завантаженні даних DICOM) 

вимкнеться відображення вікна Isocenter 

Position (Положення ізоцентра) до перезапуску 

програми VeriSoft, і останні налаштування 

знову будуть використовуватися при 

наступному завантаженні матриць в форматі 

DICOM. 

 
• Натисніть кнопку Yes (Так), щоб 

завантажити дані DICOM і визначити 

положення ізоцентра, використовуючи 

налаштовані параметри. 

 
• Натисніть кнопку No (Ні), щоб завантажити 

дані DICOM без урахування налаштованих 

параметрів. 

 
➔ Буде завантажена матриця. 

 
Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 

ПРИМІТКА 

... 



VeriSoftTM 

Загальні відомості 

 

 
 
 

 

8.5. Додавання і 

завантаження матриць 

Якщо ви вибрали декілька файлів з 

матрицями матричного детектора в 

стандартному діалоговому вікні Open 

(Відкрити), виміряні значення окремих 

матриць будуть додані і завантажені як одна 

матриця. 

 

 
8.6. Завантаження об'ємних 

наборів доз з системи TPS 

 
Коли ви завантажуєте з системи планування 

променевої терапії (TPS) дані, які 

складаються з декількох зрізів об'ємного 

набору доз, в вікні матриці буде 

відображатися зріз об'ємного набору доз з 

системи TPS на глибині 0 мм або найближчій 

глибині. 

 
Можна відобразити інші зрізи об'ємного 

набору доз з системи TPS за допомогою 

повзунка у спливаючому вікні Slice (Зріз). 

 
8.7. Завантаження 

вимірювань OCTAVIUS 4D і 

розрахунок об'ємного 

набору доз OCTAVIUS 4D 

 
Об'ємний набір доз OCTAVIUS 4D 

розраховується на основі даних вимірювань 

OCTAVIUS 4D. У цьому вимірюванні для 

кожного інтервалу вимірювання зберігаються 

кут гентрі і значення доз для всіх 

вимірювальних камер матричного детектора. 

Додаткову інформацію див. в розд.10.4 

"Вимірювання OCTAVIUS 4D ". 

 
При завантаженні даних розподіл доз буде 

розраховано для кожного інтервалу 

вимірювання на основі кривих «глибина - 

доза», що залежать від розміру поля. При 

цьому будуть додані розподіли доз всіх 

інтервалів вимірювання. 

 
Інформацію щодо створення файлів PDD з 

необхідними кривими «глибина - доза» див. в 

розд. 23.3.7 "Створення файлів PDD ". 

 

 
• для завантаження вимірювань 

OCTAVIUS 4D, A або B, клацніть на 

відповідній кнопці або виберіть меню 

File → Data Set A/B → Open (Файл - 

Набір даних A/B - Відкрити). 

 
• • Виберіть відповідний файл xcc в 

стандартному діалоговому вікні Open 

(Відкрити). 
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➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). 
 

Малюнок 10. Виберіть діапазон кутів для 
розрахунку об'ємного набору 
доз OCTAVIUS 4D 

В панелі Select Range (Вибір діапазону) 

вкажіть, чи будуть використовуватися всі дані 

вимірювання або тільки виміряні значення 

певного діапазону кутів для розрахунку 

об'ємного набору доз OCTAVIUS 4D: 

• Для цього виберіть потрібний режим в полі 

переліку Range mode (Режим діапазону): 

- All (Всі) 

всі дані вимірювання (за замовчуванням) 

- Angle (Кут) 

діапазон кутів 

 
➔ При виборі параметра Angle (Кут) 

максимальний діапазон кутів, доступний 

для вибору, буде показаний в області 

Available (Доступні). 
 

Якщо потрібно розрахувати об'ємний набір доз 

OCTAVIUS 4D тільки для обраного діапазону 

кутів, експортуйте дані тільки для цього 

діапазону кутів в систему планування 

променевої терапії, щоб забезпечити 

обґрунтоване порівняння даних. 
 

 
• Введіть діапазон для розрахунку в області 

Selected (Вибрані). 

 
• В панелі PDD File (Файл PDD) виберіть 

файл PDD для розрахунку об'ємного набору 

доз. 

Каталог з файлами PDD повинен бути 

заданий через меню Tools → Options 

(Сервіс - Параметри) на вкладці 4D 

Dosimetry (Дозиметрія 4D) (див. Розд. 

23.3.6 "Налаштування для 4D-дозиметрії"). 

 
• В панелі Calculation Limits (Границі 

розрахунків) введіть границі на розмір 

об'ємного набору доз для розрахунку. Границі 

залежать від використовуваного матричного 

детектора і від поворотного блоку. Клацнувши 

на кнопці Set to default (Встановити за 

замовчуванням), можна відновити границі за 

замовчуванням. Налаштування за 

замовчуванням для границь - максимальний 

діапазон, доступний для розрахунків. 

 
- Cylinder Radius [mm] (Радіус циліндра 

[Мм]) 

Радіус області об'ємного набору доз для 

розрахунку 

 
- Cylinder Length [mm] (Довжина циліндра 

[Мм]) 

Довжина області об'ємного набору доз 

для розрахунку 
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• Підтвердити налаштування натисканням 

кнопки OK. 

 
• Оскільки каталог з файлами PDD містить 

кілька файлів, потрібно знову підтвердити 

вибрані файли PDD. 

Знявши відповідний прапорець у вікні 

запиту, ви вимкнете це вікно до 

перезапуску програми VeriSoft або до 

вибору іншого файлу PDD. 

➔ Якщо обраний файл PDD містить криві 

«глибина - доза» не для всіх розмірів 

поля аж до 26 x 26 см (для детектора 

OCTAVIUS Detector 1000SRS: 11 x 11 см), 

то для всіх відсутніх розмірів поля 

потрібно   використовувати   криву 

«глибина - доза» з найбільшим розміром 

поля. 

Знявши відповідний прапорець у вікні 

запиту, ви вимкнете це вікно до 

перезапуску програми VeriSoft або до 

вибору іншого файлу PDD. 

 

Малюнок 11. Вікно запиту в разі відсутності 
кривих «глибина - доза» 

➔ Якщо обраний файл PDD не містить 

інформації щодо того, для якого 

джерела випромінювання він 

призначений - з режимом FFF або без 

режиму FFF, то буде виведений 

наступний запит: 

 

Малюнок 12. Вікно запиту в разі відсутності 
інформації про режим FFF 

 
• Якщо файл PDD був 

визначений для джерела 

випромінювання з режимом FFF, 

підтвердіть запит, натиснувши кнопку 

Yes (Так). 

➔ Відповідна інформація (фільтр = FFF) 

буде введена в файл PDD і збережена. 

• Якщо файл PDD був 

визначений для джерела 

випромінювання без режиму FFF, 

підтвердіть запит, натиснувши кнопку 

No (Ні). 

➔ Відповідна інформація (фільтр = FF) 

буде введена в файл PDD і збережена. 

 
➔ Будуть завантажені виміряні значення 

файлу xcc. За допомогою файлу PDD 

розподіл доз буде розраховано для 

кожного інтервалу вимірювання, і будуть 

додані розподіли доз всіх інтервалів 

вимірювання. Якщо обрано діапазон 

кутів, розподіли доз будуть розраховані 

і додані тільки для інтервалів 

вимірювання цього діапазону. 

 

➔ Зріз об'ємного набору доз на глибині 0 

мм буде відображений у відповідному 

вікні матриці. 



 
 
 
 
 

Інші зрізи об'ємного набору доз можна 

відобразити за допомогою повзунка у 

спливаючому вікні Slice (Зріз). 

 
Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 

8.7.1. Зауваження по процедурам 

некомпланарного опромінення 

• Якщо потрібно розрахувати об'ємний набір 

доз для некомпланарного опромінення, то 

спочатку в меню Tools → Options (Сервіс - 

Параметри) на вкладці 4D Dosimetry 

(Дозиметрія 4D) виберіть Non coplanar 4D 

dosimetry (Некомпланарна 4D-дозиметрія) в 

панелі Non-Standard 4D Dosimetry 

(Нестандартна 4D-дозиметрія) (див. у розд. 

23.3.6 "Налаштування для 4D-дозиметрії"). 

 
➔ В діалоговому вікні Select an angle range 

(Вибір діапазону кутів) з'явиться 

додаткове поле з переліком Couch Angle 

(Кут столу) на панелі PDD File (Файл 

PDD), за допомогою якого можна 

налаштувати кут повороту стола 

пацієнта: 

 

Малюнок 13. Виберіть діапазон кутів для 
розрахунку об'ємного набору доз 
OCTAVIUS 4D для 
некомпланарного опромінення 
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• В полі з переліком Couch Angle (Кут столу) 

виберіть або введіть кут повороту для столу 

пацієнта. 

-  Якщо файл RTPlan завантажено, кути 

повороту столу будуть зчитуватися з файлу 

RTPlan і вводитися в полі з переліком. Якщо 

одне значення кута повороту зустрічається 

кілька разів, воно вводиться тільки один раз. 

 
-  Введене значення кута повороту повинно 

відповідати вимогам стандарту IEC 61217. 

➔ На основі даних компланарних 

вимірювань і кута повороту деки столу 

пацієнта програма VeriSoft розраховує 

об'ємний набір доз для 

некомпланарного опромінення. 

Якщо введений кут повороту 0°, буде 

розраховано об'ємний набір доз 

OCTAVIUS 4D для компланарного 

опромінення. 

 
 

Додаткову інформацію про виконання 

вимірювань при некомпланарному 

опроміненні і про завантаження цих 

вимірювань див. в офіційному документі 

D913.200.12, опублікованому PTW. 
 

 
8.7.2. Зауваження по процедурам 

опромінення з поворотним 

блоком, розташованим не в 

ізоцентрі 

 
• Якщо потрібно розрахувати об'ємний набір 

доз для опромінення при розташуванні 

поворотного блоку не в ізоцентрі, то спочатку 

в меню Tools → Options (Сервіс - Параметри) 

на вкладці 4D Dosimetry (Дозиметрія 4D), 

виберіть Off-axis 4D dosimetry (4D-дозиметрія 

зі зсувом від осі) на панелі Non-Standard 4D 

Dosimetry (Нестандартна 4D-дозиметрія) (див. 

у розд.23.3.6 "Налаштування для 4D- 

дозиметрії"). 

➔ У діалоговому вікні Select an angle range 

(Вибір діапазону кутів) є панель Off-axis 

4D dosimetry (4D-дозиметрія зі зсувом 

від осі): 
 

Малюнок 14. Діалогове вікно вибору діапазону 
кутів для розрахунку об'ємного 
набору доз OCTAVIUS 4D для 
опромінення при розташуванні 
поворотного блоку не в ізоцентрі 
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• В панелі Off-axis 4D Dosimetry (4D- 

дозиметрія зі зсувом від осі) введіть значення 

зміщення поворотного блоку в міліметрах з 

одним знаком після коми для наступних 

напрямків. 

- LR - напрямок зліва направо 

- TG - напрямок мішень-джерело 

- BT - напрямок знизу вгору 

Діапазони введення: 

-  приналежність Rotation Unit (Поворотний 

блок) з усіма детекторами OCTAVIUS: 

всі напрямки (0 ... ± 250) мм 

 
- приналежність Rotation Unit SRS (Поворотний 

блок SRS) з детекторами OCTAVIUS Detector 

729 і 1500: 

напрямок TG (0 ... ± 120) мм 

напрямок LR і BT (0 ... ± 250) мм 

 
- приналежність Rotation Unit SRS (Поворотний 

блок SRS) з детектором OCTAVIUS Detector 

1000SRS: 

всі напрямки (0 ... ± 250) мм 
 

При введенні цих значень див. визначення 

системи координат в стандарті IEC 61217 і 

наступну ілюстрацію. 

 

 

Малюнок 15. Відповідність між координатами 
IEC і координатами PTW 

➔ На основі даних вимірювань і значень 

зсуву VeriSoft розраховує об'ємний набір 

доз для опромінення при розташуванні 

поворотного блоку не в ізоцентрі. 

Ізоцентром є нульова точка значень 

дози, які відображаються в VeriSoft. 

Якщо для  кожного значення зсуву 

вводиться 0,  об'ємний набір  доз 

OCTAVIUS 4D буде вирахувано при 

розташуванні поворотного  блоку  в 

ізоцентрі. 

 
 

Додаткову інформацію про виконання 

вимірювань при опроміненні з поворотним 

блоком, розміщеним не в ізоцентрі, та про 

завантаження цих вимірювань див. в 

офіційному документі D913.200.12, 

опублікованому PTW. 
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8.8. Додавання і 

завантаження вимірювань 

OCTAVIUS 4D 
 

Додавання і завантаження вимірювань 

OCTAVIUS 4D допускаються, якщо тільки вони 

були виміряні одним і тим же пристроєм. 

 
Ви можете додати і завантажити тільки повні 

вимірювання OCTAVIUS 4D. У цьому випадку 

вибір діапазону кутів неможливий. 

 
Також є можливість обчислити об'ємний набір 

доз OCTAVIUS 4D для доданих вимірювань 

OCTAVIUS 4D в наступних випадках: 

- некомпланарне опромінення 

-  опромінення при розташуванні поворотного 

блоку не в ізоцентрі 

- опромінення з різними енергіями 

-  опромінення з різними рівнями енергії при 

розташуванні поворотного блоку не в 

ізоцентрі 
 

 

 
Якщо ви виберете декілька файлів з 

вимірюваннями OCTAVIUS 4D в стандартному 

діалоговому вікні Open (Відкрити), то в 

розрахунок об'ємного набору доз OCTAVIUS 

4D будуть включені всі інтервали вимірювання 

з усіх вимірювань. 

 
Додаткову інформацію щодо завантаження 

вимірювань OCTAVIUS 4D див. в розд.8.7 

"Завантаження вимірювань OCTAVIUS 4D і 

розрахунок об'ємного набору доз OCTAVIUS 

4D ". 

8.8.1. Зауваження про додавання 

вимірювань при 

некомпланарному опроміненні 

і різних кутах повороту столу 

пацієнта 

• Якщо вимірювання проводилися при 

некомпланарному опроміненні і різних кутах 

повороту столу пацієнта і ви хочете додати ці 

вимірювання для обчислення об'ємного 

набору доз, то спочатку в меню Tools → 

Options (Сервіс- Параметри) на вкладці 4D 

Dosimetry (Дозиметрія 4D) виберіть параметр 

Non coplanar 4D dosimetry (Некомпланарна 

4D-дозиметрія) на панелі Non-Standard 4D 

Dosimetry (Нестандартна 4D-дозиметрія) (див. 

розд. 23.3.6 "Налаштування для 4D- 

дозиметрії"). 

 
➔ У діалоговому вікні Select an angle range 

(Вибір діапазону кутів) з'явиться 

додаткове поле з переліком Couch Angle 

(Кут столу) на панелі PDD File (Файл 

PDD), за допомогою якого можна 

налаштувати кут повороту стола 

пацієнта: 
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Малюнок 16. Виберіть діапазон кутів для 

розрахунку об'ємного набору 
доз OCTAVIUS 4D при 
некомпланарному опроміненні і 
різних кутах повороту столу 
пацієнта 

 

• В панелі PDD File (Файл PDD) для кожного 

вимірювання виберіть файл PDD з 

відповідною енергією, щоб обчислити 

об'ємний набір доз. 

• В панелі PDD File (Файл PDD) для кожного 

вимірювання виберіть або введіть потрібний 

кут повороту стола пацієнта в полі з переліком 

Couch Angle (Кут столу). 

 
-  Якщо файл RTPlan завантажений, кути 

повороту столу будуть зчитуватися з 

файлу RTPlan і вводитися в полі з 

переліком. Якщо одне значення кута 

повороту зустрічається кілька разів, воно 

вводиться тільки один раз. 

 
-  Введене значення кута повороту повинно 

відповідати вимогам стандарту IEC 61217. 

• У вікні запиту знову підтвердіть вибрані 

файли PDD. 

 

➔ Програма VeriSoft буде використовувати 

для розрахунку файл PDD і кут повороту 

столу пацієнта, відповідний кожному 

файлу вимірювань OCTAVIUS 4D. 

Якщо введено кут повороту 0°, буде 

розрахований об'ємний набір доз 

OCTAVIUS 4D для компланарного 

опромінення. 

 
 

Додаткову інформацію про виконання 

вимірювань при некомпланарному 

опроміненні і різних кутах повороту столу 

пацієнта, а також про завантаження цих 

вимірювань, див. в офіційному документі 

D913.200.12, опублікованому PTW. 
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8.8.2. Зауваження про додавання 

вимірювань, виконаних з 

різними енергіями 

 
• Якщо вимірювання проводилися з різними 

енергіями і ви хочете додати ці вимірювання 

для обчислення об'ємного набору доз, то 

спочатку в меню Tools → Options (Сервіс - 

Параметри) на вкладці 4D Dosimetry 

(Дозиметрія 4D) виберіть 4D dosimetry for 

multiple energies (4D-дозіметрія для декількох 

енергій) в панелі Non-Standard 4D Dosimetry 

(Нестандартна 4D-дозиметрія) (див. у розд. 

23.3.6 "Налаштування для 4D-дозиметрії"). 

➔ У діалоговому вікні Select an angle range 

(Вибір діапазону кутів) можна потім 

переглянути всі вимірювання і один 

пов'язаний файл PDD в панелі PDD File: 

 
 
 

 

Малюнок 17. Діалогове вікно вибору 
діапазону кутів для розрахунку 
об'ємного набору доз OCTAVIUS 
4D для вимірювань з різними 
енергіями 

• В панелі PDD File (Файл PDD) для кожного 

вимірювання виберіть файл PDD з 

відповідною енергією, щоб обчислити 

об'ємний набір доз. 

 
• У вікні запиту знову підтвердіть вибрані 

файли PDD. 

 
➔ VeriSoft буде використовувати файл 

PDD, пов'язаний з кожним файлом 

вимірювань OCTAVIUS 4D, для 

розрахунку. 

 

 

Додаткову інформацію про виконання 

вимірювань при опроміненні з різними рівнями 

енергії і про завантаження цих вимірювань 

див. в офіційному документі D913.200.12, 

опублікованому PTW. 
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8.8.3. Зауваження про додавання 

вимірювань, виконаних при 

розміщенні поворотного блоку 

не в ізоцентрі і для різних 

рівнів енергії 
 
 

Переконайтеся, що поворотний блок 

розташований не в ізоцентрі. Його положення 

повинно бути однаковим для всіх вимірювань 

OCTAVIUS 4D, які ви додаєте і завантажуєте. 
 

 

• Якщо вимірювання проводилися при 

розташуванні поворотного блоку не в ізоцентрі 

і для різних рівнів енергії і ви хочете додати ці 

вимірювання для обчислення об'ємного 

набору доз, то спочатку в меню Tools → 

Options (Сервіс - Параметри) на вкладці 4D 

Dosimetry (Дозиметрія 4D) виберіть параметр 

Off-axis 4D dosimetry (4D-дозиметрія зі зсувом 

від осі) на панелі Non-Standard 4D Dosimetry 

(Нестандартна 4D-дозиметрія) (див. розд. 

23.3.6 "Налаштування для 4D-дозиметрії"). 

➔ У діалоговому вікні Select an angle range 

(Вибір діапазону кутів) можна 

переглянути всі вимірювання і один 

пов'язаний файл PDD в панелі PDD File 

(Файл PDD). Також з'явиться додаткова 

панель Off-axis 4D Dosimetry (4D- 

дозиметрія зі зсувом від осі): 

 

 

Малюнок 18. Діалогове вікно Select an angle 
range (Вибір діапазону кутів) 
для розрахунку об'ємного 
набору доз OCTAVIUS 4D при 
опроміненні з різними рівнями 
енергії і поворотним блоком, 
розташованим не в ізоцентрі 

 

• В панелі PDD File (Файл PDD) для кожного 

вимірювання виберіть файл PDD з 

відповідною енергією, щоб обчислити 

об'ємний набір доз. 
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• В панелі Off-axis 4D Dosimetry (4D- 

дозиметрія зі зсувом від осі) введіть значення 

зміщення поворотного блоку в напрямку LR 

(зліва направо), TG (мішень-джерело) і BT 

(знизу до верху). Додаткову інформацію див. в 

розд.8.7.2 "Зауваження по процедурам 

опромінення з поворотним блоком, 

розташованим не в ізоцентрі". 

 
• У вікні запиту знову підтвердіть вибрані 

файли PDD. 

 

➔ Програма VeriSoft буде використовувати 

для розрахунку файли PDD, пов'язані з 

кожним файлом вимірювань OCTAVIUS 

4D; при цьому буде враховуватися 

неізоцентричне положення поворотного 

блоку. 
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Додаткову інформацію про виконання 

вимірювань при опроміненні з різними рівнями 

енергії і з поворотним блоком, розміщеним не 

в ізоцентрі, а також про завантаження цих 

вимірювань, див. в офіційному документі 

D913.200.12, опублікованому PTW. 
 

8.9. Завантаження 

вимірювань, виконаних з 

матричним детектором і 

планарним поворотним 

блоком 

 
У вимірюванні з матричним детектором і 

планарним поворотним блоком для кожного 

інтервалу вимірювання зберігаються кут гентрі 

і значення доз для всіх вимірювальних камер 

матричного детектора. Додаткову інформацію 

див. в розд.10.5 "Вимірювання з матричним 

детектором і планарним поворотним блоком". 

 
При завантаженні даних будуть додані 

значення доз вимірювальних камер. 

 
 

 
• Для завантаження матриці A або 

матриці B клацніть на відповідній кнопці 

або виберіть меню File → Data Set A/B 

→ Open (Файл - Набір даних A/B - 

Відкрити). 

 
• Виберіть потрібний файл xcc в 

стандартному діалоговому вікні Open 

(Відкрити). 

 

 

Відповідний файл mcc містить тільки значення 

доз. Кути гентрі доступні тільки в файлі xcc 

(див. Розд.11.1.2 "Збереження вимірювань, 

виконаних з матричним детектором і 

планарним поворотним блоком або 

інклінометром "). 
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➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). 
 

Малюнок 19. Відкрийте діалогове вікно 
діапазону для кутів гентрі 

 

В панелі Select Range (Вибір діапазону) 

вкажіть, чи повинні відображатися всі дані 

вимірювання або тільки виміряні значення 

певного діапазону кутів: 

• Для цього виберіть потрібний режим в полі 

переліку Range mode (Режим діапазону): 

- All (Всі) 

всі дані вимірювання (за замовчуванням) 

- Angle (Кут) 

діапазон кутів 

- Time (Час) 

інтервал часу 

➔ При виборі параметра Angle (Кут) або 

Time (Час) максимальний діапазон кутів 

або інтервал часу, доступний для 

вибору, буде показаний в області 

Available (Доступні). 

• Введіть діапазон для відображення в 

області Selected (Вибрані). 

 
• Підтвердіть налаштування натисканням 

кнопки OK. 

 
➔ Буде завантажена матриця. В даному 

випадку матриця є доповненням 

окремих значень. Наприклад, якщо ви 

виберете діапазон кутів від 0° до 90°, то 

буде відображена матриця з сумарною 

дозою для цього діапазону кутів. 

 

Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 
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8.10. Завантаження 

вимірювань, виконаних з 

матричним детектором 

планарним поворотним 

блоком 
(Без поворотного блоку) 

 
У вимірюванні з матричним детектором та 

інклінометром для кожного інтервалу 

вимірювання зберігаються кут гентрі і 

значення доз для вимірювальних камер 

матричного детектора. Додаткову інформацію 

див. в розд.10.6 "Вимірювання з матричним 

детектором та інклінометром". 

 
При завантаженні даних будуть додані 

значення доз вимірювальних камер. 

 
 

 
• Для завантаження матриці A або 

матриці B клацніть на відповідній кнопці 

або виберіть меню File → Data Set A/B 

→ Open (Файл - Набір даних A/B - 

Відкрити). 

 
• Виберіть потрібний файл xcc в 

стандартному діалоговому вікні Open 

(Відкрити). 

 

Відповідний файл mcc містить тільки значення 

доз. Кути гентрі доступні тільки в файлі xcc 

(див. Розд.11.1.2 "Збереження вимірювань, 

виконаних з матричним детектором і 

планарним поворотним блоком або 

інклінометром"). 

 

➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). 
 

Малюнок 20. Відкрийте діалогове вікно 
діапазону для кутів гентрі 

 

 
В панелі Select Range (Вибір діапазону) 

вкажіть, чи повинні відображатися всі дані 

вимірювання або тільки виміряні значення 

певного діапазону кутів: 

 
• Для цього виберіть потрібний режим в полі 

переліку Range mode (Режим діапазону): 

- All (Всі) 

всі дані вимірювання (за замовчуванням) 

- Angle (Кут) 

діапазон кутів 

- Time (Час) 

інтервал часу 

 
➔ При виборі параметра Angle (Кут) або 

Time (Час) максимальний діапазон кутів 

або інтервал часу, доступний для 

вибору, буде показаний в області 

Available (Доступні). 
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• Введіть діапазон для відображення в 

області Selected (Вибрані). 

 
• Підтвердіть налаштування натисканням 

кнопки OK. 

 
➔ Буде завантажена матриця. В даному 

випадку матриця є доповненням 

окремих значень. Наприклад, якщо ви 

виберете діапазон кутів від 0° до 90°, то 

буде відображена матриця з сумарною 

дозою для цього діапазону кутів. 

 

Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 

8.11. Завантаження переліків 
матриць 

 

Ця функція недоступна для об'ємних наборів 

доз. 

 
Замість окремих матриць або об'ємних 

наборів доз можна завантажити переліки 

матриць. 

 
• Для завантаження переліку матриць A або 

B виберіть меню File → Data Set A/B → Open 

List (Файл - Набір даних A/B - Відкрити 

перелік). 

➔ Відкриється діалогове вікно Define List 

and Sequence (Визначення переліку та 

послідовності) (див. малюнок 21). 

• Натисніть кнопку Select Folder (Вибір 

папки). 

 
• У стандартному діалоговому вікні Open 

(Відкрити) виберіть каталог з матрицями для 

завантаження. 

 
➔ Всі файли обраного каталогу будуть 

вставлені в перелік. 

 
• Натисніть кнопку OK. 

 
➔ Перелік буде завантажений, і перша 

матриця переліку буде відображена у 

відповідному вікні матриці. 

Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 
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8.11.1. Діалогове вікно 

визначення переліку і 

послідовності 

 
Крім того, в діалоговому вікні Define List and 

Sequence (Визначення переліку та 

послідовності) можливі наступні функції для 

переліку матриць: 

 

 
Додавання матриць до переліку матриць 

 
• Натисніть кнопку Add File(s) (Додавання 

файлів). 

 
• У стандартному діалоговому вікні Open 

(Відкрити) виберіть одну або кілька матриць 

для додавання. 

 

➔ Вибрані матриці будуть додані в кінці 

існуючого переліку. 

 

Видалення матриць з переліку матриць 

 
• У переліку матриць виберіть одну або 

кілька матриць для видалення. 

 
• Натисніть   кнопку   Remove   File(s) 

(Видалення файлів). 

 
➔ Вибрані матриці будуть вилучені з 

переліку. 

Очищення переліку матриць 

 
• Натисніть кнопку Clear (Очистити). 

 
➔ Весь перелік буде видалений. 

 
 

Зміна порядку наведення матриць в 

переліку 

• В переліку матриць виберіть одну або 

кілька матриць для переміщення. 

 
• Перемістіть вибрані матриці вгору за 

переліком, натиснувши кнопку Move Up 

(Перемістити вгору). 

 
• Перемістіть вибрані матриці вниз за 

переліком, натиснувши кнопку Move Down 

(Перемістити вниз). 

 

 
 

Малюнок 21. Діалогове вікно визначення переліку і послідовності 
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8.12. Додавання і 

завантаження матриць 
 

Ця функція доступна тільки для матриць 

матричного детектора. Якщо ця умова не 

дотримується, з'явиться відповідне 

повідомлення. 

Об'єднання і завантаження матриць 

допускаються, якщо тільки вони були виміряні 

одним і тим же пристроєм. 
 

 
Функція Merge (Об'єднання) при завантаженні 

матриць використовується для створення 

матриць матричного детектора з більш 

високим просторовим дозволом. 

 
Тому повинні бути доступні 2 або 4 матриці із 

зсувом 5 мм (для детектора OCTAVIUS 

Detector 1000SRS 2,5 мм). Для першої матриці 

матричний детектор вирівнюється по 

ізоцентру. Для наступних матриць матричний 

детектор зміщується. 

 
При завантаженні ці матриці будуть об'єднані. 

Об'єднана матриця може бути збережена в 

програмі VeriSoft. 

 
 

При цьому об'єднуються тільки точки 

вимірювання всіх завантажених вимірювань, 

без зміни виміряних значень. 
 

 
Матриці будуть позначені таким чином: 

 
- matrix # 1 (матриця №1): 

вимірювання матричного детектора Gun- 

Left (джерело-ліворуч) 

(Матричний детектор в ізоцентрі) 

 
- matrix # 2 (матриця №2): 

вимірювання матричного детектора Target- 

Left (мішень-ліворуч) 

 
- matrix # 3 (матриця №3): 

вимірювання матричного детектора Gun- 

Right (джерело-праворуч) 

 
- matrix # 4 (матриця №4): 

вимірювання матричного детектора Target- 

Right (мішень-праворуч) 

 
Об'єднання матриць можливе тільки для 

наступних комбінацій матриць: 

- матриця №1 і №2 

- матриця №1 і №3 

- матриця №1, №2, №3 і №4 

 
У випадку детектора OCTAVIUS Detector 1500 

об'єднання можливе тільки для комбінації 

матриць №1 і №2. 

 

 
• Для об'єднання і завантаження матриці A 

або матриці B виберіть меню File → Data Set 

A/B → Merge (Файл - Набір даних A/B - 

Об'єднати). 
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➔ На екрані з'явиться діалогове вікно Open 

Data to Merge (Відкрити дані для 

об'єднання). 

• Відкрийте матрицю №1, натиснувши кнопку 

Open # 1 (Відкрити №1). 

 
➔ На кнопці з'явиться зображення у 

відтінках сірого. При наведенні 

покажчика на зображення з'явиться 

підказка, яка вказує шлях і ім'я файлу. 

• Відкрийте матрицю №2, або матрицю №3, 

або матриці №2, №3 і №4, клацнувши на 

відповідних кнопках. 

 

➔ На кнопках з'являться відповідні 

зображення у відтінках сірого. При 

наведенні покажчика миші на 

зображення з'являться підказки, які 

вказують відповідний шлях і ім'я файлу. 

 

• Підтвердіть вибір матриць натисканням 

кнопки OK. 

 

➔ Матриці будуть об'єднані і завантажені: 

 
Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 

 

 

Малюнок 22. Діалогове вікно відкриття 
даних для об'єднання 

1 Кнопка для відкриття матриці №1: 

Gun-Left (джерело-ліворуч), 

матричний детектор в ізоцентрі 

2 Кнопка для відкриття матриці №2: 

Target-Left (мішень-ліворуч) 

3 Кнопка для відкриття матриці №3: 

Gun-Right (джерело-праворуч) 

4 Кнопка для відкриття матриці №4: 

Target-Right (мішень-праворуч) 

  

  



 
 
 

 

8.12.1. Алгоритм об'єднання 

 
Об'єднане вимірювання створено з вимірювань з 

№1 по №4. Зсув для кожного вимірювання 

завжди становить 5 мм (для детектора 

OCTAVIUS Detector 1000SRS 2,5 мм). 

 
Об'єднане вимірювання охоплює ту ж саму 

область, що і вимірювання №1, тобто рядки 

детектора зміщених вимірювань, що виходять за 

границі області вимірювань №1 (сірі області поза 

широкою границею), ігноруються (див. малюнок 

23). 

 
Об'єднане вимірювання має той же початок 

координат, що і вимірювання №1. 

 
 

 
Малюнок 23. Область вимірювання і початок координат об'єднаного вимірювання 
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8.13. Об'єднання і 

завантаження вимірювань 

OCTAVIUS 4D 
 

Об'єднувати можна тільки вимірювання 

OCTAVIUS 4D. Якщо обрано вимірювання з 

інклінометром, але без поворотного блоку, 

буде виведено відповідне повідомлення про 

помилку. 

 
Об'єднання і завантаження вимірювань 

OCTAVIUS 4D допускаються, якщо тільки 

вони були виміряні одним і тим же пристроєм. 

 
Об'єднання двох вимірювань OCTAVIUS 4D 

можливе тільки в тому випадку, коли 

матричний детектор був зміщений в напрямку 

осі обертання. 

 
Об'єднання і завантаження вимірювань 

OCTAVIUS 4D неможливі в наступних 

випадках: 

- некомпланарне опромінення 

-  опромінення при розташуванні поворотного 

блоку не в ізоцентрі 

- опромінення з різними енергіями 
 

 
 

Функція Merge (Об'єднання) при завантаженні 

вимірювань OCTAVIUS 4D (файли xcc) 

використовується для розрахунку об'єму доз 

OCTAVIUS 4D з бази даних з більш високим 

дозволом. 

Тому повинні бути доступні два вимірювання 

OCTAVIUS 4D зі зсувом матричного детектора 

5 мм (для детектора OCTAVIUS Detector 

1000SRS 2,5 мм). Для першого вимірювання 

матричний детектор вирівнюється по 

ізоцентру. Для другого вимірювання 

матричний детектор зміщується в напрямку 

мішені. Для цього змістіть поворотний блок з 

допомогою процедурного столу. 

 
При завантаженні ці два вимірювання 

OCTAVIUS 4D будуть об'єднані. Об'ємний 

набір доз OCTAVIUS 4D, розрахований з 

об'єднаних вимірювань, може бути 

збережений в програмі VeriSoft. 

 
Вимірювання OCTAVIUS 4D будуть позначені 

таким чином: 

 
- вимірювання №1: 

вимірювання матричного детектора Gun- 

Left (джерело-ліворуч) 

(Матричний детектор в ізоцентрі) 

 
- вимірювання №2: 

вимірювання матричного детектора Target- 

Left (мішень-ліворуч) 
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• Для об'єднання і завантаження 

вимірювання A або B OCTAVIUS 4D виберіть 

меню File → Data Set A/B → Merge (Файл - 

Набір даних A / B - Об'єднати). 

➔ На екрані з'явиться діалогове вікно Open 

Data to Merge (Відкрити дані для 

об'єднання) (див. малюнок 22). 

• Відкрийте два вимірювання, клацнувши на 

кнопках Open # 1 (Відкрити №1) та Open # 2 

(Відкрити №2). Кнопки Open # 3 (Відкрити №3) 

та Open # 4 (Відкрити №4) неактивні. 

 

➔ У разі вимірювань OCTAVIUS 4D 

попередній перегляд неможливий. 

• Підтвердіть обрані вимірювання 

натисканням кнопки OK. 

 

➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). Воно містить значення часу і 

діапазону кутів для вимірювання №1. 

• Змініть налаштування, як описано в розд. 

8.7 "Завантаження вимірювань OCTAVIUS 4D 

і розрахунок об'ємного набору доз OCTAVIUS 

4D". 

 

➔ Вимірювання OCTAVIUS 4D будуть 

об'єднані, і буде розрахований об'ємний 

набір доз OCTAVIUS 4D. 

 
 

Додаткову інформацію по об'єднанню і 

завантаженню матриць див. в розд. 8.12 

"Додавання і завантаження матриць". 

8.14. Складання та 

завантаження матриць 
 

Щоб уникнути пошкодження обладнання при 

вимірюванні великих полів, вимірюйте матриці 

на стороні джерела з перевернутим 

матричним детектором. Це допоможе 

запобігти опроміненню електроніки. 

Функція Compose (Складання) враховує цей 

переворот і буде правильно відображати 

матриці на стороні джерела. 
 

 

 
 

Ця функція доступна тільки для матриць 

матричного детектора. 

Складання та завантаження матриць 

допускаються, якщо тільки вони були виміряні 

одним і тим же пристроєм. 
 

 

 
 

Складання та завантаження об'ємних наборів 

доз неможливі (наприклад, файли xcc з 

вимірюваннями OCTAVIUS 4D). При подібній 

спробі буде виводитися повідомлення про 

помилку. 
 

 

 
Функція Compose (Складання) при 

завантаженні матриць використовується для 

створення матриць матричного детектора для 

великих розмірів полів. 

 
Для цих цілей будуть складені 2 або 4 матриці 

з обраних рядків і стовпців. Дозвіл складеної 

матриці не буде змінено. 
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При завантаженні ці матриці будуть складені. 

Складена матриця може бути збережена в 

програмі VeriSoft як матриця матричного 

детектора. 
 

При цьому складаються тільки точки 

вимірювання всіх завантажених вимірювань, 

без зміни виміряних значень. 
 

 
Матриці будуть позначені таким чином: 

 
- matrix # 1 (матриця №1): 

вимірювання матричного детектора Target- 

Left (мішень-ліворуч) 

 
- matrix # 2 (матриця №2): 

вимірювання матричного детектора Gun-Left 

(джерело-ліворуч) 

 
- matrix # 3 (матриця №3): 

вимірювання матричного детектора Target- 

Right (мішень-праворуч) 

 
- matrix # 4 (матриця №4): 

вимірювання матричного детектора Gun- 

Right (джерело-праворуч) 

 
Складання матриць можливе тільки для 

наступних комбінацій матриць: 

 
- матриця №1 і №2 

- матриця №1 і №3 

- матриця №1, №2, №3 і №4 

• Для складання і завантаження матриці A 

або матриці B виберіть меню File → Data Set A 

/ B → Compose (Файл - Набір даних A / B - 

Скласти). 

 
➔ На екрані з'явиться діалогове вікно Open 

Data to Compose (Відкрити дані для 

складання) (див. малюнок 24). 

• Відкрийте матрицю №1, натиснувши кнопку 

Open # 1 (Відкрити №1). 

 
➔ На кнопці з'явиться зображення у 

відтінках сірого. При наведенні 

покажчика миші на зображення 

з'явиться підказка, яка вказує шлях і ім'я 

файлу. 

• Відкрийте матрицю №2, або матрицю №3, 

або матриці №2, №3 і №4, клацнувши на 

відповідних кнопках. 

 

➔ На кнопках з'являться відповідні 

зображення у відтінках сірого. При 

наведенні покажчика миші на 

зображення з'являться підказки, які 

вказують відповідний шлях і ім'я файлу. 

• Для матриць на лівій і правій стороні 

введіть стовпці, які повинні використовуватися 

для складеної матриці. 

 
• Для матриць на стороні джерела і мішені 

введіть рядки, які повинні використовуватися 

для складеної матриці. 

 
• Підтвердіть вибір матриць і введені дані 

натисканням кнопки OK. 

 

➔ Матриці будуть складені і завантажені. 

 
Додаткову інформацію щодо завантаження 

матриць див. в розд. 8.1 "Загальні відомості 

щодо завантаження". 



   

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
C 4 

 
 
 
 

 
D 3 

 
 
 
 
 
 
 
 
 

Малюнок 24. Діалогове вікно відкриття даних для складання 
 
 

1 Кнопка для відкриття матриці №1: 

Target-Left (мішень-ліворуч) 

 
2 Кнопка для відкриття матриці №2: 

Gun-Left (джерело-ліворуч) 

 
3 Кнопка для відкриття матриці №3: 

Target-Right (мішень-праворуч) 

 
4 Кнопка для відкриття матриці №4: 

Gun-Right (джерело-праворуч) 

A Поле введення для стовпців матриць на 

лівій стороні, які повинні використовува- 

тися для складеної матриці 

 
B Поле введення для стовпців матриць на 

правій стороні, які повинні використову- 

ватися для складеної матриці 

 
C Поле введення для рядків матриць на 

стороні джерела, які повинні використо- 

вуватися для складеної матриці 

 
D Поле введення для рядків матриць на 

стороні мішені, які повинні використо- 

вуватися для складеної матриці 
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8.15. Складання та 

завантаження вимірювань 

OCTAVIUS 4D 
 

Неправильне тлумачення при складанні та 

завантаженні вимірювань з детектором 

OCTAVIUS Detector 1000 SRS. 

 
Неправильне спрацьовування! 

 
При складанні і завантаженні вимірювань з 

детектором OCTAVIUS Detector 1000SRS, 

заплановані і виміряні дози в ізоцентрі або 

розподіли загальної дози можуть відрізнятися, 

навіть якщо була виконане перехресне 

калібрування матричного детектора, це 

пояснюється конструкцією детектора. Таким 

чином, щоб уникнути невірного тлумачення 

використовуйте додаткові засоби і заходи для 

метрологічної перевірки планів лікування. 
 

 

 

Щоб запобігти пошкодженню обладнання, для 

великих полів вимірюйте матриці на стороні 

джерела, повернувши матричний детектор на 

180°. В цьому випадку електронні компоненти 

не піддаються опроміненню. 

Функція Compose (Складання) враховує цей 

поворот. 

 

 

Складати можна тільки вимірювання 

OCTAVIUS 4D. Якщо обрано вимірювання з 

інклінометром, але без поворотного блоку, 

буде виведено відповідне повідомлення про 

помилку. 

 
Складати і завантажувати можна тільки 

вимірювання OCTAVIUS 4D, виконані одним 

вимірювальним пристроєм. 

 
Складання двох вимірювань OCTAVIUS 4D 

можливе тільки в тому випадку, коли 

матричний детектор був зміщений в 

напрямку осі повороту. 

 
Складання та завантаження вимірювань 

OCTAVIUS 4D неможливі в наступних 

випадках: 

- некомпланарне опромінення 

- опромінення при розташуванні поворотного 

блоку не в ізоцентрі 

- опромінення з різними енергіями 
 

ПРИМІТКА 



 
 
 
 

При завантаженні вимірювань OCTAVIUS 4D 

(xcc-файлів), функція Compose (Складання) 

використовується для розрахунку об'ємних 

наборів доз OCTAVIUS 4D для полів великих 

розмірів в напрямку мішень-джерело. Дозвіл 

складеного вимірювання залишається тим же 

самим. 

 
З допомогою цієї функції складаються два 

вимірювання OCTAVIUS 4D, що 

перекриваються, і перекривання симетричне 

відносно ізоцентра. Для цього зміщення 

поворотного блоку проводиться за допомогою 

деки столу. 

 
Зсув матричного детектора має забезпечити 

накладення детекторів в області 

перекривання, а також виконання таких умов: 
 

- максимальне зміщення:  

OCTAVIUS Detector 729/1500 110 мм 

OCTAVIUS Detector 1000 SRS 45 мм 

-  зміщення повинно бути помножене на 

наступні значення: 
 

OCTAVIUS Detector 729 10 мм 

OCTAVIUS Detector 1500 5 мм 

OCTAVIUS Detector 1000 SRS 2,5 мм 

 
Два вимірювання OCTAVIUS 4D складаються 

при завантаженні. Об'ємний набір доз 

OCTAVIUS 4D, розрахований із складених 

вимірювань, може бути збережений в програмі 

VeriSoft. 

 
Вимірювання OCTAVIUS 4D позначаються 

наступним чином: 

 
-  Вимірювання Face Out (Лицьові сторони 

назовні): 

нормальна орієнтація поворотного блоку 

(нормальний напрямок повороту, редуктор 

звернений до джерела) 

поворотний блок зміщений в напрямку мішені 

 
-  Вимірювання Face In (Лицьові сторони 

всередину): 

поворотний блок повернутий на 180° 

(зворотний напрямок повороту, редуктор 

звернений до мішені) 

поворотний блок зміщений в напрямку 

джерела 

 
• Створення плану лікування для довгого 

фантома (наприклад, 50 см). 

 
• У вікні вимірювань виконайте наступні два 

вимірювання OCTAVIUS 4D. Будьте уважні і не 

закривайте вікно вимірювань між 

вимірюваннями. 

• Спочатку вирівняйте поворотний блок 

відносно ізоцентра. 

• Використовуючи деку столу пацієнта, 

помістіть поворотний блок в положення, 

коли він зміщений в напрямку мішені, за 

допомогою потрібного значення зсуву. При 

такій компоновці буде опромінюватися 

редуктор поворотного блоку, а не 

електронні компоненти матричного 

детектора. 

➔ Вікно вимірювань буде 

показувати орієнтацію Face Out 

(Лицьові сторони назовні), яка є 

нормальною орієнтацією 

поворотного блоку (редуктор 

звернений до джерела). 

• Почніть вимірювання за планом. 
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• Збережіть вимірювання у вікні вимірювань 

в форматі xcc. 

 

PTW рекомендує додавати до імені файлу 

напрямок і значення зсуву. 
 

 
• Встановіть гентрі в положення 0°. 

 
• Поверніть поворотний блок на 180°. 

 
• Спочатку вирівняйте поворотний блок 

відносно ізоцентра. 

 
• Використовуючи деку столу пацієнта, на 

цей раз помістіть поворотний блок в 

положення, коли він зміщений в напрямку 

джерела, за допомогою потрібного значення 

зсуву. При такій компоновці також буде 

опромінюватись редуктор поворотного блоку, 

а не електронні компоненти матричного 

детектора. 

 
• У вікні вимірювань виберіть 

орієнтацію Face In (Лицьові сторони 

всередину) для поворотного блоку, 

повернутого на 180° (редуктор 

звернений до мішені). 

 
• Почніть інше вимірювання за планом. 

 
• Збережіть вимірювання у вікні вимірювань 

в форматі xcc. 

 

PTW рекомендує додавати до імені файлу 

напрямок і значення зсуву. 
 

 

 
• Натисніть кнопку Cancel (Скасувати), щоб 

вийти з вікна вимірювань. 

 
• Для складання і завантаження 

вимірювання A або B OCTAVIUS 4D виберіть 

меню File → Data Set A / B → Compose (Файл 

- Набір даних A / B - Складання). 
 

➔ На екрані з'явиться діалогове вікно Open 

Data to Compose (Відкрити дані для 

складання) (див. малюнок 24). 

• Відкрийте вимірювання Face Out (Лицьові 

сторони назовні), натиснувши кнопку Open #1 

(Відкрити №1). 

 

➔ При цьому кнопки Open # 3 (Відкрити 

№3) та Open # 4 (Відкрити №4) стануть 

неактивними. 

• Відкрийте вимірювання Face In (Лицьові 

сторони всередину), натиснувши кнопку Open 

#2 (Відкрити №2). 

 
• В полі введення TG Offset (Зсув TG) введіть 

значення зміщення без знака в [мм]. 

 

➔ Для вимірювань OCTAVIUS 4D 

попередній перегляд неможливий, але 

завантажені дані можна визначити за 

допомогою значків Face Out і Face In: 

 

Малюнок 25. Діалогове вікно відкриття 
даних для складання з двома 
завантаженими вимірюваннями 
OCTAVIUS 4D 



 
 
 
 

 

• Підтвердіть обрані вимірювання 

натисканням кнопки OK. 

 

➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). У ньому показані значення часу і 

діапазони кутів вимірювання Face Out 

(Лицьові сторони назовні). 

• Вкажіть необхідні налаштування, як 

описано в розд. 8.7 "Завантаження 

вимірювань OCTAVIUS 4D і розрахунок 

об'ємного набору доз OCTAVIUS 4D ". 

 
➔ Вимірювання OCTAVIUS 4D будуть 

складені, і буде розрахований об'ємний 

набір доз OCTAVIUS 4D. 

 

Додаткову інформацію щодо складання і 

завантаженні матриць див. в розд. 8.14 

"Складання і завантаження матриць". 

8.16. Підстроювання 

двох матриць під час 

завантаження 

 
Для можливості порівняння двох матриць 

необхідно, щоб значення в них були виражені 

в однакових одиницях вимірювання. 

 
Після завантаження другої матриці програма 

VeriSoft буде поєднувати матриці на початку 

координат, і обидві матриці будуть 

відображатися повністю (див. малюнок 26). 

 
Вся область, що охоплює області двох 

матриць, формує область перегляду 

(Viewport). 

 
 

 

 
 

Малюнок 26. Підстроювання двох матриць 

матриця A 

Матриця A + B 
перекриття 

матриця B 

область відображення 
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9. Імпорт матриць в форматі DICOM 
 
 

 

Якщо матриці доступні в форматі DICOM, вони 

можуть бути імпортовані. Існують наступні 

режими імпорту: 

 
- Каталог DICOM 

Імпорт з будь-якого каталогу з даними 

DICOM, 

наприклад з каталогу зберігання PTW 

DICOM, програмою PTW DicomSCP (див. 

інструкцію з використання DicomSCP). 

Для можливості завантаження даних DICOM 

програмою VeriSoft обраний каталог повинен 

містити файл індексу DICOMDIR. Якщо файл 

індексу DICOMDIR відсутній, буде 

відображено відповідне повідомлення, і 

надана можливість створити тимчасовий 

файл DICOMDIR. 

 
- DICOM SCP 

Імпорт даних DICOM безпосередньо з 

мережевого сервера DICOM. 

 
Для режиму імпорту DICOM SCP необхідно 

налаштувати мережеві параметри через меню 

Tools → Options (Сервіс - Параметри) на 

вкладці DICOM (див. Розд. 23.3.5 

"Налаштування для імпорту даних DICOM"). 

• Виберіть меню File → Data Set A/B → 

DICOM Import (Файл - Набір даних A / B - 

Імпорт DICOM). 

 
➔ На екрані з'явиться діалогове вікно 

DICOM Import (Імпорт DICOM) (див. 

малюнок 27 і малюнок 28). 



 

 
 

 
 

 
 

 
 

 

 
 
 

 

9.1. Діалогове вікно імпорту DICOM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
7 8 9 

 
 

Малюнок 27. Діалогове вікно імпорту DICOM - каталог DICOM 
 
 

1 Вибір режиму імпорту 

 
2 Вибір каталогу, що містить дані 

DICOM для імпорту 

 
3 Поля введення для пошуку пацієнта за 

ідентифікатором пацієнта або за 

прізвищем 

 
4 Вибір методів для відображення 

 
5 Поле прапорця для відображення 

попереднього перегляду матриці 

6 Структуроване дерево, що показує дані 

пацієнтів 

 
7 Параметри імпорту даних DICOM 

 
8 Відображення даних в залежності від 

рівня, виділеного в дереві (6) 

 
9 Попередній перегляд матриці для 

імпорту 

Попередній перегляд буде можливий, 

тільки якщо вибрано параметр 

Thumbnail (Піктограма), а обраний 

об'єкт містить матрицю. 
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Малюнок 28. Діалогове вікно імпорту DICOM - DICOM SCP 
 
 

1 Вибір режиму імпорту 

 
2 Ім'я вибраного сервера DICOM (сервера 

SCP) в мережі 

 
3 Поля введення для пошуку пацієнта за 

ідентифікатором пацієнта, іменем, 

прізвищем або статтю 

 
4 Поля введення для пошуку пацієнта за 

вказаним періодом створення даних 

Можна вибрати такі періоди: 

- All (Всі) 

без обмеження діапазону дат 

- Today (Сьогодні) 

- Today and yesterday (Сьогодні і вчора) 

- Yesterday (Вчора) 

- Last 7 days (Останні 7 днів) 

- Last 14 days (Останні 14 днів) 

- Custom date range (діапазон дат, 

вказаний користувачем) 

Можна вказати період (Date Range), 

використовуючи поля переліків Start 

date (Початкова дата) і End date 

(Кінцева дата). 

 
5 Вибір методів для відображення 

 
6 структурованого дерева, що показує 

дані пацієнтів 

 
7 Параметри імпорту даних DICOM 

 
8 Відображення даних в залежності від 

рівня, виділеного в дереві (6) 

 

 
 

 

 

 

 
 

  



 
 
 
 

 

9.1.1. Підтримувані методи 

 
VeriSoft може імпортувати методи DICOM: 

- RTDOSE 

- RTIMAGE 

- CT (КТ) 

 
Виберіть параметр All (Всі) для відображення 

всіх доступних методів DICOM. 

 

 

9.1.2. Структуроване дерево 

даних пацієнтів в каталозі 

Каталог DICOM 

 
В дереві пацієнтів в каталозі DICOM Directory 

доступні наступні рівні: 

 
- Patient (Пацієнт): 

адміністративні дані пацієнта 

 
- DICOM Study (Дослідження DICOM): 

інформація щодо лікування 

 
- DICOM Series (Серія DICOM): 

інформація щодо серії тестів і терапії 

 
- DICOM Object (Об'єкт DICOM): 

матриці, зображення і плани терапії 

(тільки режим імпорту з каталогу DICOM) 

 
9.1.3. Параметри для імпорту 

даних DICOM 

 
Use DICOM tag ImagePositionPatient for 

calculation of the isocenter position 

(Використовувати DICOM-тег 

ImagePositionPatient для розрахунку 

положення ізоцентра) 

 
Коли встановлено прапорець цього 

параметра, ізоцентр не буде розташовуватися 

в центрі завантаженої матриці. Замість цього 

буде використовуватися інформація про 

ізоцентр, що міститься у файлі. 

 

 
Use appropriate RTPlan object for calculation 

of the isocenter position 

(Використовувати відповідний об'єкт 

RTPlan для розрахунку положення 

ізоцентра) 

 
Коли встановлено прапорець цього 

параметра, відповідний файл DICOM RTPlan 

для обраного файлу DICOM RTDose буде 

автоматично виявлено і завантажено для 

розрахунку положення ізоцентра матриці. 

 
Якщо знайдено лише один файл RTPlan, і цей 

файл може бути певно призначений, він буде 

автоматично завантажений. Якщо ці умови не 

дотримуються, з'явиться відповідне 

повідомлення. 
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9.2. Імпорт матриць 

з каталогу DICOM 

• Виберіть режим імпорту DICOM Dir 

(Каталог DICOM) в діалоговому вікні DICOM 

Import (Імпорт DICOM). 

 
• Вибір каталогу, що містить дані DICOM для 

імпорту. 

 

➔ Для можливості імпорту даних DICOM 

обраний каталог повинен містити файл 

індексу DICOMDIR. Якщо ця умова не 

виконується, з'явиться наступне 

повідомлення: 

 

 

Малюнок 29. Запит при відсутності файлу 
DICOMDIR 

9.2.1. Вибір матриці в каталозі 

DICOM 

 
Щоб швидко перейти до матриці можна 

скористатися полями введення прізвища (last 

name) або ідентифікатора (ID) пацієнта в 

якості фільтрів. 

 
• У діалоговому вікні DICOM Import (Імпорт 

DICOM), введіть прізвище або ідентифікатор 

пацієнта. Введіть параметр повністю або 

тільки початкові символи і зірочку «*» в кінці. 

 
• Натисніть кнопку Search (Пошук). 

 
➔ У структурованому дереві будуть 

показані тільки набори DICOM-даних 

пацієнтів, що відповідають вибраним 

умовам пошуку. 

 
 

9.2.2. Імпорт матриці 
 

• При натисканні кнопки OK буде створено 

тимчасовий файл DICOMDIR. 

При натисканні кнопки Cancel (Скасування) 

вікно запиту буде закрито, а імпорт даних 

DICOM буде неможливий. 

 
• Виберіть і імпортуйте потрібні дані, як 

описано в розд. 9.2.1 "Вибір матриці в каталозі 

DICOM " і 9.2.2 "Імпорт матриці". 

 
• Імпортуйте матрицю, вибравши потрібну 

матрицю і натиснувши кнопку Import (Імпорт). 

 

➔ Діалогове вікно DICOM Import (Імпорт 

DICOM) закриється. 

 
➔ Матриця буде імпортована і 

відображена у відповідному вікні 

матриці як зображення у відтінках сірого 

з ізодозами. Ізоцентр буде позначений 

косим хрестом. 

 
➔ Одночасно буде оновлено вікно 

результатів. Наприклад, буде 

відображено представлення профілю 

виміряної матриці. 



 
 
 
 
 

 

Якщо імпортована матриця є об'ємним 

набором доз, то відображення у вікні 

попереднього перегляду і в вікні матриці 

залежить від напрямку зрізу, обраного в меню 

Tools → Options (Сервіс - Параметри) на 

вкладці DICOM (див. Розд. 23.3.5 

"Налаштування для імпорту даних DICOM"). 
 

 
 

 

9.2.3. Видалення даних DICOM 

 
В діалоговому вікні DICOM Import (Імпорт 

DICOM) є можливість видалення окремих 

матриць або повних записів даних пацієнтів з 

каталогу PTW DICOM. 

 
• Виберіть матрицю або запис даних 

пацієнта для видалення. 

 
• Виберіть пункт контекстного меню Remove 

(Видалити). 

 
➔ Після підтвердження дії обрана матриця 

або обраний запис даних пацієнта 

будуть видалені. 

9.3. Імпорт матриць з 

мережевого сервера 

DICOM 

• Виберіть режим імпорту DICOM SCP в 

діалоговому вікні DICOM Import (Імпорт 

DICOM). 

 
➔ На екрані буде відображено сервер 

DICOM, встановлений через меню Tools 

→ Options (Сервіс - Параметри) на 

вкладці DICOM. 

• Знайдіть потрібні дані, як описано в розд. 

9.3.1 "Пошук матриці на мережевому сервері 

DICOM". 

 
• Імпортуйте дані, як описано в розд. 9.3.2 

"Вибір і імпорт матриці з мережевого сервера 

DICOM". 

 
 

 
9.3.1. Пошук матриці на 

мережевому сервері DICOM 

• Задайте умови пошуку в діалоговому вікні 

DICOM Import (Імпорт DICOM). 

У полях введення імені та прізвища або 

ідентифікатора пацієнта можна ввести 

параметр повністю, або початкові символи із 

зірочкою «*» в кінці, або тільки зірочку «*», щоб 

знайти всіх пацієнтів для обраного періоду. 

• Натисніть кнопку Search (Пошук). 

 
➔ У структурованому дереві будуть 

показані всі набори DICOM-даних 

пацієнтів, що відповідають вибраним 

умовам пошуку. 

ПРИМІТКА 
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9.3.2. Вибір і імпорт матриці з 

мережевого сервера DICOM 

• Виберіть потрібну матрицю, встановивши 

відповідний прапорець на рівні Study 

(Дослідження) або Series (Серія). 

 
• Імпортуйте обрану матрицю, натиснувши 

кнопку Import (Імпорт). 

 

➔ Діалогове вікно DICOM Import (Імпорт 

DICOM) закриється. 

 
➔ Матриця буде імпортована і 

відображена у відповідному вікні 

матриці як зображення у відтінках сірого 

з ізодозами. Ізоцентр буде позначений 

косим хрестом. 

 
Програма VeriSoft виконає наступні дії: 

 
- Якщо вибрати декілька об'єктів з однаковим 

методом, вони будуть додані. Якщо 

додавання неможливе, буде виведено 

повідомлення про помилку. 

 
- Якщо вибрати серію RTDose та RTPlan і 

встановити параметри Use DICOM tag 

ImagePositionPatient for calculation of the 

isocenter position (Використовувати DICOM-тег 

ImagePositionPatient для розрахунку 

положення ізоцентра) і Use appropriate RTPlan 

object for calculation of the isocenter position 

(Використовувати відповідний об'єкт RTPlan 

для розрахунку положення ізоцентра), 

ізоцентр буде розрахований відповідним 

чином (див. також розд. 9.1.3 "Параметри для 

імпорту даних DICOM"). 

Якщо вибрати декілька серій RTPlan, буде 

виведено відповідне повідомлення і можна 

буде вибрати потрібну серію RTPlan. 

 
➔ Одночасно буде оновлено вікно 

результатів. Наприклад, буде 

відображено представлення профілю 

виміряної матриці. 
 

Якщо імпортована матриця є об'ємним 

набором доз, то відображення у вікні 

попереднього перегляду і в вікні матриці 

залежить від напрямку зрізу, обраного в меню 

Tools → Options (Сервіс - Параметри) на 

вкладці DICOM (див. Розд. 23.3.5 

"Налаштування для імпорту даних DICOM"). 
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10. Вимірювання 
матриць 

 
 

10.1. Підготовка 

до вимірювання 

 
Перед виконанням вимірювань налаштуйте 

програму належним чином через меню Tools → 

Measurement Options (Сервіс - Налаштування 

вимірювань), (див. також розділ 23.2 

"Налаштування вимірювань"): 

 
• В панелі Devices in Use (Використовувані 

пристрої) на вкладці Devices (Пристрої) 

виберіть використовувані вимірювальні 

пристрої: 

-  використовуваний матричний детектор і 

пов'язаний файл калібрування (*.cal) 

-  приналежності (тільки для вимірювань з 

поворотним блоком або інклінометром) 

 
• В панелі Connections (З'єднання) на вкладці 

Devices (Пристрої) налаштуйте параметри 

передачі даних. 

 
• На вкладці Measurement (Вимірювання) 

задайте час вимірювання. 

 
• На вкладці Measurement (Вимірювання) 

задайте інтервал часу. 

Після кожного інтервалу доступний новий набір 

значень вимірювання (одне значення для 

кожного каналу). 

 
• На вкладці Advanced (Додатково) задайте 

налаштування для інклінометра (тільки для 

вимірювань з використанням інклінометра). 

 
 

Переконайтеся, що серійний номер 

використовуваного матричного детектора 

збігається з серійним номером, показаним в 

рядку стану. У рядку стану показаний 

серійний номер, взятий з файлу 

калібрування. VeriSoft не перевірятиме 

підключене устаткування. 
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10.2. Налаштування 

параметрів вимірювання 

• Для завантаження матриць клацніть 

на відповідній кнопці або виберіть меню 

File → Data Set A / B → Measure (Файл - 

Набір даних A / B - Виміряти). 

 

➔ Спочатку з'явиться діалогове вікно для 

введення параметрів вимірювання: 

 
 
 

 
Малюнок 30. Діалогове вікно параметрів 

вимірювання - поправки для T і P 

• У цьому діалоговому вікні визначте із 

наведеного нижче параметри вимірювання: 

-  Поправочні параметри для поправки до 

щільності повітря або перехресного 

калібрування (див. також розд. 10.7 

"Поправка до щільності повітря" і 10.9 

"Перехресне калібрування") 

 
- Додатковий, вільний поправочний коефіцієнт 

kUser 

допустимий діапазон: 0,1 ... 10 

за замовчуванням: 1,0 

-  Поправочний коефіцієнт kEnergy для якості 

випромінювання, для поправки до щільності 

повітря (див. також розд. 10.8 "Поправочний 

коефіцієнт для якості випромінювання") 

 
- Визначення положення ізоцентра (див. також 

розд. 10.10 "Визначення положення 

ізоцентра"). 

Визначення положення ізоцентра потрібне 

тільки в тому випадку, якщо матричний 

детектор встановлений не в ізоцентрі. 

Якщо обрано приналежність Rotation Unit 

(Поворотний блок) або Rotation Unit SRS 

(Поворотний блок SRS), положення 

ізоцентра неможливо визначити. 

 
-  Автоматичне збереження вихідних значень 

вимірювань: 

Встановіть відповідний прапорець. Натисніть 

кнопку ... , щоб вибрати каталог. Тепер 

вимірювання будуть автоматично 

зберігатися в цьому каталозі. Запропоноване 

ім'я файлу складається з поточної дати і 

часу. 



ПРИМІТКА 
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За замовчуванням перед кожним 

вимірюванням відкривається діалогове вікно 

Measurement Parameters (Параметри 

вимірювання). Якщо зняти прапорець Show 

dialog on next measurement (Відкрити 

діалогове вікно при наступному вимірюванні), 

діалогове вікно буде відкриватися тільки 

перед першим вимірюванням після 

перезапуску програми VeriSoft. Таким чином, 

можна задати параметри відразу для всіх 

наступних вимірювань. 

 

Вікно Measurement Parameters (Параметри 

вимірювання) можна також відкрити, 

вибравши меню Edit → Measurement 

Parameters (Правка - Параметри 

вимірювання). Змінені параметри будуть діяти 

для наступних вимірювань. 

Щоб змінити значення поправок для матриць 

відображеного матричного детектора, 

потрібно використати функцію Calibrate 

(Вирівнювання)   (див.   Розд.   13.4.1 

"Калібрування матриць матричного 

детектора"). 

• Підтвердіть введені параметри 

натисканням кнопки OK. 

10.3. Вимірювання з 

матричним детектором 
(Без використання приналежностей) 

 
• Підготуйте калібрування, як описано в розд. 

10.1 "Підготовка до вимірювання". 

 
• Налаштуйте параметри вимірювань, як 

описано в розд. 10.2 "Налаштування 

параметрів вимірювання" і підтвердіть їх 

натисканням кнопки OK. 

 

➔ З'явиться вікно вимірювань. 

 
• Виконайте потрібне вимірювання і прийміть 

дані вимірювання, натиснувши кнопку Accept 

(Прийняти). 

 

Додаткову інформацію про виконання 

вимірювань див. в розд. 24 "VeriSoft вікно 

вимірювань". 
 

 

 
➔ Виміряна матриця буде відображена у 

відповідному вікні матриці як 

зображення у відтінках сірого з 

ізодозами. Ізоцентр буде позначений 

косим хрестом. 

 
➔ Одночасно буде оновлено вікно 

результатів. Наприклад, буде 

відображено представлення профілю 

виміряної матриці. 
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В разі представлення зображень у відтінках 

сірого або ізодоз, матриці матричного 

детектора завжди будуть відображатися 

розміром 27 x 27 см (для детектора 

OCTAVIUS Detector1000SRS: 11 x 11 см) з 

дозволом 0,5 мм. Відсутні точки між двома 

виміряними значеннями будуть визначатися 

інтерполяцією. Точки в приграничній області 

екстраполюються на основі сусідніх виміряних 

значень. Інтерпольовані значення 

використовуються тільки для поліпшення 

візуалізації розподілу доз. Вони не будуть 

враховуватися для аналізу. 
 

 
 
 
 

Через обмеженість просторового дозволу 

ізодози матричного детектора дають 

обмежену точність, і вони відображаються 

тільки як орієнтовні значення. Ппедставлення 

ізодози, яке визначається вимірюванням з 

матричним детектором, не підходить для 

порівняння виміряних і розрахункових даних. 
 

10.4. Вимірювання OCTAVIUS 

4D 

 
Вимірювальна система для цього 

вимірювання складається з матричного 

детектора, поворотного блоку, блоку 

управління і інклінометра, наприклад апаратні 

компоненти системи OCTAVIUS 4D. 

Матричний детектор буде вставлений в 

поворотний блок і буде повертатися 

синхронно з кутом гентрі, завжди 

забезпечуючи перпендикулярний напрямок 

випромінювання відносно матричного 

детектора. Для цього інклінометр визначає кут 

гентрі джерела випромінювання. Блок 

управління використовує ці дані для 

управління обертанням поворотного блоку. 

 
Можна використовувати поворотний блок 

стандартної версії або модульної версії зі 

стандартним верхом або верхом SRS. 

 
В цьому вимірюванні для кожного інтервалу 

вимірювання зберігаються кут гентрі і 

значення доз для всіх вимірювальних камер 

матричного детектора. 

 
При завантаженні даних розподіл доз буде 

розраховано для кожного інтервалу 

вимірювання на основі кривих «глибина - 

доза», які залежать від розміру поля. При 

цьому будуть додані розподіли доз всіх 

інтервалів вимірювання. 

 
Інформацію щодо створення файлів PDD з 

необхідними кривими «глибина - доза» див. в 

розд. 23.3.7 "Створення файлів PDD". 

ПРИМІТКА 
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• Підготуйте калібрування, як описано в 

розд. 10.1 "Підготовка до вимірювання". 

 
• Налаштуйте параметри вимірювань, як 

описано в розд. 10.2 "Налаштування 

параметрів вимірювання" і підтвердіть їх 

натисканням кнопки OK. 

 
➔ З'явиться вікно вимірювань. 

 
• Виконайте потрібне вимірювання і прийміть 

дані вимірювання, натиснувши кнопку Accept 

(Прийняти). 

 

Додаткову інформацію про виконання 

вимірювань див. в розд. 24 "VeriSoft вікно 

вимірювань ". 
 

 

➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). 
 

Малюнок 31. Виберіть діапазон кутів для 
розрахунку об'ємного набору 
доз OCTAVIUS 4D 

 

В панелі Select Range (Вибір діапазону) 

вкажіть, чи будуть використовуватися всі дані 

вимірювання або тільки виміряні значення 

певного діапазону кутів для розрахунку 

об'ємного набору доз OCTAVIUS 4D: 

 
• Для цього виберіть потрібний режим в полі 

переліку Range mode (Режим діапазону): 

- All (Всі) 

всі дані вимірювання (за замовчуванням) 

- Angle (Кут) 

діапазон кутів 

 
➔ При виборі параметра Angle (Кут) 

максимальний діапазон кутів, доступний 

для вибору, буде показаний в області 

Available (Доступні). 
 

Якщо потрібно розрахувати об'ємний набір доз 

OCTAVIUS 4D тільки для обраного діапазону 

кутів, експортуйте дані тільки для цього 

діапазону кутів в систему планування 

променевої терапії, щоб забезпечити 

обґрунтоване порівняння даних. 
 

 
• Введіть діапазон для розрахунку в області 

Selected (Вибрані). 

 
• В панелі PDD File (Файл PDD) виберіть 

файл PDD для розрахунку об'ємного набору 

доз. 

Каталог з файлами PDD повинен бути заданий 

через меню Tools → Options (Сервіс - 

Параметри) на вкладці 4D Dosimetry 

(Дозиметрія 4D) (див. Розд. 23.3.6 

"Налаштування для 4D-дозиметрії"). 
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• В панелі Calculation Limits (Границі 

розрахунків) введіть границі на розмір 

об'ємного набору доз для розрахунку. Границі 

залежать від використовуваного матричного 

детектора і від поворотного блоку. Клацнувши 

на кнопці Set to default (Встановити за 

замовчуванням), можна відновити границі за 

замовчуванням. Налаштування за 

замовчуванням для границь - максимальний 

діапазон, доступний для розрахунків. 

- Cylinder Radius [mm] (Радіус циліндра [мм]) 

Радіус області об'ємного набору доз для 

розрахунку 

 
- Cylinder Length [mm] (Довжина циліндра [мм]) 

Довжина області об'ємного набору доз для 

розрахунку 

 
• Підтвердити налаштування натисканням 

кнопки OK. 

 
• Оскільки каталог з файлами PDD містить 

декілька файлів, потрібно знову підтвердити 

вибрані файли PDD в окремому вікні запиту. 

Знявши відповідний прапорець у вікні запиту, 

ви вимкнете це вікно до перезапуску програми 

VeriSoft або до вибору іншого файлу PDD. 

 
➔ Якщо обраний файл PDD містить криві 

«глибина - доза» не для всіх розмірів 

поля аж до 26x26 см (для детектора 

OCTAVIUS Detector 1000SRS: 11x11 см), 

то для всіх відсутніх розмірів поля 

потрібно   використовувати   криву 

«глибина - доза» з найбільшим розміром 

поля. Знявши відповідний прапорець у 

вікні запиту, ви вимкнете це вікно до 

перезапуску програми VeriSoft або до 

вибору іншого файлу PDD. 

 

Малюнок 32. Вікно запиту в разі відсутності 
кривих «глибина - доза» 

➔ Якщо обраний файл PDD не містить 

інформації щодо того, для якого 

джерела випромінювання він 

призначений - з режимом FFF або без 

режиму FFF, то буде виведений 

наступний запит: 

 

Малюнок 33. Вікно запиту в разі відсутності 
інформації про режим FFF 

 
• Якщо файл PDD був визначений для 

джерела випромінювання з режимом FFF, 

підтвердіть запит, натиснувши кнопку Yes 

(Так). 

➔ Відповідна інформація (фільтр = FFF) 

буде введена в файл PDD і збережена. 
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• Якщо файл PDD був визначений для 

джерела випромінювання без режиму FFF, 

підтвердіть запит, натиснувши кнопку No (Ні). 

➔ Відповідна інформація (фільтр = FF) 

буде введена в файл PDD і збережена. 

 
➔ На екран виводяться результати 

вимірювань. За допомогою файлу PDD 

розподіл доз буде розраховано для 

кожного інтервалу вимірювання, і будуть 

додані розподіли доз всіх інтервалів 

вимірювання. Якщо обрано діапазон 

кутів, розподіли доз будуть розраховані 

і додані тільки для інтервалів 

вимірювання цього діапазону кутів. 

 
➔ Зріз об'ємного набору доз на глибині 0 

мм буде відображений у відповідному 

вікні матриці у вигляді зображення у 

відтінках сірого з ізодозами. Ізоцентр 

буде позначений косим хрестом. 

 
➔ Одночасно буде оновлено вікно 

результатів. Наприклад, буде 

відображено представлення профілю 

для зрізу об'ємного набору доз на 

глибині 0 мм. 

 

 
Інші зрізи об'ємного набору доз можна 

відобразити за допомогою повзунка у 

спливаючому вікні Slice (Зріз). 

 
Додаткову інформацію про відображення 

матриць матричного детектора див. в розд. 

10.3 "Вимірювання з матричним детектором". 

 
Додаткову інформацію про об'ємні набори доз 

див. в розд. 20 "Робота з об'ємними наборами 

доз і переліками матриць". 

10.4.1. Моніторинг стану 

Bluetooth-з'єднання 
 

Моніторинг стану Bluetooth-з'єднання 

можливий тільки при дотриманні наступних 

умов: 

- VeriSoft ≥ 7.2 

-  Блок управління OCTAVIUS 4D з мікро- 

програмним забезпеченням версії ≥ 2.0 
 

 

Система OCTAVIUS 4D використовує 

Bluetooth-з'єднання для відправки даних з 

інклінометра на блок управління. Стан 

Bluetooth-з'єднання вказується індикатором на 

блоці управління. 

 
Якщо версія VeriSoft ≥ 7.2, а версія мікро- 

програмного забезпечення блоку управління 

OCTAVIUS 4D ≥ 2.0, то стан Bluetooth- 

з'єднання передається в програму VeriSoft: 

 
-  Стан Bluetooth-з'єднання буде перевірено 

перед початком вимірювання. Якщо 

виявиться проблема, буде виведено 

відповідне повідомлення і вимірювання не 

буде розпочато. 

 
-  Стан Bluetooth-з'єднання буде постійно 

перевірятися в процесі вимірювання. Якщо 

виявиться проблема, буде виведено 

відповідне повідомлення і вимірювання буде 

перервано. 
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10.4.2. Зауваження по процедурам 

некомпланарного опромінення 

• Якщо потрібно розрахувати об'ємний набір 

доз для некомпланарного опромінення, то 

спочатку в меню Tools → Options (Сервіс - 

Параметри) на вкладці 4D Dosimetry 

(Дозиметрія 4D) виберіть Non coplanar 4D 

dosimetry (Некомпланарна 4D-дозиметрія) в 

панелі Non-Standard 4D Dosimetry 

(Нестандартна 4D-дозиметрія) (див. у розд. 

23.3.6 "Налаштування для 4D-дозиметрії"). 

➔ У діалоговому вікні Select an angle range 

(Вибір діапазону кутів) з'явиться 

додаткове поле з переліком Couch Angle 

(Кут столу) на панелі PDD File (Файл 

PDD), за допомогою якого можна 

налаштувати кут повороту стола 

пацієнта: 

 

 

Малюнок 34. Виберіть діапазон кутів для 
розрахунку об'ємного набору доз 
OCTAVIUS 4D для 
некомпланарного опромінення 

• В полі з переліком Couch Angle (Кут столу) 

виберіть або введіть кут повороту для столу 

пацієнта. 

-  Якщо файл RTPlan завантажений, кути 

повороту столу будуть зчитуватися з файлу 

RTPlan і вводитися в полі з переліком. Якщо 

одне значення кута повороту зустрічається 

кілька разів, воно вводиться тільки один раз. 

-  Введене значення кута повороту повинно 

відповідати вимогам стандарту IEC 61217. 

 
➔ На основі даних компланарних 

вимірювань і кута повороту деки столу 

пацієнта програма VeriSoft розраховує 

об'ємний набір доз для некомпла- 

нарного опромінення. 

Якщо введено кут повороту 0°, буде 

розрахований об'ємний набір доз 

OCTAVIUS 4D для компланарного 

опромінення. 

 
 

Додаткову інформацію про виконання 

вимірювань при некомпланарному 

опроміненні і про завантаження цих 

вимірювань див. в офіційному документі 

D913.200.12, опублікованому PTW. 
 



 
 
 
 

10.4.3. Зауваження по процедурам 

опромінення з поворотним 

блоком, розташованим не в 

ізоцентрі 

 
• Якщо потрібно розрахувати об'ємний набір 

доз для опромінення при розташуванні 

поворотного блоку не в ізоцентрі, то спочатку 

в меню Tools → Options (Сервіс - Параметри) 

на вкладці 4D Dosimetry (Дозиметрія 4D), 

виберіть Off-axis 4D dosimetry (4D-дозиметрія 

зі зсувом від осі) на панелі Non-Standard 4D 

Dosimetry (Нестандартна 4D-дозиметрія) (див. 

у розд.23.3.6 "Налаштування для 4D- 

дозиметрії"). 

➔ У діалоговому вікні Select an angle range 

(Вибір діапазону кутів) є панель Off-axis 

4D dosimetry (4D-дозиметрія зі зсувом 

від осі): 

 
 

 

Малюнок 35. Діалогове вікно вибору 
діапазону кутів для розрахунку 
об'ємного набору доз 
OCTAVIUS 4D для опромінення 
при розташуванні 
поворотного блоку не в 
ізоцентрі 

 
• В панелі Off-axis 4D Dosimetry (4D- 

дозиметрія зі зсувом від осі) введіть значення 

зміщення поворотного блоку в міліметрах з 

одним знаком після коми для наступних 

напрямків. 

- LR - напрямок зліва направо 

- TG - напрямок мішень-джерело 

- BT - напрямок знизу вгору 

Діапазони введення: 

-  приналежність Rotation Unit (Поворотний 

блок) з усіма детекторами OCTAVIUS: 

всі напрямки (0 ... ± 250) мм 

 
- приналежність Rotation Unit SRS (Поворотний 

блок SRS) з детекторами OCTAVIUS Detector 

729 і 1500: 

напрямок TG (0 ... ± 120) мм 

напрямок LR і BT    (0 ... ± 250) мм 

 
- приналежність Rotation Unit SRS (Поворотний 

блок SRS) з детектором OCTAVIUS Detector 

1000SRS: 

всі напрямки (0 ... ± 250) мм 
 

При введенні цих значень див. визначення 

системи координат в стандарті IEC 61217 і 

наступну ілюстрацію. 

 

Малюнок 36. Відповідність між 
координатами IEC і 
координатами PTW 
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➔ На основі даних вимірювань і значень 

зсуву VeriSoft розраховує об'ємний 

набір доз для опромінення при 

розташуванні поворотного блоку не в 

ізоцентрі. 

Ізоцентром є нульова точка значень 

дози, які відображаються в VeriSoft. 

Якщо для кожного значення зміщення 

вводиться 0, об'ємний набір доз 

OCTAVIUS 4D буде вирахувано при 

розташуванні поворотного блоку в 

ізоцентрі. 

 
 

Додаткову інформацію про виконання 

вимірювань при опроміненні з поворотним 

блоком, розміщеним не в ізоцентрі, та про 

завантаження цих вимірювань, див. в 

офіційному документі D913.200.12, 

опублікованому PTW. 
 

10.5. Вимірювання з 

матричним детектором і 

планарним поворотним 

блоком 

 
Вимірювальна система для цього 

вимірювання складається з матричного 

детектора, планарного поворотного блоку, 

блоку управління та інклінометра, наприклад 

апаратні компоненти системи OCTAVIUS 4D. 

Матричний детектор буде вставлений в 

поворотний блок і буде повертатися 

синхронно з кутом гентрі, завжди 

забезпечуючи перпендикулярний напрямок 

випромінювання відносно матричного 

детектора. Для цього інклінометр визначає кут 

гентрі джерела випромінювання. Блок 

управління використовує ці дані для 

управління обертанням поворотного блоку. 

 
В цьому вимірюванні для кожного інтервалу 

вимірювання зберігаються кут гентрі і 

значення доз для всіх вимірювальних камер 

матричного детектора. 

 
Результатом вимірювання в програмі VeriSoft 

є матриця з підсумовуванням значень доз 

кожної вимірювальної камери. 
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• Підготуйте калібрування, як описано в 

розд. 10.1 "Підготовка до вимірювання". 

 
• Налаштуйте параметри вимірювань, як 

описано в розд. 10.2 "Налаштування 

параметрів вимірювання" і підтвердіть їх 

натисканням кнопки OK. 

 

➔ З'явиться вікно вимірювань. 

 
• Виконайте потрібне вимірювання і прийміть 

дані вимірювання, натиснувши кнопку Accept 

(Прийняти). 

 

Додаткову інформацію про виконання 

вимірювань див. в розд. 24 "VeriSoft вікно 

вимірювань". 
 

 

 
➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). 
 

Малюнок 37. Відкрийте діалогове вікно 
діапазону для кутів гентрі 

В панелі Select Range (Вибір діапазону) 

вкажіть, чи повинні відображатися всі дані 

вимірювання або тільки виміряні значення 

певного діапазону кутів: 

 
• Для цього виберіть потрібний режим в полі 

переліку Range mode (Режим діапазону): 

- All (Всі) 

всі дані вимірювання (за замовчуванням) 

- Angle (Кут) 

діапазон кутів 

- Time (Час) 

інтервал часу 

 
➔ При виборі параметра Angle (Кут) або 

Time (Час) максимальний діапазон кутів 

або інтервал часу, доступний для 

вибору, буде показаний в області 

Available (Доступні). 

 
• Введіть діапазон для відображення в 

області Selected (Вибрані). 

 
• Підтвердіть налаштування натисканням 

кнопки OK. 

 
➔ Виміряна матриця буде відображена у 

відповідному вікні матриці як 

зображення у відтінках сірого з 

ізодозами. Ізоцентр буде позначений 

косим хрестом. 

В даному випадку виміряна матриця є 

доданою сумою окремих значень. 

Наприклад, якщо обрати діапазон кутів 

від 0° до 90°, то буде відображена 

матриця з сумарною дозою для цього 

діапазону кутів. 

 

➔ Одночасно буде оновлено вікно 

результатів. Наприклад, буде 

відображено представлення профілю 

виміряної матриці. 

 
Додаткову інформацію по відображенню 

матриць див. в розд. 10.3 "Вимірювання з 

матричним детектором". 
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10.6. Вимірювання з 

матричним детектором та 

інклінометром 

 

Наступна інформація не відноситься до 

використання інклінометра з поворотним 

блоком. В цьому випадку див. Розд.10.4 

"Вимірювання OCTAVIUS 4D". 
 

 

 
Вимірювальна система для цього 

вимірювання складається з матричного 

детектора, фантома OCTAVIUS і інклінометра. 

Матричний детектор буде вставлений в 

фантом OCTAVIUS. Інклінометр визначає кут 

гентрі джерела випромінювання. 

 
В цьому вимірюванні для кожного інтервалу 

вимірювання зберігаються кут гентрі і 

значення доз для всіх вимірювальних камер 

матричного детектора. 

 
Результатом вимірювання в програмі VeriSoft 

є матриця з підсумовуванням значень доз 

кожної вимірювальної камери. 

• Підготуйте калібрування, як описано в 

розд. 10.1 "Підготовка до вимірювання". 

 
• Налаштуйте параметри вимірювань, як 

описано в розд. 10.2 "Налаштування 

параметрів вимірювання" і підтвердіть їх 

натисканням кнопки OK. 

 
➔ З'явиться вікно вимірювань. 

 
• Виконайте потрібне вимірювання і прийміть 

дані вимірювання, натиснувши кнопку Accept 

(Прийняти). 

 

Додаткову інформацію про виконання 

вимірювань див. в розд. 24 "VeriSoft вікно 

вимірювань". 
 

 

➔ На екрані з'явиться діалогове вікно 

Select an angle range (Вибір діапазону 

кутів). 
 

Малюнок 38. Відкрийте діалогове вікно 
діапазону для кутів гентрі 
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В панелі Select Range (Вибір діапазону) 

вкажіть, чи повинні відображатися всі дані 

вимірювання або тільки виміряні значення 

певного діапазону кутів: 

 
• Для цього виберіть потрібний режим в полі 

переліку Range mode (Режим діапазону): 

- All (Всі) 

всі дані вимірювання (за замовчуванням) 

- Angle (Кут) 

діапазон кутів 

- Time (Час) 

інтервал часу 

 
➔ При виборі параметра Angle (Кут) або 

Time (Час) максимальний діапазон кутів 

або інтервал часу, доступний для 

вибору, буде показаний в області 

Available (Доступні). 

 
• Введіть діапазон для відображення в 

області Selected (Вибрані). 

 
• Підтвердіть налаштування натисканням 

кнопки OK. 

 
➔ Виміряна матриця буде відображена у 

відповідному вікні матриці як 

зображення у відтінках сірого з 

ізодозами. Ізоцентр буде позначений 

косим хрестом. 

В даному випадку виміряна матриця є 

доданою сумою окремих значень. 

Наприклад, якщо обрати діапазон кутів 

від 0° до 90°, то буде відображена 

матриця з сумарною дозою для цього 

діапазону кутів. 

 

➔ Одночасно буде оновлено вікно 

результатів. Наприклад, буде 

відображено представлення профілю 

виміряної матриці. 

 
Додаткову інформацію по відображенню 

матриць див. в розд. 10.3 "Вимірювання з 

матрічним детектором ". 

10.7. Поправка до 

щільності повітря 

 
Матричні детектори PTW містять вентильовані 

іонізаційні камери. З цієї причини необхідно 

вводити поправку до щільності повітря. 

 

Детектор OCTAVIUS Detector 1000SRS 

відноситься до матричних детекторів з 

камерами, заповненими рідиною. Для таких 

матричних детекторів потрібно ввести тільки 

коефіцієнт калібрування kuser і/або виконати 

перехресне калібрування. 
 

 
 

• Виберіть параметр Correction T and P 

(Поправка до T і P) в діалоговому вікні 

Measurement Parameters (Параметри 

вимірювання): 

 

Малюнок 39. Діалогове вікно параметрів 
вимірювання - поправки для T і P 



VeriSoftTM 

Загальні відомості 

 

ПРИМІТКА 

ПРИМІТКА 

 
 
 
 

 

• Введіть значення температури і 

атмосферного тиску. 

 
- Температура 

допустимий діапазон: (5 ... 45) ° C, 

за замовчуванням: 20 ° C 

 
- Атмосферний тиск 

допустимий діапазон: (600 ... 1100) гПа 

за замовчуванням: 1013,25 гПа 

 

 
➔ Поправочний коефіцієнт kTP для 

поправки до щільності повітря 

обчислюється за такою формулою: 
 

 
T  температура в вимірювальному об'ємі 

[°C] 

P  атмосферний тиск на ділянці 

вимірювання [гПа] 

T0 референтна температура 20°C або 

22°C 

P0 референтний атмосферний тиск 

1013,25 гПа 

 

Референтну температуру для вимірювання 

можна змінити в меню Tools → Measurement 

Options (Сервіс - Налаштування вимірювань) 

на вкладці Measurement (Вимірювання) (див. 

Розд. 23.2.2 "Measurement Settings 

(Налаштування вимірювань)"). 
 

 

 

➔ Всі подальші вимірювання скориговані 

множенням на поправочні коефіцієнти 

kTP, kUser і kEnergy. 

10.8. Поправочний 

коефіцієнт для якості 

випромінювання 

 
Для корекції щільності повітря необхідно 

додатково ввести поправочний коефіцієнт для 

якості випромінювання. 

 
Поправочні коефіцієнти для якості 

випромінювання вказані в таблиці. 

 
• Натисніть кнопку Change (Змінити) в 

діалоговому вікні Measurement Parameters 

(Параметри вимірювання). 

➔ На екрані з'явиться діалогове вікно 

Energy Calibration (Калібрування 

енергій): 

 

Малюнок 40. Діалогове вікно калібрування 
енергій 

• Виберіть поправочний коефіцієнт, 

встановивши відповідний прапорець. 

 

Програма VeriSoft не перевіряє відповідність 

налаштованої і фактично використовуваної 

якості випромінювання. 
 



 
 
 
 
 
 

Додавання поправочного коефіцієнта 

 
• Введіть енергію і відповідний поправочний 

коефіцієнт в порожній рядок таблиці. 

 
• Підтвердіть вибір натисканням клавіші 

Enter. 

 
➔ Новий поправочний коефіцієнт буде 

додано в таблицю. 

10.9. Перехресне 

калібрування 

 
Замість визначення поправки до щільності 

повітря можна скорегувати виміряні значення 

за допомогою перехресного калібрування. У 

разі перехресного калібрування температура, 

тиск повітря, енергія, і потужність джерела 

випромінювання будуть скориговані 

одночасно. 

 

 
Видалення поправочного коефіцієнта 

 
• Виберіть поправочний коефіцієнт для 

видалення, клацнувши на відповідному рядку. 

 
• Натисніть клавішу Delete. 

 
➔ Обраний поправочний коефіцієнт буде 

видалений. 

Компанія PTW рекомендує повторювати 

перехресне калібрування кожного робочого 

дня. 

Компанія PTW рекомендує виконувати 

перехресне калібрування при розмірі поля, що 

відповідає розміру поля області застосування. 

Типовий розмір поля для детектора 

OCTAVIUS Detector 729 або OCTAVIUS 

Detector 1500 становить 10x10 см. Типовий 

розмір поля для детектора OCTAVIUS Detector 

1000SRS становить 4x4 см. 
 

 

 
• Виберіть параметр Cross Calibration 

(Перехресне калібрування) в діалоговому вікні 

Measurement Parameters (Параметри 

вимірювання): 

ПРИМІТКА 
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Малюнок 41. Діалогове вікно параметрів 
вимірювання - перехресне 
калібрування 

• В полі введення Expected value (Очікуване 

значення) введіть очікуване виміряне 

значення для референтного вимірювання 

центральної камери (наприклад, 1 Гр). 

 
• Почніть вимірювання, натиснувши кнопку 

Measure (Виміряти). 

 
➔ З'явиться вікно вимірювань. 

 
• Виконайте потрібне референтне 

вимірювання. 

Тобто, слід опромінити референтне поле 

(наприклад, 10x10 см, 1 Гр). Доза опромінення 

повинна відповідати значенню дози, 

введеному в полі введення в діалоговому вікні 

Expected value (Очікуване значення). 

• Прийміть дані вимірювань, натиснувши 

кнопку Accept (Прийняти). 

 

➔ В полі значень Measured (Обмірювані) 

буде відображено фактичне виміряне 

значення, і буде розраховано 

поправочний коефіцієнт для 

перехресного калібрування. 
 

Референтне вимірювання відрізняється від 

звичайного вимірювання. Воно 

використовується тільки для визначення 

поправочного коефіцієнта для перехресного 

калібрування. 

Всі подальші вимірювання коригуються 

множенням на поправочні коефіціент kCross і 

kUser. 

В цьому випадку поправку до щільності 

повітря, що отримується введенням 

температури і тиску повітря, неможливо 

визначити. 

 

 

Додаткову інформацію про виконання 

вимірювань див. в розд. 24 "VeriSoft вікно 

вимірювань". 
 

ПРИМІТКА 
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10.10. Визначення положення 

ізоцентра 
 

Ця функція недоступна для вимірювань 

OCTAVIUS 4D. 

 
• В діалоговому вікні Measurement 

Parameters (Параметри вимірювання) задайте 

положення ізоцентра, ввівши відстані в 

напрямку LR (зліва-направо) і TG (мішень- 

джерело) між ізоцентром та центром 

матричного детектора. 

 
або 

 
• Натисніть кнопку Define (Визначити). 

 
➔ На екрані з'явиться діалогове вікно Array 

Isocenter (Ізоцентр матриці). 
 

Малюнок 42. Діалогове вікно ізоцентра 
матричного детектора 

• Для визначення ізоцентра клацніть на 

зображенні або введіть відстань від ізоцентра 

до центра матричного детектора в напрямку 

LR (зліва-направо) і TG (мішень-джерело) і 

перевірте стан, натиснувши кнопку Apply 

(Застосувати). 

 
• Підтвердіть новий ізоцентр натисканням 

кнопки OK. 
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11. Збереження і закриття матриць 
 
 
 

 

11.1. Збереження матриць 

 
Матриці матричного детектора можуть бути 

збережені у форматі PTW mcc (*.mcc), в 

форматі TIFF (*.tif) або в форматі зображення 

PTW (*.dat). 

 
Матриці, що не мають відношення до 

детектора, можуть бути збережені у форматі 

TIFF (*.tif) або в форматі зображення PTW 

(*.dat). 

 
• Для збереження матриці A або 

матриці B клацніть на відповідній кнопці 

або виберіть меню File → Data Set A / B 

→ Save As (Файл - Набір даних A / B - 

Зберегти як). 

 
➔ Для матриці A або матриці B відкриється 

стандартне діалогове вікно Save 

(Зберегти). Запропоноване ім'я файлу 

складається з поточної дати і часу. 

 
➔ Матриця буде збережена з усією 

виконаною обробкою зображення. 
 

У випадку об'ємних наборів доз або переліків 

матриць будуть збережені тільки зріз 

об'ємного набору доз або матриця переліку, 

що відображаються в даний час. 

11.1.1. Збереження вимірювань 

OCTAVIUS 4D і об'ємних 

наборів доз OCTAVIUS 4D 

 
Збереження вихідних виміряних значень 

 
Після вимірювання вихідні виміряні значення 

будуть збережені автоматично в файлі xcc з 

ідентифікатором «_4D» в каталозі, вказаному 

в діалоговому вікні Measurement Parameters 

(Параметри вимірювання). Файл xcc містить 

виміряні значення дози з відповідними кутами 

гентрі. 

 

 
Експорт вихідних виміряних значень 

 
Крім того, вихідні виміряні значення можуть 

бути експортовані як файл формату PTW xcc 

(*.xcc). Файл xcc зберігається автоматично 

після збереження вимірювання. 

 
• • Виберіть меню File → Data Set A/B → 

Export → Rotation Unit raw data (Файл - Набір 

даних A/B - Експорт - Необроблені дані 

поворотного блоку). 

 
➔ Відкриється стандартне діалогове вікно 

Save (Зберегти). Запропоноване ім'я 

файлу складається з поточної дати, 

часу і ідентифікатора «_4D». 
 



 
 
 
 

Збереження об'ємного набору доз 

OCTAVIUS 4D в форматі DICOM 

 
Об'ємні набори доз OCTAVIUS 4D можуть 

бути збережені у форматі DICOM (*.dcm). 

 
• Для збереження об'ємних наборів 

доз OCTAVIUS 4D, A або B, клацніть на 

відповідній кнопці або виберіть меню 

File → Data Set A/B → Save As (Файл - 

Набір даних A/B - Зберегти як). 

 
• У стандартному діалоговому вікні Save 

(Зберегти) виберіть формат файлу DICOM RT 

і відповідний каталог. 

 

➔ Об'ємний набір доз OCTAVIUS 4D буде 

збережений у форматі DICOM. 

 

 
Збереження зрізу з об'ємного набору доз 

OCTAVIUS 4D в форматі DICOM 

 
Зріз з об'ємного набору доз OCTAVIUS 4D, що 

відображається, можна зберегти у форматі 

DICOM (*.dcm). 

 
• Виберіть зріз для збереження. 

 
• Для збереження зрізу з об'ємного 

набору доз OCTAVIUS 4D, A або B, 

клацніть на відповідній кнопці або 

виберіть меню File → Data Set A / B → 

Save As (Файл - Набір даних A / B - 

Зберегти як). 

 
• У стандартному діалоговому вікні Save 

(Зберегти) виберіть формат файлу DICOM RT 

- Visible Slice і відповідний каталог. 

 
➔ Зріз з об'ємного набору доз OCTAVIUS 

4D, що відображається, буде 

збережений у форматі DICOM. 

11.1.2. Збереження вимірювань, 

виконаних з матричним 

детектором і планарним 

поворотним блоком або 

інклінометром 

 

Збереження вихідних виміряних значень 

 
-  Якщо автоматичне збереження вихідних 

виміряних значень включено в діалоговому 

вікні Measurement Parameters (Параметри 

вимірювання), вихідні виміряні значення 

будуть автоматично збережені після 

вимірювання в файлі xcc в обраному каталозі. 

 
-  Якщо автоматичне збереження вихідних 

виміряних значень не включене в діалоговому 

вікні Measurement Parameters (Параметри 

вимірювання), файл xcc буде збережений в 

тому ж каталозі, де зберігається файл mcc 

(див. Розд. «Збереження доданих значень 

доз»). 

 
➔ Файл xcc містить виміряні значення доз 

з відповідними кутами гентрі. 

 

 
Збереження доданих значень доз 

 
• Збережіть додані значення доз в форматі 

mcc, згідно з розд. 11.1 "Збереження матриць". 

 
➔ Файл mcc містить тільки одну матрицю 

з доданими значеннями доз. 
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11.1.3. Експорт матриць 

матричного детектора в 

спеціальному форматі TIFF 

для програми TomoTherapy 

 
Ця функція використовується для управління 

вивіренням даних в програмному 

забезпеченні TomoTherapy. 

 
• Щоб зберегти матриці матричного 

детектора в спеціальному форматі TIFF для 

програми TomoTherapy, виберіть меню File → 

Data Set A/B → Export → Tif - Hi•Art optimized 

(Файл - Набір даних A/B - Експорт - Tif - Hi•Art 

оптимізований). 

 
➔ Матриця матричного детектора буде 

збережена як зображення у відтінках 

сірого 16-розрядний TIFF. 
 

Збережене зображення TIFF не включатиме 

всі параметри вимірювання. 

 

 
До зображення TIFF буде додана біла рамка і 

два маркера (чорні хрестики): один в лівому 

нижньому куті, а другий в правому верхньому 

куті. Ці маркери відповідають монтажним 

отворам матричного детектора поза областю 

вимірювання і можуть використовуватися для 

зіставлення зображення TIFF з КТ-сканом 

матричного детектора. 

 
Разом із зображенням TIFF буде збережений 

файл калібрування в тому ж каталозі з тим же 

ім'ям, але з розширенням *.cal. Цей файл 

калібрування може використовуватися для 

калібрування зображення у відтінках сірого, 

наприклад, на робочій станції TomoTherapy. 

 

 

Малюнок 43. Приклад файлу калібрування 
*.cal 

 

 
Файл калібрування містить 3 стовпці: 

 
-  Перший стовпець служить тільки для 

довідкових цілей. 

 
-  У другому стовпці вказані значення дози в 

[cGy] (сГр). Значення доз в останньому рядку 

відповідає максимальній дозі вимірювання 

матричного детектора. 

 
-  У третьому стовпці вказані значення 16- 

розрядного зображення у відтінках сірого, що 

відповідають значенням доз, введеним в 

другий стовпець. 



 
 
 

 

11.2. Закриття матриць 

 
• Для закриття матриці в вікні матриці 

A або вікні матриці B клацніть на 

відповідній кнопці або виберіть меню 

File → Data Set A / B → Close (Файл - 

Набір даних A / B - Закрити). 

 
• Щоб закрити всі матриці, видимі в 

основному вікні, виберіть меню File → Close All 

(Файл - Закрити всі). 

 
Якщо ви змінили матриці (тобто, обробили 

зображення згідно з розд. 13 "Обработка 

зображення в вікні матриці "), буде виведено 

попередження, і можна буде зберегти змінені 

матриці при необхідності. 
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12. Вікно матриці 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
7a 7b 7c 7d 7e 7f 7g 

 
 

Малюнок 44. Вікно матриці 
 

1 Панель інструментів 

a Поле переліку для вибору режиму 

представлення матриці 

b Глибина зрізу матриці, що 

відображається 

2 Вкладка, в якій виводяться спливаючі 

вікна 

3 Графічне або табличне представлення 

матриці 

4 Позиція профілю, показана у вікні 

результатів (тільки якщо матриця 

представлена графічно) 

5 Тип матриці та ідентифікатор 

пацієнта 

6 Позначення 

7 Рядок стану, що містить наступні 

елементи: 

a Ім'я матриці, що відображається, (A 

або B) 

b Позиція курсора в напрямку зліва 

направо 

 
c Позиція курсора в напрямку 

мішень-джерело 

d Початкове значення дози в позиції 

курсора (див. також розд. 12.3.2 

"Відображення значень дози в рядку 

стану") 

e Середнє або интерпольоване значення 

(тільки з двома завантаженими 

матрицями) (див. також розд. 12.3.2 

"Відображення значень дози в рядку 

стану") 

f Поправочний коефіцієнт (тільки в 

разі вимірювань з матричним 

детектором) 

g Шлях і ім'я відображеної матриці. 

Якщо ім'я показано тільки частково, 

то при наведенні покажчика миші на 

ім'я з'явиться підказка з повним ім'ям 

файлу. 



 
 
 

 

12.1. Зміна 

представлення матриць 

 
Структура вікон матриць A і B однакова. 

 
Матриці можуть бути представлені в 

наступних режимах: 

 
- зображення у відтінках сірого 

 
- лінії ізодоз 

 
- ізодозні області 

 
- зображення у відтінках сірого і лінії ізодоз 

 
- 3D- представлення ізодоз 

 
- таблиця зі значеннями доз 

 
Поле переліку (1a) в панелі інструментів 

служить для вибору режиму представлення. 

12.2. Спливаючі вікна 

 
При наведенні покажчика миші на вкладки (2), 

в лівій стороні матриці виводяться спливаючі 

вікна. Спливаючі вікна містять наступні 

функції: 

 
- Вкладка Slice (Зріз) 

доступна тільки в тому випадку, якщо 

завантажено об'ємний набір доз або перелік 

матриць. 

На цій вкладці виводиться спливаюче вікно з 

повзунком. За допомогою повзунка можна 

переміщатися по зрізах об'ємного набору доз 

або за переліком матриць (див. також 

розд.20.2 "Прокрутка в об'ємному наборі доз 

або переліках матриць"). 

 
- На вкладці Contrast (Контрастність) 

виводиться спливаюче вікно з повзунком. За 

допомогою повзунка можна змінити 

контрастність зображень у відтінках сірого 

(див. також розд.12.4 "Зміна відображенаня у 

відтінках сірого"). 

 
- На вкладці Edit (Правка) 

виводиться спливаюче вікно з функціями 

обробки зображень для зображень у 

відтінках сірого і ізодоз (див. також з розд. 

13.1 "Визначення початку координат" по 

розд. 13.6 "Поворот і дзеркальне 

відображення матриці"). 
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12.3. Представлення 

зображень у відтінках 

сірого та ізодоз 

 
Якщо для матриць вибрано представлення у 

відтінках сірого або представлення ізодоз, то у 

вікні матриці пропонуються наступні варіанти: 

 
• Якщо одна із завантажених матриць є 

матрицею матричного детектора, можна 

спроектувати позиції камер на завантажені 

матриці, вибравши меню View → Overlay 

Measuring Positions (Вид - Накладення 

позиций вимірювання). 

 
• Позначення для матриць можна показати 

або приховати, вибравши меню Graphics → 

Legend (Графіка - Позначення). 

 
• Можна задати кольори і рівні ізодоз, 

вибравши меню Graphics → Edit Contour 

Settings (Графіка - Зміна налаштувань 

контуру) (див. розд. 23.1 "Зміна кольорів і 

рівнів ізодоз"). 

 
• 3D- представлення ізодоз можна змінити за 

допомогою миші, наприклад повернути в будь- 

якому напрямку, натиснувши і утримуючи ліву 

кнопку миші і рухаючи мишу, або збільшити, 

натиснувши праву кнопку миші і рухаючи 

мишу. 

 
• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати фактичне 

представлення матриці в буфер обміну. З 

буфера обміну можна вставити його в іншу 

програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти фактичне 

представлення матриці як графічний файл. 

Доступні формати файлів: *.png, *.jpg, *.tif і 

*.bmp. 

 

12.3.1. Нормалізація 

 
Значення ізодози 100% відповідає значенню, 

по якому матриця була нормалізована (див. 

Розд. 13.5 "Нормалізація"), або максималь- 

ному значенню в разі ненормалізованих 

матриць. Одиницями вимірювання для ізодоз 

завжди є %. 

 
 

 
12.3.2. Відображення значень 

дози в рядку стану 

 
Початкове значення дози 

 
Початкове значення дози в позиції курсора 

відображається в рядку стану в полі (7d): 

 
- матриці матричного детектора: 

початкове значення дози для камери 

 
- матриці OCTAVIUS 4D: 

початкове значення дози для воксела 

 
- матриці, що не мають відношення до 

детектора: 

Значення дози в позиції курсора 

визначається так званою «середньою 

областю» (Average Region), яку можна 

коригувати в меню Tools → Options (Сервіс - 

Параметри) на вкладці Advanced 

(Додатково) (див. Розд.23.3.3 "Додаткові 

параметри"). 



 
 
 
 

 
 

Середнє або інтерпольоване значення 

дози 

 
Середнє або інтерпольоване значення дози 

буде відображено в рядку стану в полі (7e), 

тільки якщо завантажено дві матриці, причому 

одна з них - матриця матричного детектора. 

Залежно від типів завантажених матриць це 

значення буде відображено у вікні матриці A 

або B. 

 
- матриця, яка не має відношення до 

детектора, і матриця матричного детектора: 

Позиції камер в матриці матричного 

детектора будуть спроектовані на матрицю, 

що не має відношення до детектора. 

Значення, що відображається, є середнім 

значенням для значень доз під 

спроектованою областю камери. 

 
- матриця матричного детектора і матриця 

OCTAVIUS 4D: 

Позиції камер в матрицях матричного 

детектора будуть спроектовані на матрицю 

OCTAVIUS 4D. Значення, що 

відображається, є середнім значенням для 

значень доз під спроектованою областю 

камери. 

 
- дві матриці однакового типу: 

У вікні матриці A буде відображено 

інтерпольоване значення дози в позиції в 

матриці B. 

12.3.3. Типи матриць і 

ідентифікатор пацієнта 

 
Назви типів матриць показані над матрицями 

A і B. 

 
Типи матриць: 

 
Вимірювання: 

вимірювання матричного детектора 

 
MEPHYSTO: 

mcc-дані MEPHYSTO 

 
PTW-зображення: 

матриці в форматі PTW-зображення 

 
FIPS-зображення: 

дані FIPS Plus 

 
DoseMap: 

матриці системи планування променевої 

терапії 

 
TIFF-зображення: 

зображення TIFF 

 
MATRIX (Матриця): 

прості матриці без інформації 

 
Ідентифікатор пацієнта буде додано, якщо він 

доступний в файлі і якщо цей параметр 

активовано в меню Tools → Options (Сервіс - 

Параметри) на вкладці Advanced (Додатково) 

(див. Розд. 23.3.3 "Додаткові параметри"). 
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12.4. Зміна відображення у 

відтінках сірого 

 
При наведенні покажчика миші на вкладку 

Contrast (Контрастність) на лівій стороні 

матриці виводиться спливаюче вікно з 

повзунком. Повзунок можна використовувати 

для зміни відтінків сірого. 

 
При налаштуваннях за замовчуванням, тобто 

повзунок на всю довжину, значення відтінків 

сірого рівномірно розподілені по всьому 

діапазону вимірювань: мінімальне значення 

представлене білим кольором, а максимальне 

значення представлене чорним кольором. 

 
Налаштуйте довжину дії повзунка, тобто 

ширину смуги діапазону вимірювань, 

переміщаючи стрілки на кінцях повзунка при 

натиснутій лівій кнопці миші. Охоплювана 

область визначається положенням повзунка. 

Значення, що знаходяться вище і нижче 

встановленого діапазону, будуть чорними або 

білими. 

 
Якщо навести курсор миші на один з кінців 

повзунка, буде показано відповідне 

мінімальне або максимальне виміряне 

значення матриці. 

 
Приклад: 

 
Зображення містить дуже високий рівень 

сірого, але більш низькі значення будуть 

доступні для детального перегляду 

(наприклад, яскрава рентгенограма з чорними 

контурами голки). Темні області видаляються 

переміщенням верхньої стрілки вниз, що 

призводить до підвищення дозволу більш 

світлих областей. 

 

 

Обраний діапазон відтінків сірого не 

зберігається з матрицею. 

Обраний розподіл відтінків сірого не впливає 

на створювані діаграми. 
 

 
 
 

При відкритті іншої матриці налаштування 

повзунка зберігається. Щоб відновити 

відображення в відтінках сірого за 

замовчуванням, виконайте скидання для 

нижньої і верхньої стрілок. 

ПРИМІТКА 



 
 
 

 

12.5. Відображення значень 

доз для матриць 

 
Щоб відобразити значення доз в таблиці, 

виберіть параметр Table (Таблиця) в полі 

переліку панелі інструментів вікна матриці. 

 
Таблиця містить позиції і відповідні значення 

доз обраної матриці. 

 

 
Якщо одна із завантажених матриць є 

матрицею матричного детектора, то будуть 

створені дві таблиці для матриці, яка не має 

відношення до детектора. Для відображення 

потрібної таблиці клацніть на відповідній 

вкладці: 

 
-  Вкладка Measurement Resolution (Дозвіл 

вимірювання): 

розрахункові середні значення під 

віртуальними областями камер 

 
- Вкладка High Resolution (Високий дозвіл): 

вихідні значення доз 

 

 
Ці значення доз можна перенести в інші 

програми, наприклад в програми електронних 

таблиць: 

 
• Виділіть потрібний діапазон і виберіть пункт 

контекстного меню Copy (Копіювати), щоб 

скопіювати виділені значення доз в буфер 

обміну. З буфера обміну можна вставити їх в 

іншу програму. 

 
• Щоб зберегти всі значення доз у вигляді 

файлу CSV (*.csv) або у вигляді текстового 

файлу (*.txt), виберіть пункт контекстного 

меню Save All (Зберегти все). 

Для збереження тільки частини значень 

виділіть потрібний діапазон і виберіть пункт 

контекстного меню Save Selected (Зберегти 

вибрані). 

Файл CSV можна відкрити безпосередньо 

програмою електронних таблиць. 
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12.6. Відображення панелей 

об'ємних наборів доз 

 
Після завантаження об'ємного набору доз у 

вікно матриці є можливість змінити площину 

відображення об'єму доз. Визначення площин 

відображення див. на малюнку 45. 

 
Для цього на панелі інструментів буде активна 

кнопка для вибору площини відображення 

(див. також розд.7.1.1 "Опис значків на панелі 

інструментів"). 

Кнопка пропонує наступні варіанти: 

  Фронтальна площина 

  Сагітальна площина 

 Поперечна площина 

Після перемикання на іншу площину 

відображення буде виведено зріз об'ємного 

набору доз на глибині 0 мм в цьому напрямку. 

 
Можна відобразити інші зрізи об'ємного набору 

доз за допомогою повзунка у спливаючому вікні 

Slice (Зріз). 

 

 

Назви профілів у вікні результатів не будуть 

змінені при перемиканні на іншу площину 

відображення. 
 



Y 
Сагітальна площина 

X 

Фронтальна площина 

Поперечна площина Z 

 
 

 

Площини пацієнта1) в системі координат 

пацієнта відповідно до стандарту IEC 61217 

визначені наступним чином: 

 

 

Малюнок 45. Визначення площин пацієнта і системи координат пацієнта 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1) Зображення "Yassine Mrabet, CC-BY-SA" 
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13. Обробка зображення у вікні матриці 
 
 
 
 
 

 

Якщо наступні кроки обробки зображення 

виконуються при кожному завантаженні 

матриць, можна автоматично виконувати їх в 

пакетному режимі (див. Розд. 13.9 "Робота в 

пакетному режимі"). 
 

 
 

 

13.1. Визначення початку 

координат 

 
Програма VeriSoft передбачає прямокутну 

(декартову) систему координат (див. малюнок 

46). 

 
В матриці програма VeriSoft позначає початок 

координат косим хрестом. Якщо дані 

зображення включають цю точку початку 

координат, програма VeriSoft встановить 

початок координат в цю точку. В інших 

випадках програма VeriSoft визначить центр 

зображення і встановить початок координат 

там. 

 
 
 
 
 

 

-x 
 

+ x 

 

13.1.1. Визначення ізоцентра 

вручну 

• При наведенні покажчика миші на 
 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для визначення ізоцентра 

клацніть на відповідній кнопці або 

виберіть меню Edit → Data Set A / B → 

Align Manually (Файл - Набір даних A / 

B - Вирівнювання вручну). 

 
➔ Відкриється діалогове вікно Set 

Isocenter Position (Установка положення 

ізоцентра) для матриць або об'ємних 

наборів доз: 

 

Малюнок 47. Діалогове вікно установки 

положення ізоцентра для 
матриць 

 

Малюнок 48. Діалогове вікно установки 

положення ізоцентра для 
об'ємних наборів доз 

 

Малюнок 46. Система координат 

ПРИМІТКА 



ПРИМІТКА 

 
 
 
 

• Встановіть ізоцентр наступним чином: 

 
-  вибравши точку для використання 

клацанням миші; 

 
-  ввівши координати в діалоговому вікні. 

Перевірте положення, натиснувши кнопку 

Show Position (Показати положення). 

 
 

Якщо новий ізоцентр матриці матричного 

детектора встановлюється клацанням миші, 

то перехрещення буде автоматично 

встановлено в центрі найближчої камери. 

Координати центру камери будуть 

відображені в діалоговому вікні. 

 
Якщо новий ізоцентр матриці матричного 

детектора встановлюється введенням 

координат в діалоговому вікні, то новий 

ізоцентр буде встановлено в фактично 

введеній позиції. 

 
Якщо новий ізоцентр об'ємного набору доз 

OCTAVIUS 4D встановлюється клацанням 

миші, то перехрещення буде автоматично 

встановлено в центрі найближчого воксела. 

Координати центру камери будуть показані в 

діалоговому вікні. Ізоцентр буде встановлений 

в центрі відповідного воксела в усьому 

об'ємному наборі доз. 
 

 
• Підтвердіть новий ізоцентр натисканням 

кнопки OK. 

 

➔ Ізоцентр буде позначено у відповідній 

матриці косим хрестом. Якщо будуть 

завантажені дві матриці, то 

відображення буде налаштовано згідно 

з інформацією, наведеною в розд.8.16 

"Підстроювання двох матриць під час 

завантаження". 

13.1.2. Визначення ізоцентра 

автоматично 

 
За допомогою функції Align Automatically 

(Вирівнювання автоматично) матриці або 

об'ємні набори доз будуть накладені шляхом 

порівняння зображень, і таким чином буде 

розраховано новий ізоцентр порівняльної 

матриці. 

 
• Виберіть пункт меню Edit → Align 

Automatically (Правка - Вирівнювання 

автоматично) 

 

➔ Програма VeriSoft розрахує вектор 

трансляції та відобразить його в 

діалоговому вікні Auto Alignment 

(Автовирівнювання) для матриць і в 

діалоговому вікні 3D Auto Alignment 

(Автовирівнювання 3D) для об'ємного 

набору доз: 

 

Малюнок 49. Діалогове вікно 
автовирівнювання для 
матриць 

 

Малюнок 50. Діалогове вікно 
автовирівнювання 3D для 
об'ємного набору доз 
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• Підтвердіть зміщення натисканням кнопки 

OK. 

 
➔ Ізоцентр порівняльної матриці буде 

трансльований. Екран буде оновлено: 

Результати порівняння будуть 

перераховані і відображені. 

 
➔ Референтна матриця залишиться 

незмінною. 

13.2. Визначення області 

інтересу 

 
 

13.2.1. Визначення області 

інтересу в матрицях 

• При наведенні покажчика миші на 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для визначення області 

інтересу клацніть на відповідній 

кнопці або виберіть меню Edit → Data 

Set A / B → ROI (Правка - Набір даних 

A / B - Область інтересу). 
 

➔ Якщо завантажено тільки матриці, 

відкриється діалогове вікно Set Region 

of Interest (Установка області інтересу) 

для матриць. Якщо завантажений 

принаймні один об'ємний набір доз, 

застосовуються інструкції, наведені в 

розд.13.2.2 "Визначення області 

інтересу в об'ємних наборах доз" . 

 

 

Малюнок 51. Діалогове вікно установки 
області інтересу для 
матриць 

 
• За допомогою миші намалюйте 

прямокутник, щоб встановити область 

інтересу. У діалоговому вікні будуть показані 

координати верхнього лівого кута і нижнього 

правого кута. 



ПРИМІТКА 

 
 
 

 

• Альтернативно можна задати кути, 

змінюючи значення в діалоговому вікні. 

Підстройте положення прямокутника, 

натиснувши кнопку Show Region (Показати 

область). 

 
• Підтвердіть вибір натисканням кнопки OK. 

Область, обмежена прямокутником, буде 

збільшена, а всі інші області будуть видалені. 

 
• Можна повторити описані вище дії, 

вибираючи більш дрібні області зображення. 

 

 

Якщо область інтересу визначена для матриці 

матричного детектора або матриці OCTAVIUS 

4D, програма VeriSoft автоматично розташує 

область інтересу на границях іонізаційних 

камер або вокселів, які хоча б частково 

включені в область інтересу. 

 
Функція ROI (Область інтересу) завжди 

зачіпає обидві завантажені матриці 

одночасно. 

 
Якщо найтемніші або найсвітліші області 

зображення видалені, зображення у відтінках 

сірого будуть розраховані заново. 
 

13.2.2. Визначення області 

інтересу в об'ємних наборах 

доз 

 
• При наведенні покажчика миші на 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для визначення області 

інтересу клацніть на відповідній 

кнопці або виберіть меню Edit → Data 

Set A / B → ROI (Правка - Набір даних 

A / B - Область інтересу). 

 

➔ Якщо завантажено принаймні один 

об'єм доз, відкриється діалогове вікно 

Set Region of Interest (Установка області 

інтересу) для об'ємів доз. 

Якщо завантажено тільки матриці, 

застосовуються інструкції, наведені в 

розд. 13.2.1 "Визначення області 

інтересу в матрицях ". 

 

Малюнок 52. Діалогове вікно установки 
області інтересу для об'ємного 
набору доз 

• За допомогою миші намалюйте 

прямокутник, щоб встановити область. У 

діалоговому вікні будуть показані координати 

верхнього лівого кута і нижнього правого кута 

прямокутника, а також максимальний діапазон 

глибини зрізу. 
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• Альтернативно можна задати кути і діапазон 

глибини зрізу, змінюючи значення в 

діалоговому вікні. Підстройте положення 

прямокутника, натиснувши кнопку Show Region 

(Показати область). Зміни діапазону глибини 

зрізу не відображаються. 

 
• Якщо завантажено два об'ємних набори доз, 

причому один з них - об'ємний набір доз 

OCTAVIUS 4D, кнопка Adapt to O4D 

(Підстроювання для O4D) стає активною. 

Клацнувши на кнопці Adapt to O4D 

(Підстроювання для O4D) можна задати 

область інтересу, розмір якої відповідає 

розрахунковому об'ємному набору доз 

OCTAVIUS 4D. 

 
• Підтвердіть вибір натисканням кнопки OK. 

Область, охоплена прямокутником, 

збільшується, тоді як інші області, зокрема, 

області за межами заданої глибини зрізу, 

видаляються. 

 
• Можна повторити описані вище дії, 

вибираючи більш дрібні області зображення. 

 

 

Якщо область інтересу визначена для 

об'ємного набору доз OCTAVIUS 4D, або 

матриці матричного детектора, або матриці 

OCTAVIUS 4D, програма VeriSoft 

автоматично розташує область інтересу на 

границях іонізаційних камер або вокселів, які 

хоча б частково включені в область інтересу. 

 
Завантажено об'ємний набір доз і матриця: 

Область інтересу встановлюється для 

області, яка визначається глибиною зрізу, 

тільки в тому випадку, коли ви визначите 

область інтересу в об'ємному наборі доз. У 

всіх інших випадках область інтересу буде 

встановлена тільки в поточному зрізі. 

 
Функція ROI (Область інтересу) завжди 

зачіпає завантажені об'ємні набори доз/ 

матриці одночасно. 

 
Якщо найтемніші або найсвітліші області 

зображення видалені, зображення у відтінках 

сірого будуть розраховані заново. 
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13.3. Віднімання 

значення фону 

• При наведенні покажчика миші на 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для віднімання фонового 

значення клацніть на відповідній 

кнопці або виберіть меню Edit → Data 

Set A / B → Background (Правка - 

Набір даних A/B - Фонове 

випромінювання). 

 
 

➔ На екрані з'явиться діалогове вікно 

Subtract Background (Віднімання 

фонового випромінювання): 

 

Малюнок 53. Діалогове вікно віднімання 
фонового випромінювання 

• Клацніть в будь-якій точці зображення у 

відтінках сірого. З'явиться маркер-хрестик, і в 

діалоговому вікні буде показана поточна 

позиція і відповідне виміряне значення. 

Перемістіть маркер-хрестик, клацнувши на 

іншій точці зображення. 

 
• Координати маркера-хрестика можна також 

змінити в діалоговому вікні. Натисніть кнопку 

Apply (Застосувати), щоб перемістити маркер- 

хрестик в нове положення. 

 
• Натисніть кнопку Goto Min (Перейти до 

мінімального), щоб перемістити маркер- 

хрестик в позицію мінімального значення. 

 
• Незалежно від обраної точки значення для 

вирахування можна ввести в діалоговому вікні. 

 
• Підтвердіть вибір натисканням кнопки OK. 

 
➔ Значення фону буде вирахувано зі 

значень всіх точок матриці. Негативні 

значення доз будуть замінені нульовим 

значенням (0). 
 

Матриця матричного детектора: 

Якщо позиція значення фону для матриці 

матричного детектора визначена клацанням 

миші, то будуть відображені позиція і значення 

центру найближчої камери. 

 
Матриця OCTAVIUS 4D: 

Якщо позиція значення фону для матриці 

OCTAVIUS 4D визначена клацанням миші, то 

будуть відображені позиція і значення центру 

найближчого воксела. 

 
Матриця, яка не має відношення до 

детектора: 

У випадку матриці, яка не має відношення до 

детектора, значення для вирахування фону 

визначається так званою середньою областю 

(Average Region), яку можна коригувати в 

меню Tools → Options (Сервіс - Параметри) на 

вкладці Advanced (Додатково) (див. 

розд.23.3.3 "Додаткові параметри "). 
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13.4. Калібрування 

 
13.4.1. Калібрування матриць 

матричного детектора 

• При наведенні покажчика миші на 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для калібрування матриці 

матричного детектора клацніть на 

відповідній кнопці або виберіть меню 

Edit → Data Set A / B → Calibrate 

(Правка - Набір даних A/B - 

Калібрування). 

➔ В залежності від налаштувань під час 

вимірювання буде відкрито діалогове 

вікно Calibrate (Вирівнювання): 

 

Малюнок 54. Діалогове вікно калібрування - 
поправка до щільності повітря 
для матриці матричного 
детектора 

 
 
 
 
 
 
 
 
 
 

 
Малюнок 55. Діалогове вікно калібрування - 

перехресне калібрування 
матриць матричного 
детектора 

 

Матрицю матричного детектора можна 

калібрувати різними способами: 

 
- зміною поправочних коефіцієнтів для 

щільності повітря (див. Розд. 10.7 "Поправка 

до щільності повітря") 

 
- зміною додаткового, вільного поправочного 

коефіцієнта kUser (Див. Розд. 10 "Вимірювання 

матриць") 

 
- зміною одиниць вимірювання. 

 
Матрицю матричного детектора можна 

калібрувати неодноразово. 

 
 

Поправочний коефіцієнт kEnergy для якості 

променя неможливо змінити за допомогою 

функції Calibrate (Вирівнювання). 
 

 

 

Якщо завантажений об'ємний набір доз, 

калібрування застосовується до всіх значень 

доз в об'ємі. 
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Зміна одиниць вимірювання 

 
Якщо існує одиниця вимірювання матриці 

матричного детектора, вона завантажується з 

матрицею і відображається в полі Current Unit 

(Поточна одиниця вимірювання). 

 
• Виберіть нову одиницю вимірювання в полі 

переліку New Unit (Нова одиниця 

вимірювання) і підтвердіть вибір натисканням 

кнопки OK. 

 

Функція Change Unit (Змінити одиницю 

вимірювання) змінює лише одиницю 

вимірювання. Значення не перераховуються. 

13.4.2. Калібрування матриць, що 

не мають відношення до 

детектора 

• При наведенні покажчика миші на 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для калібрування матриці, 

яка не має відношення до детектора, 

клацніть на відповідній кнопці або 

виберіть меню Edit → Data Set A / B → 

Calibrate (Правка - Набір даних A / B - 

Калібрування). 

 

➔ На  екрані  з'явиться  діалогове  вікно 

Calibrate (Вирівнювання): 
 

 
 

Малюнок 56. Діалогове вікно калібрування - 
матриці, що не мають 
відношення до детектора 

 
Матрицю, що не має відношення до 

детектора, можна калібрувати різними 

способами: 

 
- множенням на коефіцієнт 

 
- зміною одиниць вимірювання. 

 
Матрицю, що не має відношення до 

детектора, можна калібрувати неодноразово. 
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Множення на коефіцієнт 

 
Всі значення зображення множаться на 

коефіцієнт. 

• Визначте відповідний множник: 

 
Для однієї завантаженої матриці: 

Переміщуючи курсор миші всередині 

матриці, можна бачити значення доз в рядку 

стану. При натисканні на потрібній точці, 

значення дози в цій точці вводиться як 

чисельник коефіцієнта. 

 
Для двох завантажених матриць: 

При натисканні на потрібній точці значення 

дози в цій точці вводиться як знаменник 

коефіцієнта. Значення дози у відповідній 

позиції в межах іншої матриці вводиться як 

чисельник коефіцієнта. Шляхом множення 

на цей коефіцієнт одне і те ж значення дози 

буде призначене обраній позиції в обох 

матрицях. 

 
• Підтвердіть введення, натиснувши кнопку 

OK. 

Зміна одиниць вимірювання 

 
Якщо існує одиниця вимірювання матриці, що 

не має відношення до детектора, вона 

завантажується з матрицею і відображається 

в полі Current Unit (Поточна одиниця 

вимірювання). 

 
• Виберіть нову одиницю вимірювання в полі 

переліку New Unit (Нова одиниця 

вимірювання) і підтвердіть вибір натисканням 

кнопки OK. 

 

Функція Change Unit (Змінити одиницю 

вимірювання) змінює лише одиницю 

вимірювання. Значення не перераховуються. 
 

 
 
 

 

Після калібрування повторно розраховуються 

значення нормалізації. 
 

 

 

Якщо буде завантажено об'ємний набір доз, то 

всі значення доз в цьому наборі будуть 

помножені на коефіцієнт. 
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13.5. Нормалізація 

 
• При наведенні покажчика миші на 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для нормалізації матриці 

клацніть на відповідній кнопці або 

виберите меню Edit → Data Set A / B 

→ Normalize (Файл - Набір даних A/B - 

Нормалізувати). 

➔ На  екрані  з'явиться  діалогове  вікно 

Normalize (Нормалізація): 
 

Малюнок 57. Діалогове вікно нормалізації 

 
В діалоговому вікні показано поточне 

значення нормалізації обраної матриці. 

 
• Визначте нову точку нормалізації, 

клацнувши на точці матриці. З'явиться маркер- 

хрестик, і в діалоговому вікні буде показана 

поточна позиція і відповідне значення 

нормалізації. Перемістіть маркер-хрестик, 

клацнувши на іншій точці матриці. 

 
• Координати точки нормалізації можна 

також змінити в діалоговому вікні. Натисніть 

кнопку Apply (Застосувати), щоб перемістити 

маркер-хрестик в нове положення. 

 

• Натисніть кнопку Goto Max (Перейти до 

максимального), щоб перемістити точку 

нормалізації в позицію максимального 

значення. 

 
• Незалежно від обраної точки нормалізації 

значення для нормалізації можна ввести в 

діалоговому вікні. У цьому випадку значення 

позиції більше не будуть виводитися. 

 
• Підтвердіть нормалізацію натисканням 

кнопки OK. 

 
Якщо встановлено прапорець Normalize both 

data sets to position (Нормалізувати обидва 

набори даних по позиції), обидві матриці 

будуть нормалізовані по одній і тій же точці, 

але по різним значенням. 

 
Якщо встановлений прапорець Normalize both 

data sets to value (Нормалізувати обидва 

набори даних за значенням), обидві матриці 

будуть нормалізовані по одному і тому ж 

значенню. 
 

 
Матриця матричного детектора: 

Якщо значення нормалізації для матриці 

матричного детектора визначено клацанням 

миші, то будуть відображені позиція і значення 

центру найближчої камери. 

 
Матриця OCTAVIUS 4D: 

Якщо значення нормалізації для матриці 

OCTAVIUS 4D визначено клацанням миші, то 

будуть відображені позиція і значення центру 

найближчого воксела. 

 
Матриця, яка не має відношення до 

детектора: 

Значення в точці нормалізації визначається 

так званою середньою областю (Average 

Region), яку можна коригувати в меню Tools → 

Options (Сервіс - Параметри) на вкладці 

Advanced (Додатково) (див. Розд.23.3.3 

"Додаткові параметри "). 
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Позиція в точці нормалізації не буде 

збережена з даними матриці і буде втрачена 

при закритті діалогового вікна. 

 
Нормалізація даних вплине тільки на 

зображення ізодоз і відносні профілі. Вихідні 

дані матриці не будуть змінені. 
 

13.6. Поворот і дзеркальне 

відображення матриці 

• При наведенні покажчика миші на 

вкладку Edit (Правка) на лівій стороні 

матриці виводиться спливаюче вікно з 

кнопками. Для повороту матриці на 

заданий кут (в математичному сенсі) 

або для дзеркального відображення 

матриці відносно осі клацніть на 

відповідній кнопці або виберіть меню 

Edit → Data Set A / B → Rotate / Flip / 

Mirror (Правка - Набір даних A / B - 

Поворот/ Переворот/ Відображення). 

➔ на екрані з'явиться діалогове вікно 

Rotate/Flip/Mirror (Поворот/ Переворот/ 

Відображення). 

 

Малюнок 58. Діалогове вікно повороту / 
перевороту / відображення 

 

 

• Для повороту матриці виберіть Rotate 

(Поворот) і кут 90°, -90 ° або 180° або 

введіть будь-який кут. 

 

 

Матричний детектор можна повернути тільки 

на кут 90°, - 90° або 180°. 
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• Для дзеркального відображення матриці 

відносно горизонтальної осі, що проходить 

через початок координат, виберіть Flip 

(Переворот). 

 
• Для дзеркального відображення матриці 

відносно вертикальної осі, що проходить 

через початок координат, виберіть Mirror 

(Віддзеркалення). 

 
• Підтвердіть обрану функцію натисканням 

кнопки OK. 

 

Створена матриця завжди прямокутна. 

Області, створені поворотом, заповнюються 

значенням 0. 

 
Якщо повернути матрицю на кут x°, а після 

цього на кут - x°, ви не отримаєте вихідне 

зображення. 
 

 
13.7. Скасування і 

повернення дії обробки 

 
Пункт меню Edit → Undo (Правка - Скасувати 

дію) дозволяє послідовно скасувати кілька дій 

обробки. 
 

Дії функцій Defining the region of interest, ROI 

(Визначення області інтересу, ROI), а також 

Rotating through an arbitrary angle, Rotate 

(Поворот на довільний кут) неможливо 

скасувати. 

 
Скасування кроку обробки Subtracting a 

background value, Background (Віднімання 

значення фону, фонове випромінювання) 

може не привести до вихідної матриці, 

оскільки при відніманні значення фону 

негативні значення будуть замінені нулями (0). 
 

 

 
Якщо ви скасуєте кроки обробки за допомогою 

функції Undo (Скасувати дію), ви можете 

повернути скасовані дії, вибравши пункт меню 

Edit → Redo (Правка - Повернути дію). 
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13.8. Виконання обробки 

зображення 

 
Якщо виконується обробка зображення для 

однієї або обох матриць, то команди обробки 

будуть збережені в стеці команд. Команди, дії 

яких були скасовані функцією Undo 

(Скасувати дію), будуть показані як неактивні. 

 
Стек команд можна переглянути, вибравши 

меню View → Show Command Stack (Вид - 

Показати стек команд). 

13.9. Робота в 

пакетному режимі 

 
Пакетний режим дозволяє автоматично 

виконувати дії обробки зображень при 

завантаженні матриць. Для цього кроки 

обробки будуть записані і збережені окремо 

для матриці A і матриці B. Ці пакетні файли 

можна застосувати до відповідної матриці при 

наступному завантаженні. 

 
В пакетному режимі можна використовувати 

всі функції обробки зображень. 

 
 

 
 

Малюнок 59. Діалогове вікно перегляду 
стека команд 

 
Крім команд обробки буде показано їх 

призначення для оброблених матриць. 

 
При закритті або завантаженні матриці, зі стека 

команд будуть видалені команди, які 

стосуються цієї матриці. При закритті програми 

VeriSoft буде видалений весь стек команд. 

 
Стек команд буде надрукований, якщо 

встановлений прапорець Data Origin (Вихідні 

дані) в діалоговому вікні Print (Друк) (див. розд. 

21 "Друк матриць і результатів"). 



 
 

 

13.9.1. Створення пакетних 

файлів 
 

• Завантажте матрицю. 

 
• Почніть запис пакетного файлу, вибравши 

меню Edit → Start Data Processing Batch 

Recording (Правка - Запуск запису пакета 

обробки). 

 
• Виконайте всі необхідні кроки обробки 

зображень. 

 
• Завершіть запис пакетного файлу, 

вибравши меню Edit → Stop Data Processing 

Batch Recording (Правка - Зупинка запису 

пакета обробки). 

Якщо під час запису пакетного файлу будуть 

завантажені дві матриці, і обробка зображень 

зачіпає обидві матриці (наприклад, 

визначаючи область інтересу), то будуть 

записані два пакетних файли, і відкриється 

діалогове вікно Save Processing Batch 

(Збереження пакета обробки) для обох 

матриць. 
 

 

 
• Введіть ім'я файлу і підтвердіть 

натисканням кнопки OK. 

 

➔ Пакетний файл буде збережений. 

➔ На екрані з'явиться діалогове вікно Save 
 

Клацання на кнопці 
 

відкриває наступне 
Processing Batch (Збереження пакета 

обробки). 

 
 

 
Малюнок 60. Діалогове вікно збереження 

пакета обробки 

діалогове вікно. У цьому діалоговому вікні 

відображає перелік доступних пакетних 

файлів для матриці A або матриці B. За 

допомогою пунктів контекстного меню можна 

перейменувати або видалити існуючі пакетні 

файли. 

 
Збережені пакетні файли розташовані в 

каталозі <PTW application files> \ VeriSoft \ 

VeriSoft \ BatchProcess. 

ПРИМІТКА 

... 



VeriSoftTM 

Загальні відомості 

 

ПРИМІТКА 

 
 
 
 

 

13.9.2. Створення пакетних 

файлів 

 
• Почніть виконання пакетних файлів, 

встановивши відповідні прапорці Activate data 

processing batch (Активувати пакет обробки 

даних) в меню Tools → Options (Сервіс - 

Параметри) на вкладці Data (Дані) (див. Розд. 

23.3.2 "Параметри для завантаження 

матриць"). 

➔ При завантаженні матриці буде 

відкриватися діалогове вікно Data 

Processing Batch (Пакет обробки даних): 

• Для виконання пакетного файлу клацніть 

на кнопці Apply (Застосувати). 

 
• Якщо ви не хочете виконувати пакетний 

файл, клацніть на кнопці Cancel (Скасувати). 

 

Якщо виконання пакетної команди в принципі 

неможливо через тип команди: 

- команда не буде показана в діалоговому 

вікні Data Processing Batch (Пакет обробки 

даних) і 

- не буде застосовуватися до даних. 
 

 

За замовчуванням при завантаженні матриці 

буде відкриватися діалогове вікно Data 

Processing Batch (Пакет обробки даних). Якщо 

діалогове вікно не повинно відкриватися, і 

пакетний файл повинен виконуватися 

автоматично, потрібно зняти прапорець Show 

Dialog before Opening (Показати діалогове 

вікно перед відкриттям). При перезапуску 

програми VeriSoft цей прапорець знову 

встановиться автоматично. 

 
За допомогою контекстного меню цього 

діалогового вікна можна перейменувати або 

видалити існуючі пакетні файли. 

 
 
 

 
Малюнок 61. Діалогове вікно пакета обробки 

даних 

 
1 Перелік доступних пакетних файлів 

a  Активований пакетний файл 

Буде активований пакетний файл, 

який використовувався останнім. 

2 Перелік функцій обробки зображень в 

активованому пакетному файлі 

 
 

1a 

 



1a 

 

 
 

 

 

 

6a 6b 6c 6d 6e 6f 

 
 

14. Вікно результатів 
 
 
 

 

Малюнок 62. Вікно результатів 
 

1 Панель інструментів 

a Поле переліку для вибору режиму 

представлення результатів 

 
2 Вкладка, в якій виводиться спливаюче 

вікно 

 
3 Представлення результатів у вигляді 

профілю, гістограми або таблиці 

 
4 Значення нормалізації матриць A і B 

 
5 Відображене перехрещення 

 
6 Рядок стану 

в разі відображеного перехрещення в 

ньому виводяться наступні елементи 

a Ім'я обраної матриці (A або B) 

b Зсув профілю (недоступно в разі 

діагональних профілів) або позиція 

курсору на профілі 

 

c Зсув профілю (недоступно в разі 

діагональних профілів) або позиція 

курсору на профілі 

 

d Виміряне значення в позиції курсора 

 
e Значення порівняння для обраного 

режиму в позиції курсора (доступно, 

лише якщо обрана референтна 

матриця) 

 

f Різниця абсолютних доз в позиції 

курсора (доступно, лише якщо 

обрана референтна матриця) 
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14.1. Зміна представлення у 

вікні результатів 

 
Результати можуть бути представлені в 

наступних режимах: 

 
- LR profile (Профіль зліва направо) 

 
- TG profile (Профіль мішень-джерело) 

 
- positive diagonal (позитивна діагональ) - від 

Target-Left (мішень-ліворуч) до Gun-Right 

(джерело-праворуч) 

 
- negative diagonal (негативна діагональ) - від 

Gun-Left (джерело-ліворуч) до Target-Right 

(мішень-праворуч) 

 
- гістограма порівняння матриць 

 
- результат порівняння матриць. 

 
Крім того, можна переключитися в режим 

Zoom (Збільшення). 

 
Поле переліку (1a) в панелі інструментів 

служить для вибору режиму представлення. 

14.2. Спливаюче вікно 

 
При наведенні покажчика миші на вкладку (2), 

в лівій стороні вікна результатів виводиться 

спливаюче вікно зі «світлофором». 
 

Використання оціночних даних без перевірки. 

 
Небезпека для пацієнта! 

 
Програма VeriSoft буде оцінювати 

завантажені дані з урахуванням встановлених 

параметрів і буде показувати результат в 

формі сигналів світлофора. 

Дуже важливо перевірити налаштовані 

параметри перед вивірянням. Налаштування 

режиму порівняння будуть відображатися у 

вигляді спливаючих підказок при наведенні 

покажчика миші на світлофор. 
 

 
-  Якщо завантажена тільки одна матриця, 

світлофор не працює. 

 
-  Якщо завантажені дві матриці, світлофор 

показує результат порівняння матриць в 

залежності від налаштувань в меню Tools → 

Options (Сервіс - Параметри) на вкладці 

Compare (Порівняння) (див. Розд. 23.3.1 

"Параметри режиму порівняйня"): 

 

 
Зелений сигнал світлофора: 

Результат вище або дорівнює значенню, 

налаштованому для «зеленого результату». 

 
Жовтий сигнал світлофора: 

Результат вище або дорівнює значенню, 

налаштованому для «жовтого результату», 

але  нижче  значення,  налаштованого  для 

«зеленого результату». 



= 
 

 

Червоний сигнал світлофора: 

Результат нижче значення, налаштованого 

для «жовтого результату». 

 
При наведенні покажчика миші на світлофор 

з'явиться підказка з налаштуваннями режиму 

порівняння. 

14.3. Представлення 

профілю 

 
Якщо вибрано представлення профілю, то у 

вікні результатів пропонуються наступні 

варіанти: 

 
- Профілі для двох матриць позначені різними 

кольорами. Кольори профілів у вікнах 

матриць (див. малюнок 44, Пункт 4) 

відповідають кольорам профілів у вікні 

результатів. 

 
• Можна задати кольори профілів, вибравши 

меню Graphics → Edit Contour Settings (ГраФіка 

- Зміна налаштувань контуру) (див. розд. 23.1 

"Зміна кольорів і рівнів ізодоз"). 

-  Профілі матриць матричного детектора 

показані як точки (не як криві), що 

відповідають позиціям камер. 

Якщо обрано режим порівняння Gamma 

Index (Гамма-індекс) і завантажено дві 

матриці, ці точки вимірювання пофарбовані 

згідно з вимогами результату порівняння: 

 
passed: (в діапазоні допуску) 

зелений 

failed: (поза межами допуску) 

синій для недостатньої дози 

червоний для надлишкової дози 

 
-  За замовчуванням всі значення профілю 

представлені відносно значення нормалізації 

відповідної матриці. Одиниця вимірювання - 

відсоток (%). 

Абсолютні значення дози профілів будуть 

відображені при установці прапорця Absolute 

Dose Values (Абсолютні значення дози). В 

цьому випадку одиниці вимірювання 

профілів будуть відповідати одиницям 

вимірювання матриць. 

-  У разі діагоналей нульова точка відповідає 

вертикальній осі через початок координат, а 

значення абсциси відповідають відстані від 

початку координат. 
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• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати 

представлення профілю в буфер обміну. З 

буфера обміну можна вставити його в іншу 

програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти 

представлення профілю у вигляді графічного 

файлу. Доступні формати файлів: *.png, *.jpg, 

*.tif і *.bmp. 

 

 
14.3.1. Створення профілів 

 
Створення профілів завжди зачіпає всі 

завантажені матриці. 

 
Матриці матричного детектора: 

 
• Створення профілю одним клацанням миші 

на матриці. 

 

➔ Спочатку програма VeriSoft знаходить 

центр найближчої камери. Профіль буде 

проходити через цю точку. 

 

Матриці OCTAVIUS 4D: 

 
• Створення профілю одним клацанням миші 

на матриці. 

 

➔ Спочатку програма VeriSoft знаходить 

центр найближчого воксела. Профіль 

буде проходити через цю точку. 

 
 

Матриці, що не мають відношення до 

детектора: 

 
• Створення профілю одним клацанням миші 

на матриці. 

 

➔ Спочатку програма VeriSoft знаходить 

найближчий піксель. Профіль буде 

проходити через цю точку. 

 
14.3.2. Визначення положення 

профілю 

• У вікні матриці виберіть пункт контекстного 

меню Profile Position (Положення профілю). 

 

➔ На екрані з'явиться діалогове вікно Set 

Coordinate for Profile (Установка 

координат для профілю): 

 
 
 

 

 
Малюнок 63. Діалогове вікно установки 

координат для профілю 

• Встановіть положення профілю наступним 

чином: 

 
- вибравши точку для використання клацанням 

миші в матриці; 

 
-  ввівши координати в діалоговому вікні. 

Перевірте положення, натиснувши кнопку 

Show Position (Показати положення). 

 
• Підтвердіть новий ізоцентр натисканням 

кнопки OK. 

 

➔ Профіль буде намальовано через центр 

найближчої камери, центр найближчого 

воксела або через найближчий піксель 

(див. Розд. 14.3.1 "Створення 

профілів"). 



 
 
 
 

 

14.3.3. Зсув профілів 

 
• Використовуйте клавішу Shift і клавіші зі 

стрілками для переміщення покажчика миші ↑, 

↓, ← і → для зміщення профілів в залежності 

від дозволу матриці. Якщо у вікні результатів 

відображається дискретне перехрещення, 

положення профілю (зміщення) буде показано 

в рядку стану. 

 

➔ Матриці матричного детектора: 

Якщо завантажена принаймні одна 

матриця матричного детектора, то профіль 

буде зміщений на відстань камери, тобто 

на 10 мм, в обраному напрямку (в разі 

детектора OCTAVIUS Detector 1000SRS - на 

2,5 мм, а в разі детектора OCTAVIUS 

Detector 1500 - на 5 мм). 

➔ Матриці OCTAVIUS 4D: 

Якщо завантажена принаймні одна 

матриця OCTAVIUS 4D, профіль буде 

зміщений на розмір воксела в обраному 

напрямку. 

➔ Матриці, що не мають відношення до 
детектора: 

Профіль буде зміщений в обраному 

напрямку. 

14.3.4. Дискретне перехрещення 

 
• При подвійному натисканні на 

представленні профілю буде відображено 

дискретне перехрещення. 

 

➔ Значення в фактичній позиції 

перехрещення будуть відображені в 

рядку стану (див. малюнок 62). 

 

 
Виконайте описані нижче дії, щоб переміщати 

перехрещення в діаграмі: 

 
• Клацніть лівою кнопкою миші на діаграмі і 

утримуйте кнопку миші. При переміщенні миші 

перехрещення буде зміщуватися від однієї 

точки вимірювання до іншої на профілі. Якщо 

відпустити кнопку миші перехрещення 

зупиниться на останній точці вимірювання. 

 
• Використовуйте клавіші зі стрілками ← і → 

(без клавіші Shift), щоб зміщувати 

перехрещення від однієї точки вимірювання до 

іншої. 

Дозвіл точок вимірювання складає: 

матриця матричного детектора: 10 мм 

(В разі детектора OCTAVIUS 

Detector 1000 SRS 2,5 мм) 

(В разі детектора OCTAVIUS 

Detector 1500  5 мм) 

матриця OCTAVIUS 4D: розмір воксела 

 
• Якщо встановити покажчик миші на іншу 

точку вимірювання і клацнути лівою кнопкою 

миші, перехрещення з'явиться на цій точці 

вимірювання. 

 

 
Перехрещення деактивується при закритті 

матриці або повторному виборі 

представлення профілю. 
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14.3.5. Відображення значень доз 

для профілів 

 
Якщо встановити прапорець View Table 

(Перегляд таблиці) в панелі інструментів вікна 

результатів, профілі будуть показані в 

табличному форматі. 

 
Таблиця містить позиції і відповідні значення 

доз для матриці A і матриці B, а також 

результат порівняння. Якщо завантажено 

тільки одну матрицю, то стовпці для другої 

матриці і для результату порівняння будуть 

порожніми. 

 
При відображенні відносних профілів таблиця 

містить нормалізовані значення доз. При 

відображенні абсолютних профілів 

(прапорець Absolute Dose Values 

встановлено), таблиця містить абсолютні 

значення доз. 

 
Якщо обрано метод Gamma Index (Гамма- 

індекс), позиції з недостатньою дозою при 

значенні гамма > 1 виділені синім кольором, а 

позиції з надлишковою дозою при значенні 

гамма > 1 виділені червоним кольором. 

 

 
Ці значення доз можна перенести в інші 

програми, наприклад в програми електронних 

таблиць: 

• Виділіть потрібний діапазон і виберіть пункт 

контекстного меню Copy (Копіювати), щоб 

скопіювати виділені значення доз і результати 

в буфер обміну. З буфера обміну можна 

вставити їх в іншу програму. 

 
• Щоб зберегти всі значення доз як файл 

CSV (*.csv) або як текстовий файл (*.txt), 

виберіть пункт контекстного меню Save All 

(Зберегти все). 

Щоб зберегти тільки частина значень, виділіть 

потрібний діапазон і виберіть пункт 

контекстного меню Save Selected (Зберегти 

вибрані). 

Файл CSV можна відкрити в програмі 

електронних таблиць. 
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14.4. Функція збільшення 

 
Якщо завантажені дві матриці, можна оцінити 

певну область завантажених матриць з 

допомогою функції Zoom (Збільшення). при 

використанні функції Zoom (Збільшення) 

вихідні матриці не змінюються. 

 
• В полі переліку в панелі інструментів 

виберіть запис Zoom (Збільшення). 

 

➔ У вікні результатів буде виведено 

зображення матриці B у відтінках сірого. 

• Утримуючи ліву кнопку миші, накресліть 

прямокутник, щоб визначити область для 

збільшення. 

 

➔ Обрана область буде позначена 

червоним прямокутником. 

 
➔ В інших вікнах буде показана обрана 

область, і всі оцінки будуть перераховані 

для цієї області. 

 

• Область для збільшення завжди можна 

змінити, накресливши інший прямокутник. 

 

В режимі Zoom (Збільшення) можна 

перемикати представлення профілю. 

Виконання обробки зображень в режимі Zoom 

неможливе. 
 

 

• Повернення до початкового вигляду матриці 

здійснюється наступним чином: 

-  в полі переліку в панелі інструментів знову 

виберіть новий запис Zoom (Збільшення) і 

 
-  виберіть пункт контекстного меню Reset 

(Скидання) в представленні Zoom 

(Збільшення). 
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Малюнок 64. Вікно результатів з функцією збільшення 
 
 

1 Зображення матриці B у відтінках сірого 

 
2 Обрана область збільшення 

 
3 Рядок стану, що містить наступні 

елементи: 

 
a Координати лівої сторони обраної 

області збільшення 

 
b Координати сторони джерела обраної 

області збільшення 

c Координати правої сторони обраної 

області збільшення 

 
d Координати сторони мішені обраної 

області збільшення 

 
e Позиція курсора в напрямку зліва 

направо 

 
f Позиція курсора в напрямку 

мішень-джерело 

 

 

3a 3b 3c 3d 3e 3f 



 
 
 
 

 

14.5. Гістограма 

 
Якщо завантажено дві матриці, можна 

відобразити гістограму результату порівняння. 

В полі переліку в панелі інструментів виберіть 

запис Histogram (Гістограма). 

 
Для обох матриць повинна використовуватися 

однакова одиниця вимірювання. Інакше буде 

виведено відповідне повідомлення і 

доведеться спочатку відкалібрувати матриці 

(див. Розд.13.4 "Калібрування"). 

 
• Позначення для гістограми можна показати 

або приховати, вибравши меню Graphics → 

Legend (Графіка - Позначення). 

 
• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати гістограму в 

буфер обміну. З буфера обміну можна 

вставити його в іншу програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти гістограму у 

вигляді графічного файлу. Доступні формати 

файлів: *.png, *.jpg, *.tif і *.bmp. 

 
Структура гістограми залежить від режиму 

порівняння (див. Розд. 15.2 "Вибір режиму 

порівняння та налаштування параметрів 

порівняння "). 

Метод Gamma Index (Гамма-індекс): 

 
1. Значення доз, які відповідають умовам 

режиму порівняння Gamma (в діапазоні 

допуску): 

 
Гамма-індекс 0 ... ≤ 1: 

-  темно-зелені стовпчики для значень з 

недостатньою дозою 

-  світло-зелені стовпчики для значень з 

надлишковою дозою 

 
2. Значення доз, які не відповідають умовам 

режиму порівняння Gamma (Гамма) (поза 

межами допуску): 

 
Гамма-індекс 1 <... ≤ 3: 

- сині стовпчики для значень з недостатньою 

дозою 

-  червоні стовпчики для значень з 

надлишковою дозою 

 
Гамма-індекс > 3: 

Значення доз будуть додані і відображені 

синіми стовпцями для значень з 

недостатньою дозою і червоними 

стовпчиками для значень з надлишковою 

дозою. 

 
Крок значень гамма для стовпчиків становить 

приблизно 0,2. 
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Метод Local% Difference (Локальна різниця 

в%) або DoN (різниця в% від реф. норм. 

значення): 

 
Відхилення будуть показані світло-зеленими 

стовпчиками з кроком значень 2%. 

 
Будуть додані значення з відхиленням <-10%. 

Будуть додані значення з відхиленням > +10%. 

Малюнок 65. Гістограма для методу Gamma Index (Гамма-індекс) 



 
 

14.6. Результат порівняння 

 
Якщо завантажено дві матриці, можна 

відобразити таблицю з результатом 

порівняння. Для цього в полі переліку в панелі 

інструментів виберіть запис Results 

(Результати). 

 
Для обох матриць повинна використовуватися 

однакова одиниця вимірювання. Інакше буде 

виведено відповідне повідомлення і 

доведеться спочатку відкалібрувати матриці 

(див. Розд.13.4 "Калібрування"). 

 

 
Показані результати порівняння залежать від 

наступного: 

 
- режим порівняння, обраний у вікні порівняння 

 
-  умови оцінки, налаштовані в меню Tools → 

Options (Сервіс - Параметри) на вкладці 

Compare (Порівняння) (див. Розд. 23.3.1 

"Параметри режиму порівняйня") 

 

 
Після вибору класу порівняння у вікні 

порівняння на вкладці Compare 

(Порівняння) стане активною кнопка 

Export to Track-it (Експорт в Track-it), і 

можна буде експортувати результати 

порівняння в базу даних Track-it. 

Додаткову інформацію див. в розд.22 

"Експорт в базу даних Track-it". 

 

 
• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати результати 

порівняння в буфер обміну. З буфера обміну 

можна вставити його в іншу програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти результати 

порівняння в файл CSV (*.csv) або в текстовий 

файл (*.txt). 

 

Представлення результатів містить наступні 

дані: 

 

 
Область Statistics (Статистика) 

 
- Number of Dose Points (Число точок доз) 

Загальна кількість точок матриці. 

 
- Evaluated Dose Points (Оцінені точки доз) 

Число оцінених точок, тобто загальне число 

точок мінус число точок нижче певного 

порогу. Цей поріг можна задати у 

спливаючому вікні Compare (Порівняння) у 

вікні порівняння (див.   Розд.15.2 "Вибір 

режиму  порівняння  і  налаштування 

параметрів порівняння"). 

 
- Passed (В діапазоні допуску) 

Число оцінених точок доз, які відповідають 

заданим умовам. 

Відсоткове співвідношення до оцінених 

точок доз зазначене в дужках. 

 
- Failed (Поза діапазоном допуску) 

Число оцінених точок доз, які не 

відповідають заданим умовам. 

Відсоткове співвідношення до оцінених 

точок доз зазначенев дужках. 

 
- Result (Результат) 

Результат відповідно до умов оцінки, 

налаштованими в меню Tools → Options 

(Сервіс - Параметри) на вкладці Compare 

(Порівняння) (див. Розд. 23.3.1 "Параметри 

режиму порівняйня"). 
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Область Gamma 2D, Gamma 3D, Local % 

Difference і DoN (Гамма 2D, Гамма 3D, 

Локальна різниця в%, Різниця в% від реф. 

норм. значення) 

 
- Arithmetic Mean (Арифметичне середнє): 

арифметичне середнє значення 

розрахункових значень порівняння 

 
- Min (Мінімальне): 

мінімальне розрахункове значення 

порівняння з координатами і значення 

референтної матриці 

 
- Max (Максимальне): 

максимальне розрахункове значення 

порівняння з координатами і значення 

референтної матриці 

 
- Median: 

медіана розрахункових значень порівняння 

 

 
Область Absolute Difference (Абсолютна 

різниця) 

 
- Arithmetic Mean: 

арифметичне середнє значення різниць доз 

 
- Min: 

мінімальна розрахункова різниця доз з 

координатами і значення референтної 

матриці 

 
- Max: 

максимальна розрахункова різниця доз з 

координатами і значення референтної 

матриці 

 
- Median: 

медіана різниць доз 

 

 
Область Settings (Налаштування) 

 
Налаштування в меню Tools → Options (Сервіс 

- Параметри) на вкладці Compare (Порівняння) 

(Див. Розд. 23.3.1 "Параметри режиму 

порівняння ") 



1a 1b 

 

 
 

 

 

 

 
 

15. Вікно порівняння 
 

Результати порівняння будуть показані у вікні 

порівняння, якщо завантажено дві матриці 

(або  об'ємні  набори  доз  або  переліки 

матриць). 

Під час завантаження матриці будуть 

підлаштовані, як описано в розд. 8.16 

"Підстроювання  двох  матриць  під  час 

завантаження". 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6a 6b 6c 6d 6e 6f 

 
Малюнок 66. Вікно порівняння 

 
 

1 Панель інструментів 

a Поле переліку для вибору режиму 

представлення результатів 

порівняння 

b Поле переліку для вибору 

відображення подальшої інформації 

2 Вкладка, в якій виводиться спливаюче 

вікно 

3 Графічне або табличне представлення 

результатів порівняння 

4 Положення профілю, відображуваного 

у вікні результатів 

5 Позначення 

6 Рядок стану, що містить наступні 

елементи: 

a Обраний режим порівняння 

b Позиція курсора в напрямку зліва 

направо 

c Позиція курсора в напрямку мішень- 

джерело 

d Значення порівняння в позиції 

курсора 

e Абсолютна різниця доз в позиції 

курсора 

f Відносна різниця доз в позиції 

курсора 
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15.1. Спливаючі вікна 

 
При наведенні покажчика миші на вкладці (2), 

в лівій стороні вікна порівняння виводяться 

спливаючі вікна. Ці спливаючі вікна містять 

наступні функції: 

 
- Вкладка Compare (Порівняння) 

містить спливаюче вікно для вибору режиму 

порівняння і налаштування параметрів 

порівняння (див. також розд. 15.2 "Вибір 

режиму порівняння і налаштування 

параметрів порівняння"). 

Якщо завантаженоі два об'ємних набора доз, 

і режим порівняння Gamma 3D (Гамма 3D) 

активний, в цьому спливаючому вікні можна 

ініціювати порівняння розподілів доз в об'ємі 

(див. також розд. 15.6 "Порівняння розподілів 

доз в об'ємі"). 

 
- Вкладка RTView 

містить спливаюче вікно для накладення 

структур тіла пацієнта на розподіл доз (див. 

також розд. 17 "Накладення структур тіла 

пацієнта"). 

 
-  Вкладка DVH (Гістограма об'ємного набору 

доз) 

містить спливаюче вікно для розрахунку 

кривих DVH на основі даних вимірювань 

OCTAVIUS 4D (див. також розд. 18 

"Гістограми об'ємного набору доз (опція)") і 

для порівняння з кривими DVH на основі 

даних системи планування променевої 

терапії (TPS). 

Спливаюче вікно DVH відкривається тільки 

при наявності купленої і активованої ліцензії 

для функції DVH 4D (Гістограма об'ємного 

набору доз 4D). 

15.2. Вибір режиму 

порівняння і 

налаштування параметрів 

порівняння 

 
При наведенні покажчика миші на вкладку 

Compare (Порівняння) в лівій стороні вікна 

порівняння виводиться спливаюче вікно (див. 

малюнок 67). На вкладці Compare 

(Порівняння) тепер є дві можливості 

налаштування параметрів порівняння: 

 
1. Вгорі, в полі переліку виберіть клас 

порівняння. Додаткову інформацію щодо 

визначення класів порівняння див. в 

розд.23.3.9 "Визначення класів порівняйня". 

 
➔ Результат порівняння  буде 

розрахований і відображений відповідно 

до параметрів порівняння, 

встановлених для класу порівняння. 

 

 
2. Виберіть режим порівняння у другому полі 

переліку: 

 
- Gamma 2D і Gamma 3D 

метод «Гамма-індекс» 

 
- Local% Difference 

метод «Локальна різниця у відсотках» 

 
- DoN (% Diff ref Norm. Value) 

метод «Різниця в% від нормалізованого 

значення референтної матриці» 

 

Режим порівняння Gamma 3D (Гамма 3D) 

можна вибрати, лише якщо завантажена 

матриця є об'ємним набором доз. 
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• Налаштуйте параметри порівняння для 

обраного режиму порівняння згідно з розд. 

15.2.1 "Методи Gamma 2D і Gamma 3D" і розд. 

15.2.2 "Метод Local Percentage Difference 

(Локальна різниця у відсотках) і Difference in% 

of Normalization Value of Reference Matrix 

(Різниця в % від нормалізованного значення 

референтної матриці)". 

 
• Натисніть кнопку Apply (Застосувати) (або 

натисніть клавіші Ctrl і A). 

 

➔ Результати порівняння будуть 

розраховані і відображені. 

 
15.2.1. Методи Gamma 2D і Gamma 

3D 

 

Якщо завантажено матрицю матричного 

детектора і матрицю, яка не має відношення 

до детектора, то в якості референтної матриці 

завжди буде використовуватися матриця 

матричного детектора. 

 
Якщо завантажено дві матриці матричного 

детектора або дві матриці, що не мають 

відношення до детектора, то в якості 

референтної матриці завжди буде 

використовуватися матриця B. 
 

 

 
Метод Gamma Index (Гамма-індекс) базується 

на теоретичній концепції, викладеній в статті 

Daniel A. Low та ін. (Med. Phys. 25 (1998) 656- 

661) [4]. 

 
Програма VeriSoft дає можливість додатково 

обчислювати гамма-індекс, застосовуючи 

розширені умови (другий і третій прохід), 

розроблені авторами статті Tom Depuydt та ін. 

(Radiotherapy and Oncology 62 (2002) 309-319) 

[5]. У певних випадках це призводить до 

меншого числа точок збою. Зміна відбувається 

головним чином в областях крутих градієнтів 

дози. Цю можливість можна включити і 

відключити в меню Tools → Options (Сервіс - 

Параметри) на вкладці Compare (Порівняння) 

(див. Розд.23.3.1 "Параметри режиму 

порівняння"). PTW рекомендує 

використовувати цю можливість. 
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Малюнок 67. Спливаюче вікно порівняння з 
параметрами для методу 
Gamma Index (Гамма-індекс) 

 
Для методу Gamma Index (Гамма-індекс) 

можна визначити наступні параметри 

розрахунку: 

 
- mm Distance-To-Agreement (Відстань до 

заданої точки в мм): 

відповідає просторовому відхиленню 
 

Якщо в якості порівняльної матриці 

завантажено об'ємний набір доз і обрано 

режим порівняння Gamma 3D (Гамма 3D), 

програма VeriSoft перевірить прийняте 

просторове відхилення у всіх просторових 

напрямах. 
 

 

 
- % Dose Difference with ref. to (% різниці дози 

відносно): 

прийнятого відсоткового відхилення дози 

-  Референтне значення для прийнятого 

відсоткового відхилення дози: 

 
- Local dose (Локальна доза): 

доза у відповідній позиції референтної 

матриці 

 
- Max. dose of ... (Макс. доза ...): 

максимальна доза референтної матриці, 

яка залежить від налаштувань в меню Tools 

→ Options (Сервіс - Параметри) на вкладці 

Compare (Порівняння) (див. розд. 23.3.1 

"Параметри режиму порівняння") 

 
- calculated volume (розрахунковий об'єм): 

максимальна доза всього об'ємного 

набору доз 

- measured slice (виміряний зріз): 

максимальна доза обраного зрізу 

 
- Selected dose (Обрана доза): 

доза в довільній точці референтної 

матриці: 

Для цього клацніть на кнопці Select 

(Вибрати), а потім клацніть на потрібній 

точці у вікні порівняння або введіть 

потрібне значення дози. 

 
-  Use increased tolerance (Використовувати 

збільшений допуск): 

Ви можете визначити вищий допуск для 

використання нижче певного порогу. Для 

цього потрібно встановити відповідний 

прапорець і ввести більш високий допуск і 

бажане значення порога. 
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-  Suppress doses below (Ігнорувати більш 

низькі дози): 

Можна заборонити виконання гамма- 

розрахунку, якщо значення доз референтної 

матриці нижче заданого порогу доз. Для 

цього потрібно встановити відповідний 

прапорець і ввести значення порога у 

відсотках від заданої максимальної дози. 

Максимальна доза визначається 

налаштуванням в меню Tools → Options 

(Сервіс - Параметри) на вкладці Compare 

(Порівняння) (див. Розд.23.3.1 "Параметри 

режиму порівняння"). 

Точки, виключені з оцінки, будуть позначені 

як не поціновані, відображені зі значенням 

гамма = 0 в діаграмі і помічені символами 

«---» в таблиці. Точки, виключені з оцінки, не 

розглядаються в статистиці або в гістограмі. 

PTW рекомендує використовувати цей 

параметр, щоб усунути вплив розсіяного 

випромінювання на результати. 

 

 
Якщо завантажено два об'ємні набори 

доз, і режим порівняння Gamma 3D 

(Гамма 3D) активний, за допомогою 

цієї кнопки можна ініціювати 

порівняння розподілів доз в об'ємі 

(див. також розд. 15.6 "Порівняння 

розподілів доз в об'ємі"). 

15.2.2. Метод Local Percentage 

Difference (Локальна різниця у 

відсотках) і Difference in% of 

Normalization Value of 

Reference Matrix (Різниця в % 

від нормалізованого значення 

референтної матриці) 

 

Якщо завантажено матрицю матричного 

детектора і матрицю, яка не має відношення 

до детектора, то матриця матричного 

детектора буде використовуватися як 

референтна матриця. 

 
Якщо завантажено дві матриці матричного 

детектора або дві матриці, що не мають 

відношення до детектора, то в якості 

референтної матриці завжди буде 

використовуватися матриця B. 
 

 

 
Різниця між двома матрицями матричного 

детектора визначається порівнянням значень 

доз для камер. 

 
Різниця між двома матрицями, що не мають 

відношення до детектора, визначається 

порівнянням окремих пікселів. 

 
У випадку матриці матричного детектора і 

матриці, яка не має відношення до детектора, 

програма VeriSoft буде накладати матрицю, 

що не має відношення до детектора, на сітку, 

відповідну спроектованим областям камер, і 

обчислювати середнє значення дози для 

кожної камери. Ці середні значення доз 

порівнюються зі значеннями доз матриці 

матричного детектора. 
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Формула розрахунку для матриці різниць в 

методі Local Percentage Difference (Локальна 

різниця у відсотках): 
 

 

Формула розрахунку для матриці різниць в 

методі Difference in% of Normalization Value of 

Reference Matrix (Різниця в % від 

нормалізованого значення референтної 

матриці): 
 

 

V (i,j) значення в точці (i,j) порівняльної 

матриці 

R (i,j) значення в точці (i,j) референтної 

матриці 

R (i0,j0) Значення в точці нормалізації (i0,j0) 

референтної матриці 

 

Малюнок 68. Спливаюче вікно порівняння з 
параметрами для методу 
Local% Difference (Локальна 
різниця в %) 

 

 
 

Малюнок 69. Спливаюче вікно порівняння з 

параметрами для методу DoN 
(Різниця в % від нормальних 
значень. значення реф. 
матриці) 

 
Для цих двох режимів порівняння можна також 

заборонити виконання розрахунку, якщо 

значення доз референтної матриці нижче 

заданого порогу. Для цього потрібно 

встановити відповідний прапорець і ввести 

значення порога у відсотках від 

максимального значення в вимірюваному 

зрізі. 

Точки, виключені з оцінки, будуть позначені як 

не поціновані, відображені зі значенням 

порівняння = 0 в діаграмі і помічені символами 

«---» в таблиці. Точки, виключені з оцінки, не 

розглядаються в статистиці або в гістограмі. 



 
 
 
 
 

15.3. Зміна візуалізації у 

вікні порівняння 

 
Результат порівняння може бути 

представлений в наступних режимах в 

залежності від обраного режиму порівняння: 

 
- розподіл значень порівняння 

 
-  відображення збійних точок (тільки для 

методу Gamma Index) 

 
- таблиця зі значеннями порівняння 

 
-  без графічного або табличного 

представлення результатів порівняння. 

 
Поле переліку (1a) в панелі інструментів 

служить для вибору режиму представлення. 

 
 

 
Крім результатів порівняння може бути 

відображена наступна інформація: 

 
- зображення матриці B у відтінках сірого 

 
- області ізодоз матриці B 

 
- лінії ізодоз матриці A 

 
- лінії ізодоз матриці B 

 
Поле переліку (1b) в панелі інструментів 

служить для вибору додаткової інформації. Ці 

елементи можна комбінувати, знімаючи і 

встановлюючи відповідні прапорці. 

15.4. Результати 

порівняння у вигляді 

розподілу або 
збійних точок 

 
Режим представлення Distribution (Розподіл) 

або Failed Points (Збійні точки) вибирається в 

полі переліку (1a) в панелі інструментів: 

 
-  У разі представлення Distribution (Розподіл) 

градієнт кольору залежить від обраного 

режиму порівняння. 

 
- Метод Gamma Index (Гамма-індекс): 

градієнт кольору від зеленого (значення 

гамма = 0) через жовтий до червоного 

(значення гамма ≥ 1,5) 

 
- Метод Local% Difference (Локальна 

різниця в %) або DoN (Різниця в % від реф. 

норм. значення): 

градієнт кольору від синього (від'ємне 

значення порівняння) через зелений до 

червоного (позитивне значення порівняння) 

 
-  У разі представлення Failed Points (Збійні 

точки), доступного тільки для методу Gamma 

Index, точки зі значеннями гамма > 1 будуть 

відображатися як дискретні точки. 

Синя точка відповідає недостатній дозі, а 

червона точка - надмірній дозі. 

При наведенні покажчика миші на таку точку, 

з'явиться підказка з наступною інформацією: 

-  мінімальне прийняте просторове відхи- 

лення, для якого ця точка повинна 

відповідати умові 

-  значення гамма, розраховане для цього 

відхилення 

- позиція точки порівняння 

- позиція точки покажчика миші 
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• Якщо одна із завантажених матриць є 

матрицею матричного детектора, можна 

спроектувати позиції камер на завантажені 

матриці, вибравши меню View → Overlay 

Measuring Positions (Вид - Накладення 

позиций вимірювання). 

 
• Позначення для матриць можна показати 

або приховати, вибравши меню Graphics → 

Legend (Графіка - Позначення). 

 
• За допомогою поля переліку (1b) в панелі 

інструментів вікна порівняння можна 

відобразити подальшу інформацію (див. 

Розд.15.3 "Зміна візуалізації у вікні 

порівняння"). 

 
• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати фактичне 

представлення результатів порівняння в 

буфер обміну. З буфера обміну можна 

вставити його в іншу програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти фактичне 

представлення результатів порівняння у 

вигляді графічного файлу. Доступні формати 

файлів: *.png, *.jpg, *.tif і *.bmp. 

 

15.5. Відображення значень 

порівняння 

• В панелі інструментів виберіть запис Table 

(Таблиця) в полі переліку (1a): 

 
➔ Буде показана таблиця з позиціями 

референтної матриці і розрахунковими 

значеннями порівняння. 

 
➔ Позиції без розрахунку значень 

порівняння (неоцінені) відзначені 

символами «---». 

 
➔ Якщо обрано метод Gamma Index 

(Гамма-індекс), позиції з недостатньою 

дозою при значенні гамма > 1 виділені 

синім кольором, а позиції з 

надлишковою дозою при значенні гамма 

> 1 виділені червоним кольором. 

 

 
Ці значення порівняння можна перенести в 

інші програми, наприклад в програми 

електронних таблиць: 

 
• Виділіть потрібний діапазон і виберіть пункт 

контекстного меню Copy (Копіювати), щоб 

скопіювати виділені значення порівняння в 

буфер обміну. З буфера обміну можна 

вставити їх в іншу програму. 

 
• Щоб зберегти всі значення порівняння у 

вигляді файлу CSV (*.csv) або у вигляді 

текстового файлу (*.txt), виберіть пункт 

контекстного меню Save All (Зберегти все). 

 
Для збереження тільки частини значень 

виділіть потрібний діапазон і виберіть пункт 

контекстного меню Save Selected (Зберегти 

вибрані). 

Файл CSV можна відкрити безпосередньо 

програмою електронних таблиць. 



 
 
 

 

15.6. Порівняння розподілів 

доз в об'ємі 

 
У випадку двох завантажених об'ємних 

наборів доз і режиму Gamma 3D (Гамма 3D) 

можна ініціювати порівняння розподілів доз в 

об'ємі в спливаючому вікні Compare 

(Порівняння). 

 
Для обох матриць повинна використовуватися 

однакова одиниця вимірювання. Інакше буде 

виведено відповідне повідомлення і 

доведеться спочатку відкалібрувати матриці 

(див. Розд.13.4 "Калібрування"). 

• Натисніть кнопку Calculate Volume 

Analysis (Розрахунок аналізу об'єму). 

 
➔ Буде розраховане порівняння розподілів 

доз в об'ємі, і відкриється діалогове 

вікно Volume Analysis (Аналіз об'єму): 

 
 

 

 
 

Малюнок 70. Діалогове вікно аналізу об'єму 

  

 

4 5  
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1 Числовий вигляд порівняння розподілів 

доз в об'ємі 

2 Табличний вигляд порівняння розподілів 

доз в об'ємі 

3 Гістограма порівняння розподілів доз в 

об'ємі 

4 Кнопка для друку порівняння розподілів 

доз в об'ємі 

5 Кнопка для попереднього перегляду 

порівняння розподілів доз в об'ємі 

6 Кнопка для експорту порівняння розпо- 

ділів доз в об'ємі в базу даних Track-it 

 
 

 
• Кнопка Print (Друк) служить для друку 

порівняння розподілів доз в об'ємі, а кнопка 

Preview для попереднього перегляду. 

Додаткову інформацію див. в розд.21 "Друк 

матриць і результатів". 

 
 

Після вибору класу порівняння у вікні 

порівняння на вкладці Compare 

(Порівняння) стане активною кнопка 

Export to Track-it (Експорт в Track-it), і 

можна буде експортувати порівняння 

розподілів доз в об'ємі в базу даних 

Track-it. Додаткову інформацію див. в 

розд. 22 "Експорт в базу даних Track- 

it". 

Коли відкрито діалогове вікно Volume Analysis 

(Аналіз об'єму), в інших вікнах VeriSoft 

використовуйте такі опції: 

 
- Вікно матриці A або B: 

переміщення по зрізах об'ємного набору доз 

на вкладці Slice (Зріз) (див. розд. 12.2 

"Вспливаючі вікна") або за допомогою 

введення глибини зрізу у відповідному полі 

введення 

 
- Вікно результатів: 

зміна представлення (див. розд. 14.1 "Зміна 

представлення у вікні результатів") 

показ або приховування індикатора трафіку 

(див. розд. 14.2 "Спливаюче вікно") 

 
- Вікно порівняння: 

зміна представлення результатів порівняння 

(див. розд. 15.3 "Зміна візуалізації у вікні 

порівняння") 

 
Однак неможливо змінити режим порівняння 

або параметри порівняння. 



 
 
 

 

15.6.1. Числовий вигляд 

порівняння 

 
Числовий вигляд порівняння містить наступні 

результати: 

 

 
Область Statistics (Статистика) 

 
- Number of Voxels (Число вокселів) 

Загальна кількість вокселів в об'ємному 

наборі доз 

 
- Evaluated Voxels (Оцінені вокселі) 

Число вокселів, для якого було розраховано 

значення порівняння, тобто загальне число 

мінус число вокселів нижче заданого порогу. 

Цей поріг можна задати у спливаючому вікні 

Compare (Порівняння) у вікні порівняння 

(див. Розд.15.2 "Вибір режиму порівняння і 

налаштування параметрів порівняння"). 

Поріг задається для всього об'ємного набору 

доз. 

 
- Passed (В діапазоні допуску) 

Число оцінених вокселів, які відповідають 

заданим умовам. 

Відсоткове співвідношення до оцінених 

вокселів зазначене в дужках. 

 
- Failed (Поза діапазоном допуску) 

Число оцінених вокселів, які не відповідають 

заданим умовам. 

Відсоткове співвідношення до оцінених 

вокселів зазначене в дужках. 

 
- Result (Результат) 

Результат відповідно до умов оцінки, 

налаштованих в меню Tools → Options 

(Сервіс - Параметри) на вкладці Compare 

(Порівняння) (див. Розд. 23.3.1 "Параметри 

режиму порівняйня"). 

 
Область Compare (Порівняння) 

 
- Arithmetic Mean (Арифметичне середнє): 

Арифметичне середнє розрахункових 

значень порівняння 

 
- Min (Мінімальне): 

Мінімальне розрахункове значення 

порівняння з координатами і значення 

референтної матриці 

 
- Max (Максимальне): 

Максимальне розрахункове значення 

порівняння з координатами і значення 

референтної матриці 

 
- Median (Медіана): 

медіана розрахункових значень порівняння 

 

 
Область Absolute Difference (Абсолютна 

різниця) 

 
- Arithmetic Mean (Арифметичне середнє): 

Арифметичне середнє різниць доз 

 
- Min (Мінімальне): 

мінімальне розрахункове відхилення доз з 

різницею і значення референтної матриці 

 
- Max (Максимальне): 

Максимальне розрахункове відхилення доз з 

різницею і значення референтної матриці 

 
- Median (Медіана): 

Медіана різниць доз 

 

 
Область Settings (Налаштування) 

 
Налаштування для режиму порівняння 

Gamma 3D (Гамма 3D) в меню Tools → Options 

(Сервіс - Параметри) на вкладці Compare 

(Порівняння) (див. Розд. 23.3.1 "Параметри 

режиму порівняння") 
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Область Parameters (Параметри) 

 
Налаштування для режиму порівняння 

Gamma 3D (Гамма 3D) у спливаючому вікні 

Compare (Порівняння) (див. Розд. 15.2.1 

"Методи Gamma 2D і Gamma 3D") 

 
 

 
• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати числовий 

вигляд в буфер обміну. З буфера обміну 

можна вставити його в іншу програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти числовий 

вигляд в файл CSV (*.csv) або в текстовий 

файл (*.txt). 

15.6.2. Гістограма порівняння 

 
В гістограмі аналіз представлено стовпчиками 

з наступними кольоровими позначеннями. 

 
1. Значення доз, які відповідають умовам 

режиму порівняння Gamma (Гамма) (в 

діапазоні допуску): 

 
Гамма-індекс 0 ... ≤ 1: 

-  темно-зелені стовпчики для значень з 

недостатньою дозою 

-  світло-зелені стовпчики для значень з 

надлишковою дозою 

 
2. Значення доз, які не відповідають умовам 

режиму порівняння Gamma (Гамма) (поза 

діапазоном допуску): 

 
Гамма-індекс 1 <... ≤ 3: 

- сині стовпчики для значень з недостатньою 

дозою 

-  червоні стовпчики для значень з 

надлишковою дозою 

 
Гамма-індекс > 3: 

Значення доз будуть додані і відображені 

синіми стовпцями для значень з 

недостатньою дозою і червоними 

стовпчиками для значень з надлишковою 

дозою. 

 
Крок значень для стовпчиків становить 0,2. 

 

 
• Позначення для гістограми можна показати 

або приховати, вибравши меню Graphics → 

Legend (Графіка - Позначення). 



 
 
 

 

• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати гістограму в 

буфер обміну. З буфера обміну можна 

вставити його в іншу програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти гістограму у 

вигляді графічного файлу. Доступні формати 

файлів: *.png, *.jpg, *.tif і *.bmp. 

15.6.3. Табличний вигляд 

порівняння 

 
Табличний вигляд порівняння показує аналіз 

по областям доз. 

 
Область доз містить всі вокселі, значення дози 

в яких більші або дорівнюють відповідному 

рівню дози. Рівень дози вказано в % Від 

значення нормалізації референтного набору 

даних. 

Приклад: 

Область доз для рівня дози 50 містить всі 

вокселі, значення дози в яких складають ≥ 50% 

від значення нормалізації референтного 

набору даних. 

 
Цей вид містить шість наступних стовпців: 

 
- Стовпець 1 = Dose level for evaluation ... 

(Рівень дози для оцінки ...) 

Вибір області доз для відображення за 

допомогою установки або зняття відповідних 

прапорців рівня дози. 

В наявності є такі рівні дози: 

10, 30, 50, 70, 80, 85, 90, 95, 100, 105, 110 і 

120 

За замовчуванням активні рівні дози 10, 50 і 

100. 

 
- Стовпець 2 = Number of Voxels 

(Число вокселів) 

Число вокселів, в яких доза більше або 

дорівнює відповідному рівню дози 

 
- Стовпець 3 = Evaluated Voxels 

(Оцінені вокселі) 

Число оцінених вокселів, в яких доза більша 

або дорівнює відповідному рівню дози. 

Вокселі будуть оцінюватися, якщо вони 

перевищують поріг, заданий у спливаючому 

вікні Compare (Порівняння) (див. Розд. 15.2 

"Вибір режиму порівняння і налаштування 

параметрів порівняння"). 
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- Стовпець 4 = Passed (В діапазоні допуску) 

Число оцінених вокселів, які відповідають 

заданим умовам. 

Відсоткове співвідношення до оцінених 

вокселів зазначене в дужках. 

 
- Стовпець 5 = Failed 

(Поза діапазоном допуску) 

Число оцінених вокселів, які не відповідають 

заданим умовам. Відсоткове співвідношення 

до оцінених вокселів зазначене в дужках. 

 
- Стовпець 6 = Result (Результат) 

Результат відповідно до умов оцінки, 

налаштованих в меню Tools → Options 

(Сервіс - Параметри) на вкладці Compare 

(Порівняння) (див. Розд. 23.3.1 "Параметри 

режиму порівняння"). 

 

 
• Вибравши пункт контекстного меню Copy 

(Копіювати), можна скопіювати таблицю в 

буфер обміну. З буфера обміну можна 

вставити її в іншу програму. 

 
• Вибравши пункт контекстного меню Save 

As (Зберегти як), можна зберегти числове 

представлення до файлу CSV (*.csv) або 

текстового файлу (*.txt). 

 
 

 
15.6.3.1. Визначення рівнів дози 

 

• В панелі табличного виду виберіть 

контекстне меню Edit Dose Level (Зміна рівня 

дози). 

➔ На екрані з'явиться діалогове вікно Dose 

Levels (Рівні дози): 
 

Малюнок 71. Діалогове вікно рівнів дози 

 
 

• Визначте відповідні рівні дози. 

 
• Виберіть рівні дози, які потрібно 

відобразити, встановивши відповідні прапорці. 

 
• Натисканням кнопки Sort by value 

(Сортування за значенням) можна 

впорядкувати рівні дози. 

 
• Клацнувши на кнопці Set to default 

(Встановити значення за замовчуванням), 

можна відновити рівні дози за замовчуванням. 

 
• Підтвердіть налаштування натисканням 

кнопки OK. 

 

➔ Аналізи для установки рівнів дози 

будуть обчислюватися і відображатися 

в табличному вигляді в діалоговому вікні 

Volume Analysis (Аналіз об'єму). 



 
 

 

16. Проекти VeriSoft 
 

 

Програма VeriSoft дозволяє зберігати 

завантажений набір даних у вигляді проекту, 

завдяки чому вивірки плану можуть бути 

продовжені пізніше або можливий 

ретроспективний огляд перевірки плану. 

 
В цьому контексті термін набір даних має одне 

з наступних значень: 

 
-  матриця, завантажена і, якщо можливо, 

відредагована в вікні матриці A 

 
-  матриця, завантажена і, якщо можливо, 

відредагована в вікні матриці B 

 
-  матриці, завантажені і, якщо можливо, 

відредаговані у вікнах матриць A і B 

 
В проекті зберігається наступна інформація: 

 
- посилання на використані дані 

Якщо дані були завантажені з сервера 

DICOM, вони будуть скопійовані в підкаталог 

каталогу проекту. Буде встановлено 

посилання на цю копію. 

16.1. Збереження проекту 
 
• Для збереження проекту виберіть меню 

File→ Project → Save As (Файл - Проект - 

Зберегти як). 

➔ Відкриється стандартне діалогове вікно 

Save (Зберегти). 

Пропонований каталог: 

<PTW documents> \ VeriSoft \ Data \ 

Projects. 

Пропоноване ім'я файлу складається з 

прізвища пацієнта, використовуваного в 

файлі DICOM, і дати. 

 
• Якщо потрібно, виберіть інший каталог або 

інше ім'я файлу. 

 
• Підтвердіть введення. 

 
Проект зберігається в форматі *.vsp. 

 

 
 

Не слід переміщати дані, на які є посилання, 

в інший каталог. Інакше посилання не буде 

діяти, і буде неможливо відкрити проект. 
 

- всі зміни, виконані за допомогою меню Edit 

(Правка) 

 
-  в разі вимірювань OCTAVIUS 4D всі 

налаштування для розрахунку об'ємного 

набору доз OCTAVIUS 4D 

 
-  всі налаштування для порівняння матриць в 

діалоговому вікні Options (Параметри) і на 

вкладці Compare (Порівняння) вікна 

порівняння 

ПРИМІТКА 
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16.2. Відкриття проекту 
 

• Для відкриття проекту виберіть меню File → 

Project → Open (Файл - Проект - Відкрити). 

 
• Якщо в програмі VeriSoft активований 

захист паролем, введіть пароль. Після запуску 

програми пароль потрібно ввести тільки один 

раз. 

 
• Виберіть потрібний проект в діалоговому 

вікні Open (Відкрити). 

 

➔ Якщо проект містить вимірювання 

OCTAVIUS 4D, об'ємний набір доз 

OCTAVIUS 4D буде розрахований і 

відображений відповідно до збережених 

налаштувань. 

 
➔ У вікнах результатів і порівняння буде 

розраховане порівняння відповідно до 

збережених налаштувань, і відображено 

результат. 

 

 

Зміна налаштувань VeriSoft при відкритті 

проекту. 

 
Неправильне використання 

 
Коли проект буде відкритий, налаштування 

проекту замінять поточні налаштування 

VeriSoft, що може привести до некоректного 

порівнянні результатів. 
 

 

 
• У вікні запиту клацніть на кнопці Yes (Так), 

якщо хочете відкрити проект і замінити 

налаштування VeriSoft налаштуваннями 

проекту. 

Натисніть кнопку No (Ні) для відміни відкриття 

проекту. 

Якщо зняти цей прапорець у вікні запиту, це 

вікно перестане з'являтися до перезапуску 

програми VeriSoft. 

 
➔ У вікнах матриць A і/або B будуть 

показані пов'язані дані. Всі зміни, 

виконані за допомогою меню Edit 

(Правка), будуть повторені 

автоматично. 

ПОПЕРЕДЖЕННЯ 
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17. Накладення структур тіла пацієнта 
 
 

 
 

Перевірка розподілу доз за допомогою 

структур тіла пацієнта. 

 
Невірне тлумачення! 

 
Дані, оброблені в програмі VeriSoft, були 

розраховані для однорідного фантома і 

виміряні в однорідному фантомі. Ці дані 

будуть накладені на структури тіла пацієнта 

без перерахунку. Таким чином, ця функція 

дозволяє оцінювати тільки виміряні дані 

відносно структур тіла пацієнта. 
 

 

 

Накладення розподілу доз на структури тіла 

пацієнта в об'ємному наборі доз OCTAVIUS 4D 

неможливе, якщо об'ємний набір доз був 

обчислений для одного з наступних випадків. 

- некомпланарне опромінення 

-  опромінення при розташуванні поворотного 

блоку не в ізоцентрі 

- об'єднані вимірювання OCTAVIUS 4D 

- складені вимірювання OCTAVIUS 4D 
 

При цьому будуть виведені відповідні 

повідомлення про помилку. 
 

 

 
 

Для додаткової візуальної перевірки 

порівняння даних системи планування 

променевої терапії (TPS) і виміряних даних 

можна завантажити структури тіла пацієнта в 

вікно порівняння. Ви можете накласти 

структури тіла пацієнта на розподіл доз 

вимірювання або збійні точки. 

Як дані пацієнта можна використовувати 

дослідження DICOM, завантажене з 

довільного каталогу DICOM або імпортоване з 

мережевого сервера DICOM. Набір даних для 

завантаження або імпорту повинен містити 

методи CT (КТ), RTDose, RTPlan і RTStruct. 

 
 

 

17.1. Завантаження 

або імпорт структур 

тіла пацієнта 

• У вікні порівняння наведіть курсор миші на 

вкладку RTView. 

 

➔ Відкриється спливаюче вікно RTView. 

 

Малюнок 72. Спливаюче вікно RTView 

ПОПЕРЕДЖЕННЯ 
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Спливаюче вікно RTView містить наступні 

кнопки: 

Завантаження структур тіла пацієнта 

 

 
Імпорт структур тіла пацієнта з 

мережевого сервера DICOM 

Закриття структур тіла пацієнта 

 

 
Збільшення вікна до розміру вікна 

програми 

В збільшеному вигляді доступні всі 

параметри представлення. 

 

 
17.1.1. Завантаження структур 

тіла пацієнта 

• Для завантаження структур тіла 

пацієнта клацніть на відповідній 

кнопці. 

 
• У стандартному діалоговому вікні Select 

directory (Вибір каталогу) виберіть каталог з 

потрібним набором даних. 

 

➔ Структури тіла пацієнта будуть 

завантажені і відображені у вікні RTView. 

 
➔ Ізоцентр буде позначений червоною 

крапкою. 

 
• Щоб зробити доступними всі 

параметри представлення, збільшіть 

вікно до розміру вікна програми, 

натиснувши кнопку Maximize 

(Розгорнути). 

17.1.2. Імпорт структур тіла 

пацієнта з мережевого сервера 

DICOM 

 
• Для імпорту структур тіла пацієнта 

з мережевого сервера DICOM 

клацніть на відповідній кнопці. 

Встановіть налаштування, необхідні для 

імпорту, згідно з інструкціями в розд. 23.3.5 

"Налаштування для імпорту даних DICOM". 

➔ На екрані з'явиться діалогове вікно Load 

Remote Dataset (Завантаження 

віддаленого набору даних) (див. 

малюнок 73). 

• Знайдіть потрібні дані, як описано в розд. 

17.1.2.2 "Пошук структур тіла паціента на 

мережевому сервері DICOM". 

 
• Імпортуйте потрібні дані, як описано в розд. 

17.1.2.3 "Вибір і імпорт структур тіла пацієнта з 

мережевого сервера DICOM". 

 
➔ Структури тіла пацієнта будуть 

завантажені і відображені у вікні RTView. 

 
➔ Ізоцентр буде позначений червоною 

крапкою. 

 
• Щоб зробити доступними всі 

параметри представлення, збільшіть 

вікно до розміру вікна програми, 

натиснувши кнопку Maximize 

(Розгорнути). 



 
 
 

 

17.1.2.1. Діалогове вікно завантаження 

віддаленого набору даних 

 

 

Малюнок 73. Діалогове вікно завантаження 
віддаленого набору даних 

 
Діалогове вікно Load Remote Dataset 

(Завантаження віддаленого набору даних) 

складається з двох панелей: 

 

 
Панель Search (Пошук) 

 
В цій панелі можна задати умови для пошуку 

пацієнтів на мережевому сервері DICOM: 

 
- Patient ID (Ідентифікатор пацієнта): 

ідентифікатор для ідентифікації пацієнта 

 
- Gender (Стать): 

стать пацієнта 

 
- Last Name (Прізвище): 

прізвище пацієнта 

 
- First Name (Ім'я): 

ім'я пацієнта 

- Date Range (Діапазон дат): 

період, в який були отримані дані. 

Можна вибрати такі періоди: 

- All (Всі) 

без обмеження діапазону дат 

- Today and yesterday (Сьогодні і вчора) 

- Yesterday (Вчора) 

- Last 7 days (Останні 7 днів) 

- Last 14 days (Останні 14 днів) 

- Custom Date Range (діапазон дат, вказаний 

користувачем) 

Потрібний діапазон можна задати за 

допомогою полів переліку Begin (Початок) і 

End (Кінець). 

 

 
Панель Patients (Пацієнти) 

 
В цій панелі знайдені набори даних пацієнтів 

будуть відображені у вигляді структурованого 

дерева. 

 
В структурованому дереві пацієнтів на 

мережевому сервері DICOM доступні наступні 

три рівні: 

 
- Patient (Пацієнт): 

адміністративні дані пацієнта 

 
- Study (Дослідження): 

інформація щодо лікування 

 
- Series (Серія): 

інформація щодо тестів і серій терапії, а 

також об'єктів DICOM, тобто матриці, 

зображення і плани променевої терапії 
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17.1.2.2. Пошук структур тіла пацієнта на 

мережевому сервері DICOM 

 

• Задайте умови пошуку в діалоговому вікні 

Load Remote Dataset (Завантаження 

віддаленого набору даних). 

 
• У полях введення імені та прізвища або 

ідентифікатора пацієнта можна ввести 

параметр повністю, або початкові символи із 

зірочкою «*» в кінці, або тільки зірочку «*», щоб 

знайти всіх пацієнтів для обраного періоду. 

 
• Натисніть кнопку Search (Пошук). 

 
➔ В панелі Patients (Пацієнти) будуть 

відображені в структурованому дереві 

всі набори даних DICOM для пацієнтів, 

які відповідають обраним умовам 

пошуку. 

 
 

17.1.2.3. Вибір і імпорт структур тіла 

пацієнта з мережевого сервера 

DICOM 

 
• Виберіть потрібну структуру тіла пацієнта, 

встановивши відповідний прапорець на рівні 

Study (Дослідження) або Series (Серія). 

 
• Імпортуйте обрану структуру тіла пацієнта, 

натиснувши кнопку Download Study 

(Завантаження дослідження). 

 
• Імпорт даних можна перервати, 

натиснувши кнопку Stop Download (Зупинити 

завантаження). 

 

➔ Діалогове вікно Load Remote Dataset 

(Завантаження віддаленого набору 

даних) закриється. 

 
➔ Структура тіла пацієнта буде 

імпортована. 

17.1.3. Закриття структур тіла 

пацієнта 

• Для закриття структур тіла 

пацієнта клацніть на відповідній 

кнопці. 

 
 

17.1.4. Перевірка узгодженості 

 
Якщо набори даних будуть завантажені і в 

вікна матриць, і в вікно RTView, програма 

VeriSoft перевірить наявність кореляції між 

порівняльною матрицею і набором даних 

RTView: 

 
1. Програма VeriSoft спочатку перевірить 

відповідність ідентифікаторів користувача 

(StudyInstanceUID) обох наборів даних. 

 
➔ Якщо вони не збігаються, з'явиться 

відповідне повідомлення. Додатково 

буде виведене постійне коротке 

повідомлення в області (5) вікна RTView. 

 
2. Якщо ідентифікатори StudyInstanceUID 

збігаються, програма VeriSoft перевірить 

також відповідність ідентифікаторів 

FrameOfReferenceUID обох наборів даних. 

 
➔ Якщо вони не збігаються, з'явиться 

відповідне повідомлення в області (5) 

вікна RTView. 



1a 1b 

 

2a 

 
2b 

2c 

2d  

2e 

 
 

 

17.2. Структура вікна RTView 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 5 

2f 6 

 

 

Малюнок 74. Вікно RTView 
 
 

1 Панель інструментів 

a Поле переліку для вибору режиму 

представлення 

b Поле переліку для вибору 

відображення додаткової інформації 

 
2 Область для зміни представлення: 

a Вибір області інтересу (POI) 

b Відображення контурів пацієнта 

c Відображення ізодоз 

d Відображення пучків випромінювання 

e Спеціальні параметри в залежності 

від режиму представлення 

f Зміна відображення у відтінках 

сірого 

 
3 Кнопка для відновлення графічного 

вікна до вихідного розміру. 

 
4 Представлення структур тіла 

пацієнта і вибраних параметрів 

представлення 

 
5 Системні повідомлення 

 
6 Рядок стану 
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17.2.1. Рядок стану 

 
Якщо наступні умови будуть дотримані, то 

значення будуть відображатися в рядку стану 

(6) при наведенні покажчика миші на збійну 

точку: 

 
- завантажено матрицю матричного детектора 

або вимірювання OCTAVIUS 4D 

 
- обрано режим порівняння Gamma 2D (Гамма 

2D) або Gamma 3D (Гамма 3D) 

 
-  включено відображення Failed Points (Збійні 

точки) 

 

 
Відображаються наступні значення: 

 
- обраний режим порівняння 

 
- позиція курсора в напрямку зліва направо 

 
- позиція курсора в напрямку мішень-джерело 

 
- значення гамма в позиції курсора 

 
- абсолютна різниця доз в позиції курсора 

 
- відносна різниця доз в позиції курсора 

 
17.3. Зміна представлення у 

вікні RTView 

 
Структури тіла пацієнта можуть бути 

представлені в наступних режимах: 

 
- 2D 

двовимірне представлення, тобто зріз 

структур тіла пацієнта на глибині, що 

відповідає обраному зрізу в вікнах матриць 

 
- 3D 

тривимірне представлення, розраховане з 

серії КТ 

 
- DRR 

цифрова реконструйована рентгенограма 

 
Поле переліку (1a) в панелі інструментів 

служить для вибору режиму представлення. 

 

 
Крім структур тіла пацієнта може бути 

відображена додаткова інформація. Вона 

залежить від обраного представлення: 

 
2D 3D DRR 

Measurement Plane X X - 

відображення площини 

вимірювання 

Calculated Dose X - - 

відображення розрахункової 

дози у вигляді областей 

ізодоз 

None X X - 

без відображення 

додаткової інформації 

Failed Points X X X 

відображення збійних точок 

(Тільки для режиму 

порівняння Gamma Index) 

 



 
 
 

 
 

Поле переліку (1b) в панелі інструментів 

служить для вибору додаткової інформації. 

Елементи інформації можна комбінувати, 

знімаючи і встановлюючи відповідні прапорці. 

 
 

 
17.3.1. Відображення площини 

вимірювання і збійних точок 

 
В структурах тіла пацієнта можна відобразити 

площину вимірювання і збійні точки в потрібній 

площині відображення і на потрібній глибині. 

Площину відображення і глибину слід 

налаштувати в одному з вікон матриць. 

 
• В одному з вікон матриць виберіть потрібну 

площину відображення, клацнувши на 

відповідній кнопці (див. також розд. 12.6 

"Відображення панелей об'ємних наборів 

доз"): 

 
Фронтальна площина 

 

 
Сагітальна площина 

 
 

Поперечна площина 

 
 

➔ У вікні RTView будуть розраховані 

площина вимірювання або збійні точки в 

налаштованій площині відображення 

для глибини 0 мм і відображені на 

структурі тіла пацієнта. 

• В одному з вікон матриць виберіть потрібну 

глибину за допомогою повзунка Slice (Зріз). 

 

➔ У вікні RTView будуть розраховані 

площина вимірювання або збійні точки 

на налаштованій глибині і відображені 

на структурі тіла пацієнта. 

17.4. Параметри 

представлення у вікні 

RTView 

 
 

17.4.1. Вибір області інтересу 

 
• Виберіть потрібну область інтересу (POI) в 

полі переліку (2a). Зазвичай областю інтересу 

є ізоцентр набору даних DICOM. 

 
 

 
17.4.2. Відображення контурів 

пацієнта 

 
Якщо в завантаженому наборі даних доступні 

контури пацієнта (наприклад, контур тіла, 

контури частин тіла або контури органів), їх 

можна відобразити на додаток до структур 

тіла пацієнта. 

 
• Для цього встановіть відповідні прапорці в 

панелі Select visible ROIs (Вибір видимих 

областей інтересу) (2b). 

 

➔ Вибрані контури будуть відображені 

відповідними кольорами. 

-  Представлення 2D і DRR (Цифрова 

реконструйована рентгенограма): 

Контури будуть відображені у вигляді 

зовнішніх обрисів на поточній глибині. 

Якщо контур не перетинається на 

поточній глибині,  він не буде 

відображений. 

 
- Представлення 3D: 

Контури будуть відображені як об'ємні 

структури. 
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17.4.3. Відображення ізодоз 

 
Якщо в завантаженому наборі даних є 

розподіл доз, його можна відобразити на 

додаток до структур тіла пацієнта. 

 
• Для цього встановіть відповідні прапорці в 

панелі Select visible Isodoses (Вибір видимих 

ізодоз) (2c). 

 

➔ Всі вибрані ізодози будуть відображені 

лініями ізодоз відповідного кольору. У 

вигляді 2D ізодози можна відобразити як 

області ізодоз, якщо включено 

представлення Calculated Dose 

(Розрахункова доза) в полі переліку 

(1b). 

 

 
В панелі Select visible Isodoses (Вибір видимих 

ізодоз) (2c) можна далі визначити значення, за 

яким повинні бути нормалізовані ізодози: 

 
- Selected Isocenter (Обраний ізоцентрі) 

Нормалізація за значенням дози в обраному 

ізоцентрі (за замовчуванням) 

 
-  Norm. Value of Data Set A / B (Значення 

нормалізації набору даних A або B) 

Нормалізація за значенням нормалізації 

набору даних A або B 

Цей параметр доступний, тільки якщо набір 

даних завантажений у відповідне вікно 

матриці. 

 
- Selected Value (Вибране значення) 

Нормалізація за значенням, визначеним 

користувачем 

Введіть значення і підтвердіть його натиском 

кнопки Apply (Застосувати). 

17.4.4. Відображення пучків 

випромінювання 

 
Якщо в завантаженому наборі даних доступні 

пучки випромінювання, їх можна відобразити 

на додаток до структур тіла пацієнта. 

 
• Для цього встановіть відповідні прапорці в 

панелі Select visible Beams (Вибір видимих 

пучків випромінювання) (2d). 

 

➔ Пучок випромінювання буде виділено 

синім, а в полі переліку Control Point of 

selected Beam (Контрольна точка 

обраного пучка) будуть відображені 

доступні контрольні точки. 

• Знову клацніть на пучку. 

 
➔ Буде встановлено прапорець, і пучок 

буде відображений в першій контрольній 

точці. 

• Щоб відобразити пучок в інший контрольній 

точці, виберіть потрібну контрольну точку в 

полі переліку Control Point of selected Beam 

(Контрольна точка обраного пучка). 

 
• Якщо доступні кілька пучків, їх можна 

відобразити додатково. Повторіть описану 

послідовність дій для кожного пучка. 



 
 
 
 

 

17.4.5. Зміна відображення у 

відтінках сірого 

 
Цей параметр представлення доступний 

тільки для представлення 2D і DRR (Цифрова 

реконструйована рентгенограма). 

 
Значення КТ будуть відображені як значення у 

відтінках сірого. Відображення у відтінках 

сірого може бути змінено за допомогою двох 

повзунків (2f) під структурами тіла пацієнта. 

 
- Width (Ширина): 

за допомогою повзунка Width задається 

діапазон значень КТ для відображення, 

тобто ширина смуги. Всі значення нижче 

діапазону будуть показані чорними, а всі 

значення вище діапазону будуть показані 

білими. 

 
- Level (Рівень): 

за допомогою повзунка Level можна 

визначити середнє значення діапазону. 

 

 
Для відображення у відтінках сірого можна 

відновити значення за замовчуванням: 

• 2D-вигляд: 

Натисніть кнопку Reset 2DView (Скидання 

2D-вигляду) (2e). 

 
• Вигляд DRR (Цифрова реконструйована 

рентгенограма): 

Знову виберіть вигляд DRR в полі переліку 

(1a). 

17.4.6. Зміна представлення в 2D- 

вигляді 

 
В 2D-вигляді можна збільшити або зменшити 

структуру тіла пацієнта, що відображається. 

 
• Переміщайте мишу при натиснутій правій 

кнопці. 

 

➔ Структури тіла пацієнта будуть 

збільшуватися або зменшуватися: 

• Для відновлення стандартних 

налаштувань клацніть на кнопці Reset 

2DView (Скидання 2D-вигляду) (2e). 

 
 

17.4.7. Зміна представлення в 3D- 

вигляді 

 
Вибір представлення 

 
В полі переліку Set defined view (Установка 

заданого виду) (2e) можна вибрати один з 

наступних видів для тривимірного 

представлення структур тіла пацієнта: 

 
- Front (Спереду) 

- Back (Ззаду) 

- Left (Зліва) 

- Right (Праворуч) 

- Top (Зверху) 

- Bottom (Знизу) 
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Поворот представлення 

 
В 3D-вигляді можна повертати структуру тіла 

пацієнта, що відображається. 

 
• Переміщайте мишу при натиснутій лівій 

кнопці. 

 

➔ Структура тіла пацієнта буде 

повертатися відповідно. 

• Для відновлення стандартних налаштувань 

знову виберіть вигляд, використовуючи поле 

переліку Set defined view (Установка заданого 

виду). 

 
 

Збільшення і зменшення представлення 

 
В 3D-вигляді можна збільшити або зменшити 

структуру тіла пацієнта, що відображається. 

 
• Переміщайте мишу при натиснутій правій 

кнопці. 

 

➔ Структури тіла пацієнта будуть 

збільшуватися або зменшуватися: 

• Для відновлення стандартних налаштувань 

знову виберіть вигляд, використовуючи поле 

переліку Set defined view (Установка заданого 

виду). 

Зміна кольорів і непрозорості 

 
За допомогою функції візуалізації - кнопка 

Rendering (Візуалізація) можна змінити 

кольори структур тіла пацієнта і їх 

непрозорість. 

 

 
Скорочення області відображення 

 
За допомогою функції обрізання - кнопка 

Cropping (Обрізка), можна скоротити область 

за напрямками трьох осей. 

 

 

17.4.8. Зміна представлення в 

DRR-вигляді 

 
За допомогою повзунка в панелі DRR Tissue 

Threshold (Поріг для тканин в DRR-вигляді) 

(2e), можна вказати м'які тканини (-) або тверді 

тканини (+) в DRR-вигляді. 



 

18. Гістограми об'ємного набору доз (опція) 
 

 

Для програми VeriSoft доступна функція DVH 

4D (опція). Цю функцію необхідно ліцензувати. 

Функція DVH 4D дозволяє розраховувати 

гістограми об'ємного набору доз (DHV) на 

основі даних вимірювань OCTAVIUS 4D і 

порівнювати їх з кривими DVH з даних системи 

планування променевої терапії TPS. 

 
18.1. Структура вікна 

гістограми об'ємного 

набору доз (DVH) 

• У вікні порівняння відкрийте вкладку DVH. 

 
➔ На екрані з'явиться вікно DVH: 

 

 

 
 

Малюнок 75. Вікно DVH з кривими DVH 
 
 

1 Спливаюче вікно DVH містить: 

a Панель інструментів 

b Перелік доступних структур 

c Підказка з інформацією про обрану 

структуру 

 
2 Кнопка для відновлення графічного 

вікна до вихідного розміру 

3 Графічне вікно містить: 

a Позначення 

b Представлення кривих DVH 

c Перехрещення 

d Підказка з інформацією про 

наступну доступну точку дози для 

обраної структури 

4 Рядок стану 

 

1a 

 
1b 

3a 

1c 

3b 

3c 

3d 
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18.1.1. Пояснення щодо кожної 

піктограми на панелі 

інструментів 

Імпорт даних TPS з каталогу 

DICOM або з мережевого 

сервера DICOM 

Закриття набору даних DVH 

 

 
Розрахунок DVH-кривих PTW 

 
 

Друк DVH-кривих 

 

 
Експорт DVH-кривих 

 
 
 

 
18.1.2. Інформація про структури 

 
При наведенні покажчика миші на структуру у 

спливаючому вікні DVH з'являється підказка з 

наступною інформацією: 

 
- Назва обраної структури 

 
- Об'єм обраної структури 

 
-  Мінімальна, максимальна і середня дози 

відповідної DVH-кривої TPS 

 
-  Мінімальна, максимальна і середня дози 

відповідної DVH-кривої PTW 

18.2. Розрахунок DVH-кривих 

PTW 

 

Якщо в якості референтної матриці 

завантажено наступні типи даних вимірювань 

OCTAVIUS 4D, розрахунок DVH-кривих PTW 

неможливий. При цьому буде виведено 

відповідне повідомлення про помилку. 

-  вимірювання для некомпланарного 

опромінення 

- вимірювання для опромінення при 

розташуванні поворотного блоку не в 

ізоцентрі 

- складені вимірювання 
 

 

• У вікно матриці A або B завантажте 

вимірювання OCTAVIUS 4D згідно з 

інструкціями розд. 8.7 "Завантаження 

вимірювань OCTAVIUS 4D і розрахунок 

об'ємного набору доз OCTAVIUS 4D". 

 
• Для імпорту відповідних даних TPS 

з каталогу DICOM або з мережевого 

сервера DICOM клацніть на 

відповідній кнопці. 

 

Імпортовані дані повинні включати наступні 

файли. Без них неможливо розрахувати 

DVH-криві. 

- Файл RTStruct, RTDose і RTPlan для плану 

лікування пацієнта 

- КТ пацієнта 
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• Для імпорту потрібного набору даних дійте, 

як описано в розд. 9 "Імпорт матриць в 

форматі DICOM". 

Крім того, дотримуйтесь налаштувань, 

необхідних для імпорту з мережевого сервера 

DICOM, згідно з розд. 23.3.5 "Налаштування 

для імпорту даних DICOM". 

 
➔ Дані TPS будуть завантажені, а доступні 

структури будуть відображені в панелі 

ROI (Області інтересу). 

Програма VeriSoft перевірить, для яких 

структур можна розрахувати DVH-криві 

PTW. Розрахунок можливий тільки для 

структур всередині об'єму фантома, 

оскільки виміряні значення доступні 

тільки для цих структур. Всі інші 

структури, що знаходяться поза об'ємом 

фантома, недоступні. 

 
 

При завантаженні вимірювання, отриманого 

не за допомогою OCTAVIUS 4D, будуть 

недоступні всі структури. 
 

 
 

• DVH-криві PTW для розрахунку 

вибираються установкою прапорців для 

відповідних структур. 

Всі DVH-криві PTW, які можуть бути 

розраховані, вибираються за допомогою 

пункту контекстного меню Select All (Вибрати 

все). 

Для скасування вибору всіх DVH-кривих PTW, 

які можуть бути розраховані, виберіть пункт 

контекстного меню Unselect All (Скасувати 

вибір всіх). 

 
➔ DVH-криві TPS будуть розраховані на 

основі існуючої інформації КТ для 

пацієнта та інформації по дозам в файлі 

RTDose і будуть представлені 

суцільними лініями. 

 

• Для розрахунку DVH-кривих PTW 

за даними вимірювання OCTAVIUS 

4D клацніть на відповідній кнопці. 

 

➔ Будуть розраховані DVH-криві PTW. 

Моделі столу не беруться до уваги в цих 

розрахунках. 

DVH-криві PTW будуть розраховані 

тільки на основі значень, виміряних в 

фантомі, з урахуванням даних КТ 

пацієнта. Перевизначення щільності в 

КТ-сканах пацієнта, зареєстрованих в 

об'єкті RTStruct під час планування 

променевої терапії, не розглядати- 

меться. Додаткові відомості про 

алгоритм див. в інформаційному 

документі PTW D913.200.00 

(Реконструкція доз для фантома 

OCTAVIUS 4D і для пацієнта без 

використання даних по дозам з TPS). 

 
➔ Розрахункові DVH-криві PTW будуть 

представлені штриховими лініями. 

 
➔ Розрахункові DVH-криві PTW будуть 

автоматично збережені в каталог, 

встановлений в меню Tools → Options 

(Сервіс - Параметри) на вкладці DVH в 

полі Data Path (Шлях до даних). 

• При необхідності збільшіть вікно 

DVH до розміру вікна програми, 

натиснувши кнопку Maximize 

(Розгорнути). 
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18.3. Відображення 

розрахункових DVH-кривих 

PTW 

• Для імпорту відповідних даних TPS 

з каталогу DICOM або з мережевого 

сервера DICOM клацніть на 

відповідній кнопці. 

 
• Для імпорту потрібного набору даних дійте, 

як описано в розд. 9 "Імпорт матриць в 

форматі DICOM". 

Крім того, дотримуйтесь налаштувань, 

необхідних для імпорту з мережевого сервера 

DICOM, згідно з розд. 23.3.5 "Налаштування 

для імпорту даних DICOM". 

 

 
➔ Дані TPS будуть завантажені, а доступні 

структури відображені в панелі ROIs 

(Області інтересу). 

Якщо для цього набору даних DVH-криві 

PTW вже розраховані і збережені, вони 

також будуть завантажені автоматично. 

 
• Для відображення потрібних DVH-кривих 

встановіть прапорці для відповідних структур. 

Щоб відобразити всі доступні DVH-криві, 

виберіть пункт контекстного меню Select All 

(Вибрати все). 

Щоб приховати DVH-криві, які 

відображаються, виберіть пункт контекстного 

меню Unselect All (Скасувати вибір всіх). 

 

➔ DVH-криві TPS будуть розраховані на 

основі існуючої інформації КТ для 

пацієнта та інформації по дозам в файлі 

RTDose і будуть представлені 

суцільними лініями. 

➔ Розрахункові DVH-криві PTW будуть 

представлені штриховими лініями. 

• При необхідності збільшіть вікно 

DVH до розміру вікна програми, 

натиснувши кнопку Maximize 

(Розгорнути). 

 
 

18.4. Параметри в 

графічній області вікна 

DVH 

• Для визначення одиниць вимірювання дози 

виберіть пункт контекстного меню Dose Unit 

(Одиниці дози) і задайте потрібну одиницю Gy 

(Гр) або cGy (сГр). 

 
• Щоб показати або приховати позначення 

або змістити їх, виберіть відповідний пункт 

контекстного меню: 

 
- Legend → Show/Hide (Позначення - Показати 

/ Приховати): 

Позначення будуть показані або приховані. 

 
-  Legend → Upper Right (Позначення - Вгорі 

праворуч): 

Позначення будуть показані у верхньому 

правому куті. 

 
-  Legend → Bottom Left (Позначення - Внизу 

зліва): 

Позначення будуть показані в нижньому 

лівому куті. 



 
 
 
 
 

 

• Для зміни кольору фону виберіть пункт 

контекстного меню DVH Background Color 

(Колір фону DVH). 

 
• Для відновлення заводських налаштувань 

виберіть пункт контекстного меню Default (За 

замовчуванням). 

 
• Використовуючи пункт контекстного меню 

Copy (Копіювати), можна скопіювати DVH- 

криві, що відображаються, в буфер обміну. З 

буфера обміну можна вставити їх в інші 

програми. 

 
• Використовуючи пункт контекстного меню 

Save As (Зберегти як), можна зберегти DVH- 

криві, що відображаються, у вигляді 

графічного файлу. Доступні формати файлів: 

*.png, *.jpg, *.tif і *.bmp. 

 
• Вибір пункту контекстного меню Show 

Cursor (Показати курсор), дозволяє 

відображати перехрещення і спливаючі 

підказки. При натисканні на DVH-кривої 

відображається підказка з наступною 

інформацією: 

- Назва відповідної структури 

 
-  Доза в точці поруч з позицією курсора і 

відповідний об'єм DVH-кривої PTW 

 
-  Доза в точці поруч з позицією курсора і 

відповідний об'єм DVH-кривої TPS 

18.5. Друк DVH-кривих 

 
• Для друку DVH-кривих, що 

відображаються, клацніть на 

відповідній кнопці. 

 

➔ Спочатку з'явиться діалогове вікно Print 

(Друк). 
 

Малюнок 76. Діалогове вікно друку 

 
• Введіть адміністративні дані для друку або 

попереднього перегляду. 

 
Ідентифікатор пацієнта та прізвище пацієнта 

будуть виведені автоматично, якщо вони 

доступні в наборі даних TPS. 
 

ПРИМІТКА 
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• Встановіть прапорці для параметрів друку 

або перегляду. 

 
- Data origin (Вихідні дані): 

імена файлів і шляхи до завантажених даних 

вимірювання OCTAVIUS 4D і даних TPS 

 
-  Custom logo (Призначений для користувача 

логотип): 

Якщо хочете вставити спеціальний логотип, 

клацніть на кнопці Select (Вибрати). 

 
- Confirmation (Підтвердження): 

В кінці сторінки буде доданий рядок підпису. 

 
• У полі переліку виберіть формат виведення 

для попереднього перегляду. 

 
• Щоб задати формат сторінки, клацніть на 

кнопці Page Settings (налаштування сторінки). 

 
• Для додаткового збереження попереднього 

перегляду або роздруківки, встановіть 

прапорець Copy output to folder (Копіювати 

висновок в папку). Натисніть кнопку ... і 

виберіть потрібну папку. 

 
• Для попереднього перегляду клацніть на 

кнопці Preview. 

 
Додаткову інформацію див. в розд. 21 "Друк 

матриць і результатів". 

 
18.6. Експорт розрахункових 

DVH-кривих PTW 

 
Розрахункові DVH-криві PTW автоматично 

зберігаються в каталозі, встановленому в 

меню Tools → Options (Сервіс - Параметри) на 

вкладці DVH в полі Data Path (Шлях до даних). 

 
Крім того, можна експортувати розрахункові 

DVH-криві PTW в форматі DICOM в будь-який 

каталог. 

 
• Для цього клацніть на відповідній 

кнопці. 

 
➔ У стандартному діалоговому вікні Save 

(Зберегти) введіть ім'я файлу і каталог. 

 
➔ DVH-криві PTW будуть експортовані. 

 
 

18.7. Закриття набору 

даних DVH 

• Для закриття набору даних DVH, 

відображуваного в даний момент, 

клацніть на відповідній кнопці. 

 

➔ Перелік доступних структур буде 

видалений з області вікна ROIs (Області 

даних). 



 
 

 

19. Типовий порядок дій 
 
 

 

19.1. Порядок дій з 

матричним детектором 

 
(Без використання приналежностей) 

 
В цьому розділі описано типовий порядок дій з 

матричним детектором в режимі сканування 

Step & Shoot (Зсув і зйомка). Порядок дій в 

складеному режимі Composite (кілька 

накладених полів IMRT) або при вимірюванні 

IMAT (TomoTherapy, VMAT, RapidArc) 

ідентичний. 

Однак в цих випадках буде завантажена тільки 

одна матриця доз і порівняна з вимірюванням. 

 
1. Помістіть матричний детектор на зворотньо 

розсіюючий матеріал товщиною по меншій мірі 

3 см і вирівняйте його на столі пацієнта 

відносно положення лазерів при відстані 

джерело-поверхня (SSD) 99,25 см (ефективна 

точка вимірювання матричного детектора 

знаходиться на глибині 7,5 мм). 

Дотримуйтесь орієнтації мішень / джерело, 

зазначеної  для матричного  детектора. 

Додайте акрилові пластини 4,5 см в якості 

матеріалу потовщення (докладніше див. в 

Інструкції з  використання матричного 

детектора). 

 
2. Завантажте весь план променевої терапії 

пацієнта, експортований з TPS в програму 

VeriSoft (меню File → Data Set A → Open List 

(Файл - Набір даних A - Відкрити перелік)). 

Файли повинні знаходитися в правильному 

порядку в одній папці. 

 
3. Почніть перше вимірювання, клацнувши на 

відповідній кнопці для матриці B або 

вибравши меню File → Data Set B → Measure 

(Файл - Набір даних B - Виміряти). 

➔ На екрані з'явиться діалогове вікно 

Measurement Parameters (Параметри 

вимірювань). 

• Введіть фактичні значення температури і 

тиску повітря, а також поправочний коефіцієнт 

kUser і поправочний коефіцієнт kEnergy для якості 

випромінювання або виконайте перехресне 

калібрування (див. розд. 10.9 "Перехресне 

калібрування "). 

 
• Натисніть кнопку OK. 

➔ Буде розпочато вимірювання. 

• Виконайте опромінення першого поля при 

положенні гентрі 0°. 

 
• Коли все поле буде опромінено, припиніть 

вимірювання, натиснувши кнопку Stop 

(Зупинка) або вибравши меню Measurement→ 

Stop (Вимірювання - Зупинка). 

 
• Прийміть виміряні дані, натиснувши кнопку 

Accept (Прийняти). Виміряні дані будуть 

збережені автоматично, якщо встановлено 

прапорець Save measurements automatically in 

folder (Автоматично зберігати вимірювання в 

папку) в діалоговому вікні Measurement 

Parameters (Параметри вимірювання). 
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4. Оцініть дані у вікні порівняння програми 

VeriSoft. 

 
5. За допомогою функції прокрутки виберіть 

наступне поле на вкладці Slice (Зріз) матриці 

A. Почніть наступне вимірювання, клацнувши 

на відповідній кнопці або вибравши меню File 

→ Data Set B → Measure (Файл - Набір даних 

B - Виміряти). Виконайте опромінення другого 

поля. 

 
6. Опромінюйте і перевіряйте поле за полем, 

згідно з процедурою, описаною вище. 

 
7. Для оцінки всього плану відкрийте планові 

дані через меню File → Data Set A → Open List 

(Файл - Набір даних A - Відкрити перелік) і 

виміряні дані через меню File → Data Set B → 

Open List (Файл - Набір даних B - Відкрити 

перелік). Виберіть функцію Synchronous Data 

Set Scrolling (Синхронна прокрутка наборів 

даних) в меню Tools (Сервіс). Таким чином, 

при прокручуванні в обох вікнах будуть 

відображені відповідні матриці для 

порівняння. 

19.2. Порядок дій з OCTAVIUS 

4D 

 
В цьому розділі описано типовий порядок дій з 

системою OCTAVIUS 4D. Система OCTAVIUS 

4D може використовуватися для вимірювань 

IMRT - Step & Shoot or Sliding Window (Вікна 

зсуву і зйомки або зсуву), в режимі Composite 

(Складений) - кілька накладених полів IMRT, 

або IMAT (RapidArc, VMAT). 

 
У випадку системи OCTAVIUS 4D матричний 

детектор буде вставлений в поворотний блок і 

буде повертатися синхронно з кутом гентрі, 

завжди забезпечуючи перпендикулярний 

напрямок випромінювання відносно 

матричного детектора. У цьому вимірюванні 

для кожного інтервалу вимірювання 

зберігаються кут гентрі і значення доз для всіх 

вимірювальних камер матричного детектора. 

За допомогою кривих глибини дози в 

залежності від розміру поля програма VeriSoft 

розрахує розподіл доз для кожного інтервалу 

вимірювань. При цьому будуть додані 

розподіли доз всіх інтервалів вимірювання. 

 
Для аналізу потрібно також експортувати 

об'ємний набір доз з системи планування 

променевої терапії (TPS). 

 
В програмі VeriSoft можна порівняти розподіл 

доз в будь-якій площині або в усьому об'ємі. 

 

 

Компанія PTW завжди рекомендує 

експортувати об'єкти RTDose і RTPlan з 

системи TPS, щоб гарантувати правильне 

узгодження файлів. Якщо файли не узгоджені 

(зміщення або неправильний вибір зрізів), 

можна використовувати об'єкт RTPlan для 

корекції. 
 

ПРИМІТКА 



 
 
 
 

 

1. Встановіть систему OCTAVIUS 4D і введіть 

в дію. Додаткову інформацію див. в Інструкції 

користувача «Швидкий пуск системи 

OCTAVIUS 4D». Додаткову інформацію див. в 

інструкціях користувача компонентів системи 

OCTAVIUS 4D. 

 
2. Перевірте налаштування для 4D-дозиметрії 

в меню Tools → Options (Сервіс - Параметри) 

на вкладці 4D Dosimetry (4D-дозиметрія) (див. 

розд. 23.3.6 "Налаштування для 4D- 

дозиметрії"). 

Налаштований розмір воксела повинен 

відповідати розміру воксела системи TPS. Чим 

менший розмір воксела, тим більше часу 

займає калібрування, але точність при цьому 

не збільшується. 

 
3. В TPS перенесіть план терапії пацієнта в 

фантом поворотного блоку. Для цього 

потрібно обов'язково використовувати 

наявний КТ-скан. 

 
4. Експортуйте об'єкти RTDose і RTPlan з 

вашої системи TPS. 

 
5. Завантажте ці дані TPS в програму VeriSoft 

через меню File → Data Set A → Open (Файл - 

Набір даних A - Відкрити). 

6. Почніть вимірювання, клацнувши на 

відповідній кнопці для матриці B або 

вибравши меню File → Data Set B → Measure 

(Файл - Набір даних B - Виміряти). 

➔ На екрані з'явиться діалогове вікно 

Measurement Parameters (Параметри 

вимірювань). 

• Введіть фактичні значення температури і 

тиску повітря, а також поправочний коефіцієнт 

kUser і поправочний коефіцієнт kEnergy для якості 

випромінювання або виконайте перехресне 

калібрування (див. розд. 10.9 "Перехресне 

калібрування "). 

 
• Натисніть кнопку OK. 

➔ Буде розпочато вимірювання. 

• Передайте весь план в поворотний блок. 

 
• Припиніть вимірювання, натиснувши 

кнопку Stop (Зупинка) або вибравши меню 

Measurement→ Stop (Вимірювання - Зупинка). 

 
• Прийміть виміряні дані, натиснувши кнопку 

Accept (Прийняти). 

 
• Виберіть відповідний файл PDD. Для 

досягнення максимальної точності ви повинні 

працювати з файлами PDD вашого джерела 

випромінювання. Включені файли PDD 

наводяться тільки в якості прикладів. 

➔ Буде розраховано об'ємний набір доз і 

відображено зріз на глибині 0 мм. 

 
7. Оцініть дані у вікні порівняння програми 

VeriSoft. 
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8. Інші зрізи об'ємного набору доз можна 

відобразити за допомогою повзунка на вкладці 

Slice (Зріз). Щоб відобразити відповідні 

матриці в обох вікнах матриць для порівняння, 

виберіть функцію Synchronous Data Set 

Scrolling (Синхронна прокрутка наборів даних) 

в меню Tools (Сервіс). 

 
9. Замість виконання вимірювання можна 

завантажити дані, виміряні раніше, через 

меню File → Data Set B → Open (Файл - Набір 

даних B - Відкрити). 

 
 

 
Щоб перевірити файл PDD і вирівняти 

поворотний блок, компанія PTW рекомендує 

відкрите поле 10 x 10 см для поворотного 

блоку і порівняння виміряного об'ємного 

набору доз із запланованим. 

 
➔ У вікні результатів можна перевірити 

файл PDD в поперечній проекції. 

 
➔ У вікні результатів можна перевірити 

вирівнювання поворотного блоку у 

фронтальній проекції. 

 
Зауваження по процедурам 

некомпланарного опромінення 

 
• У меню Tools → Options (Сервіс - 

Параметри) на вкладці 4D Dosimetry (4D- 

дозиметрія) виберіть параметр Non coplanar 

4D Dosimetry (некомпланарна 4D-дозиметрія). 

 
• У TPS обчисліть план для фантома, що 

використовується для некомпланарного 

опромінення. 

 
• Виконайте вимірювання OCTAVIUS 4D з 

компланарним опроміненням. 

 
• У діалоговому вікні Select an angle range 

(Вибір діапазону кутів) виберіть кут повороту в 

полі переліку або введіть потрібний кут 

повороту. 

 

➔ На основі даних компланарного 

вимірювання і кута повороту для столу 

пацієнта програма VeriSoft вирахує 

об'ємний набір доз для 

некомпланарного опромінення. 



 
 
 

 

19.3. Порядок дій з 

матричним детектором і 

планарним поворотним 

блоком 

 
В цьому розділі описано типовий порядок дій з 

матричним детектором і планарним 

поворотним блоком. Система OCTAVIUS 4D 

може використовуватися для вимірювань 

IMRT - Step & Shoot or Sliding Window (Вікна 

зсуву і зйомки або зсуву), в режимі Composite 

(Складений) - кілька накладених полів IMRT, 

або IMAT (RapidArc, VMAT). 

 
Для цього вимірювання матричний детектор 

буде вставлений в планарний поворотний 

блок і буде повертатися синхронно з кутом 

гентрі, завжди забезпечуючи перпендикуляр- 

ний напрямок випромінювання відносно 

матричного детектора. Для кожного інтервалу 

вимірювання зберігаються кут гентрі і 

значення доз для всіх вимірювальних камер 

матричного детектора. Програма VeriSoft 

підсумовує значення доз кожної 

вимірювальної камери. 

 
Для аналізу потрібно також експортувати 

відповідний план з системи планування 

променевої терапії (TPS). 

 
1. Встановіть систему OCTAVIUS 4D і введіть 

в дію. Додаткову інформацію див. в Інструкції 

користувача «Швидкий пуск системи 

OCTAVIUS 4D». Додаткову інформацію див. в 

інструкціях користувача компонентів системи 

OCTAVIUS 4D. 

 
2. Завантажте весь план терапії пацієнта, 

експортований з системи TPS в програму 

VeriSoft, через меню File → Data Set A → Open 

(Файл - Набір даних A - Відкрити). 

3. Почніть вимірювання, клацнувши на 

відповідній кнопці для матриці B або 

вибравши меню File → Data Set B → Measure 

(Файл - Набір даних B - Виміряти). 

 
➔ На екрані з'явиться діалогове вікно 

Measurement Parameters (Параметри 

вимірювань). 

• Введіть фактичні значення температури і 

тиску повітря, а також поправочний коефіцієнт 

kUser і поправочний коефіцієнт kEnergy для якості 

випромінювання або виконайте перехресне 

калібрування (див. розд. 10.9 "Перехресне 

калібрування"). 

 
• Натисніть кнопку OK. 

➔ Буде розпочато вимірювання. 

• Передайте завершений план. 

 
• Припиніть вимірювання, натиснувши 

кнопку Stop (Зупинка) або вибравши меню 

Measurement→ Stop (Вимірювання - Зупинка). 

 
• Прийміть виміряні дані, натиснувши кнопку 

Accept (Прийняти). Виміряні дані будуть 

збережені автоматично, якщо встановлено 

прапорець Save measurements automatically in 

folder (Автоматично зберігати вимірювання в 

папку) в діалоговому вікні Measurement 

Parameters (Параметри вимірювання). 

 
4. Оцініть дані у вікні порівняння програми 

VeriSoft. 

 
5. Замість виконання вимірювання можна 

завантажити дані, виміряні раніше, через 

меню File → Data Set B → Open (Файл - Набір 

даних B - Відкрити). 
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19.4. Порядок дій з 

матричним детектором та 

інклінометром 

 
У цьому розділі описано типовий порядок дій з 

матричним детектором та інклінометром. 

Вимірювальна система може використову- 

ватися для вимірювань IMRT - Step & Shoot or 

Sliding Window (Вікна зсуву зйомки або зсуву), 

в режимі Composite (Складений) - кілька 

накладених полів IMRT, або IMAT (RapidArc, 

VMAT). 

 
У випадку вимірювання з матричним 

детектором та інклінометром матричний 

детектор вставляється в фантом OCTAVIUS. 

Для кожного інтервалу вимірювання 

зберігаються кут гентрі і значення доз для всіх 

вимірювальних камер матричного детектора. 

Програма VeriSoft підсумовує значення доз 

кожної вимірювальної камери. 

 
Для аналізу потрібно також експортувати 

відповідний план з системи планування 

променевої терапії (TPS). 

 
1. Встановіть фантом OCTAVIUS з матричним 

детектором і введіть пристрої в дію. 

Детальніше див. в інструкціях з використання 

фантома OCTAVIUS і матричного детектора. 

 
2. Встановіть інклінометр і введіть його в дію. 

Детальніше див. в Інструкції з використання 

інклінометра. 

 
3. Завантажте весь план терапії пацієнта, 

експортований з системи TPS в програму 

VeriSoft, через меню File → Data Set A → Open 

(Файл - Набір даних A - Відкрити). 

 

4. Почніть вимірювання, клацнувши на 

відповідній кнопці для матриці B або вибравши 

меню File → Data Set B → Measure (Файл - 

Набір даних B - Виміряти). 

➔ На екрані з'явиться діалогове вікно 

Measurement Parameters (Параметри 

вимірювань). 

• Введіть фактичні значення температури і 

тиску повітря, а також поправочний коефіцієнт 

kUser і поправочний коефіцієнт kEnergy для якості 

випромінювання або виконайте перехресне 

калібрування (див. розд. 10.9 "Перехресне 

калібрування"). 

 
• Натисніть кнопку OK. 

 
➔ Буде розпочато вимірювання. 

• Передайте завершений план. 

 
• Припиніть вимірювання, натиснувши кнопку 

Stop (Зупинка) або вибравши меню 

Measurement→ Stop (Вимірювання - Зупинка). 

 
• Прийміть виміряні дані, натиснувши кнопку 

Accept (Прийняти). Виміряні дані будуть 

збережені автоматично, якщо встановлено 

прапорець Save measurements automatically in 

folder (Автоматично зберігати вимірювання в 

папку) в діалоговому вікні Measurement 

Parameters (Параметри вимірювання). 

 
5. Оцініть дані у вікні порівняння програми 

VeriSoft. 

 
6. Замість проведення вимірювання можна 

завантажити дані, виміряні раніше, через 

меню File → Data Set B → Open (Файл - Набір 

даних B - Відкрити). 



 
 

20. Робота з об'ємними наборами доз і переліками 
матриць 

 
 

 

20.1. Завантаження і 

відображення об'ємних 

наборів доз і переліків 

матриць 

 
• Для завантаження об'ємного набору доз 

клацніть на відповідній кнопці або виберіть 

меню Edit → Data Set A / B → Open (Файл - 

Набір даних A / B - Відкрити). 

➔ Після завантаження об'ємного набору 

доз у вікні матриці буде відображено зріз 

на глибині 0 мм. 

 

• Для завантаження переліку матриць 

виберіть меню File → Data Set A / B → Open 

List (Файл - Набір даних A / B - Відкрити 

перелік). 

➔ Після завантаження в вікні матриці буде 

відображена перша матриця переліку. 

 

 
Додаткову інформацію щодо завантаження 

матриць див. в розд. 8 "Завантаження 

матриць". 

 
20.2. Прокрутка в об'ємному 

наборі доз або переліках 

матриць 

 
При наведенні покажчика миші на вкладку 

Slice (Зріз) на лівій стороні матриці виводиться 

спливаюче вікно з повзунком. За допомогою 

повзунка можна переміщатися по зрізах 

об'ємного набору доз або за переліком 

матриць. 

По матриці A можна також переміщатися за 

допомогою клавіш PageUp і PageDown, а по 

матриці B - з допомогою клавіші Shift і клавіш 

PageUp і PageDown. 

 
Показаний порядок матриць відповідає: 

 
-  збереженому вмісту у випадку об'ємного 

набору доз і 

-  послідовності файлів в переліку у випадку 

переліків матриць. 

 
Якщо завантажено два об'ємних набори доз 

або переліка матриць (для матриці A і матриці 

B), можна встановити синхронну прокрутку в 

меню Tools → Synchronous Data Set Scrolling 

(Сервіс - Синхронна прокрутка наборів даних). 

 
-  У випадку об'ємних наборів доз: при 

переміщенні повзунка в обох вікнах матриць 

будуть вибиратися і відображатися зрізи на 

однаковій або дуже близькій глибині 

(наскільки це можливо для завантажених 

даних). 
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- У випадку переліків матриць: при переміщенні 

повзунка в обох вікнах матриць будуть 

вибиратися і відображатися матриці з 

індексами (наскільки це можливо з 

урахуванням кількості завантажених файлів). 

 

-  У разі несинхронної прокрутки: буде 

прокручуватися тільки активне вікно. 

Відображення іншого вікна залишається 

незмінним. 

 

 

20.3. Обробка зображень в 

переліках матриць 

 

20.4. Обробка зображень в 

об'ємних наборах доз 

 
Якщо завантажено об'ємний набір доз, то 

функції обробки зображення будуть 

виконуватися одночасно на всіх зрізах. При 

прокручуванні зміни не губляться і їх можна 

зберегти в будь-який час. 

 

Якщо завантажено перелік матриць, то функції 

обробки зображення будуть виконуватися 

тільки на фактично відображеній матриці. 

 
 
 
 
 
 

 

Прокрутка оброблених переліків матриць без 

збереження. 

 
Втрата даних! 

 
Якщо ви змінюєте матрицю переліку за 

допомогою функцій обробки зображень, 

необхідно відразу зберегти ці зміни. При 

прокручуванні переліку оброблених матриць 

попередження про необхідність збереження 

змін не виводиться. Виконані зміни будуть 

втрачені. 
 

 
Програма VeriSoft збереже тільки зріз 

об'ємного набору доз, що відображається, а 

не весь набір. 

Програма VeriSoft зберігає дані об'ємних 

наборів доз TPS у вигляді файлів TIFF, дані 

матриць OCTAVIUS 4D у вигляді mcc-файлів 

PTW. 

 

 
20.5. Збереження об'ємних 

наборів доз і переліків 

матриць 

• Для збереження об'ємних наборів доз або 

переліків матриць клацніть на відповідній 

кнопці або виберіть меню File → Data Set A / B 

→ Save As (Файл - Набір даних A / B - Зберегти 

як). 

 

У випадку об'ємних наборів доз або переліків 

матриць буде збережений тільки зріз 

об'ємного набору доз або матриця переліку, 

що відображається в даний час. 
 

 
Крім того, об'ємні набори доз OCTAVIUS 4D 

можна зберегти у форматі DICOM. 

 
Додаткову інформацію про збереження див. в 

розд. 11 "Збереження і закриття матриць". 

ПРИМІТКА 



ПРИМІТКА 

 
 

 

21. Друк матриць і результатів 
 
 

 

• Для друку звітів виберіть меню File → Print 

(Файл - Друк). 

 
• Для попереднього перегляду матриць і 

результатів виберіть меню File → Print Preview 

(Файл - Попередній перегляд). 

 

➔ Спочатку з'явиться діалогове вікно Print 

(Друк). 
 

Малюнок 77. Діалогове вікно друку 
(наприклад, для попереднього 
перегляду) 

• Введіть адміністративні дані для друку або 

попереднього перегляду. 

 

Ідентифікатор пацієнта та прізвище пацієнта 

будуть виведені автоматично, якщо вони 

доступні в файлі. 
 

 

 
• Виберіть параметри для друку або 

попереднього перегляду, встановивши 

відповідні прапорці. 

 
- Data Origin (Вихідні дані): 

імена файлів і шляхи для завантажених 

матриць, а також виконаних змін 

 
- Images (Зображення): 

поточний вміст графічних вікон 

 
- Results (Результати): 

порівняння результатів і налаштувань 

 
- Additional Statistics (Додаткова статистика): 

результати додаткової статистики 

 
- Custom logo (Призначений для користувача 

логотип): 

Якщо потрібно, виберіть власний логотип, 

натиснувши кнопку Select (Вибрати). 

 
- Confirmation (Підтвердження): 

В кінці сторінки буде доданий рядок підпису. 
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• У полі переліку виберіть формат виведення 

для друку або попереднього перегляду. 

 

Якщо обрано формат виведення, для якого 

відсутня відповідна програма на комп'ютері 

(наприклад, формат виведення PDF при 

відсутності програми Adobe Reader на 

комп'ютері), попередній перегляд буде 

неможливий. 
 

 

• Щоб задати формат сторінки, клацніть на 

кнопці Page Settings (Налаштування сторінки). 

 
• Для додаткового збереження попереднього 

перегляду або роздруківки, встановіть 

прапорець Copy output to folder (Копіювати 

висновок в папку). Натисніть кнопку і 

виберіть потрібну папку. 
 

• Для друку даних клацніть на кнопці Print 

(Друк) або на кнопці Preview (Попередній 

перегляд), щоб переглянути. 

 

 

Друк автоматично виконується французькою 

мовою (French), якщо ви встановили 

французьку мову на панелі управління. 
 



 

22. Експорт в базу даних Track-it 
 
 
 

 

Для забезпечення можливості експорту даних 

в базу даних Track-it необхідно встановити 

наступні програми: 

- Track-it 

Додаткову інформацію див. в Інструкції 

користувача Track-it. 

- Клієнтський додаток Track-it Import Client 

Додаткову інформацію див. в розд. 3.2 

"Установка" і в інструкції з використання 

Track-it Import Client. 
 

 
• Використовуючи конфігурацію імпорту 

Track-it, налаштуйте параметри для експорту 

даних в базу даних Track-it. Додаткову 

інформацію див. в Інструкції користувача 

Track-it Import Client. 

 
• Щоб експортувати результати 

порівняння з вікна результатів в базу 

даних Track-it, клацніть на кнопці 

Export to Track-it (Експорт в Track-it) у 

вікні Results (Результати) (див. 

Розд.14.6 "Результат порівняння"). 

 
• Щоб експортувати результати 

порівняння розподілу доз в об'ємі в 

базу даних Track-it, клацніть на кнопці 

Export to Track-it (Експорт в Track-it) в 

діалоговому вікні Volume Analysis 

(Аналіз об'єму) (див. Розд. 15.6 

"Порівняння розподілів доз в об'ємі"). 

Система може запропонувати користувачеві 

спочатку ввійти, використовуючи дані імені 

користувача і пароля для Track-it. Додаткову 

інформацію щодо процедури входу див. в 

інструкції з використання Track-it. 
 

 

➔ Дані будуть експортовані в базу даних 

Track-it, і система виведе відповідне 

повідомлення. 

 
➔ Крім даних в базу даних Track-it також 

можуть бути експортовані такі графічні 

об'єкти: 

-  матриця, яка відображається в даний 

момент у вікні матриці A (наприклад, 

поточний встановлений зріз об'ємного 

набору доз системи TPS) 

-  матриця, яка відображається в даний 

момент у вікні матриці B (наприклад, 

поточний встановлений зріз об'ємного 

набору доз OCTAVIUS 4D) 

-  поточне графічне представлення 

результатів порівняння у вікні порівняння 

-  гістограма порівняння розподілів доз в 

об'ємі (тільки при експорті через 

діалогове вікно Volume Analysis (Аналіз 

об'єму) 

 
➔ При експорті з діалогового вікна Volume 

Analysis (Аналіз об'єму) таблиця з 

результатами порівняння розподілів доз 

в об'ємі буде збережена у файлі 

формату CSV. 

Файл CSV можна відкрити з програми 

для роботи з електронними таблицями. 

 
➔ Крім того, для кожного експорту в базі 

даних Track-it буде автоматично 

створюватися проект VeriSoft. Див. 

також інформацію в розд.16 "Проекти 

VeriSoft ". 

ПРИМІТКА ПРИМІТКА 
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23. Налаштування програми VeriSoft 

 
23.1. Зміна кольорів і 

рівнів ізодоз 

 
При виборі меню Graphics → Edit Contour 

Settings (Графіка - Зміна налаштувань контуру) 

відкриється діалогове вікно Graphic Colors and 

Isodose Levels (Кольори графіки і рівні ізодоз). 

 

 

1 Вкладки налаштування для 

матриці A і матриці B 

 
2 Встановіть прапорець, щоб 

вибрати рівень ізодози або 

скасувати його вибір 

 
3 Кнопка вибору кольору ізодози в 

стандартному діалоговому вікні 

Windows для вибору кольору 

 
4 Рівень ізодози 

 
5 Кнопка відновлення стандартних 

налаштувань для кольорів ізодоз і 

рівнів ізодоз 

 
6 Кнопка для сортування рівнів 

ізодоз за спаданням 

 
7 Кнопка вибору кольору профілю в 

стандартному діалоговому вікні 

Windows для вибору кольору 

 
8 Кнопка вибору стилю лінії 

профілю 
 

Малюнок 78. Діалогове вікно «Кольори графіки і рівні 
ізодоз» 

9 Поле введення товщини лінії 

профілю 

    

  

7 8 9 

 



 
 
 
 

23.2. Налаштування 

вимірювань 

23.2.1. Вибір вимірювальних 

пристроїв 

 

При виборі меню Tools → Measurement Options 

(Сервіс - Налаштування вимірювань) 

відкриється діалогове вікно Measurement 

Options (Налаштування вимірювань). 

 
Діалогове вікно Measurement Options 

(Налаштування вимірювань) містить 2 або 3 

вкладки, призначення яких описано нижче: 

 
- Devices (Пристрої): 

вибір вимірювальних пристроїв і 

налаштувань для передачі даних 

 
- Measurement (Вимірювання): 

налаштування вимірювань 

 
- Advanced (Додатково): 

налаштування інклінометра 

 

 

Малюнок 79. Вкладка Devices (Пристрої) в 
діалоговому вікні налаштувань 
вимірювань 

 
На вкладці Devices (Пристрої) можна, 

налаштувати наступні параметри: 

 
Detector Array (Матричний детектор) 

Поле переліку для вибору матричного 

детектора для вимірювань 

 
Можна вибрати такі матричні детектори: 

- OCTAVIUS Detector 729 

- OCTAVIUS Detector 729XDR 

- OCTAVIUS Detector 1000SRS 

- OCTAVIUS Detector 1500 

- OCTAVIUS Detector 1500MR 

- OCTAVIUS Detector 1500XDR 

- 2D-ARRAYseven29 

- 2D-ARRAYXDR 

- Device Demo (Демонстраційний пристрій) 
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Якщо обрано демонстраційний матричний 

детектор (Device Demo), ніякої взаємодії з 

апаратними компонентами не буде. 

Вимірювання буде змодельовано програмою 

VeriSoft. 

 
Якщо використовується більше одного 

матричного детектора однакового типу, PTW 

рекомендує включити параметр Use multiple 

detectors of same type (Використовувати кілька 

детекторів одного типу). В цьому випадку при 

закритті діалогового вікна Measurement 

Options (Налаштування вимірювань) система 

запропонує перевірити відповідність обраного 

файлу калібрування використовуваному 

матричному детектору. 

 

 
Calibration File (Файл калібрування) 

 
Відображення файлу калібрування, встанов- 

леного для обраного матричного детектора 

 
Кнопка для вибору файлу 

калібрування. 

 
При установці VeriSoft файл калібрування 

(*.cal), що знаходиться на компакт-диску, 

копіюється в наступну папку (див. також розд. 

3.5 "Зберігання даних"): 

<PTW documents> \ Common Files \ Calibration 

Files 

 
Якщо ви виберете файл калібрування, в якому 

деактивовані вимірювальні камери, то буде 

виведено відповідне повідомлення. Для 

отримання додаткової інформації про 

деактивацію вимірювальних камер див. 

інструкцію з використання програми PTW 

ArrayCal. 

Приналежності 

Поле переліку для вибору приналежностей 

для вимірювань 

Можна вибрати такі приналежності: 

 
- Rotation Unit (Поворотний блок) 

Стандартна версія або модульна версія 

поворотного блоку в комбінації зі 

стандартним верхом для OCTAVIUS для 

виконання вимірювань OCTAVIUS 4D 

 
- Rotation Unit SRS (Поворотний блок SRS) 

Модульна версія поворотного блоку в 

комбінації з верхом для OCTAVIUS SRS для 

виконання вимірювань OCTAVIUS 4D з 

малим діаметром 

 
- Rotation Unit planar (Поворотний блок 

планарний) 

Модульна версія поворотного блоку в 

комбінації з верхом для OCTAVIUS Linac QA 

для вимірювальних матриць матричного 

детектора 

 
- Inclinometer (Інклінометр) 

 
- None (Без приналежностей) 

 
- Rotation Unit Demo (Демонстраційний 

поворотний блок) 

 
- Inclinometer Demo (Демонстраційний 

інклінометр) 

 
Якщо обрано демонстраційну приналежність 

(Demo), ніякої взаємодії з апаратними 

компонентами не буде. Вимірювання буде 

змодельовано програмою VeriSoft. 

... 
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Connections (З'єднання) 

Відображення поточних налаштувань для 

передачі даних 

 
Параметри передачі даних повинні 

встановлюватися окремо для обраного 

матричного детектора і для обраної 

приналежності. 

 
Почніть пошук, натиснувши кнопку Search 

(Пошук). Потім відкриється діалогове вікно 

Devices (Пристрої) з усіма підключеними 

пристроями. Як тільки ви виберете пристрій, 

відповідні параметри передачі даних 

автоматично введуть в відповідне поле в 

діалоговому вікні Measurement Options 

(Налаштування вимірювань). 

 
Ви можете відредагувати параметри вручну за 

допомогою кнопки Edit (Змінити). 

 
Додаткову інформацію з налаштування 

передачі даних див. в розд. 25 "Налаштування 

для передачі даних". 

 

 
Зменшення швидкості передачі даних 

через RS232 

 
Якщо обрано матричний детектор 

підключений через роз'єм RS232, то буде 

доступний вибір параметра Reduce RS232 

Baudrate (Зменшити швидкість передачі даних 

через RS232). 

 
У випадку проблем зі зв'язком, наприклад при 

використанні довгих кабелів, слід включити 

цей параметр. Додаткову інформацію див. в 

розд.26 "Повідомлення про помилки і 

усунення неполадок". 

23.2.2. Measurement Settings 

(Налаштування вимірювань) 

 
 

Малюнок 80. Вкладка Measurement 
(Вимірювання) в діалоговому 
вікні Measurement Options 
(Налаштування вимірювань) 

 
На вкладці Measurement (Вимірювання) можна 

налаштувати такі параметри в залежності від 

матричного детектора: 

 
Zeroing Time (Час обнулення) 

Тривалість процедури обнулення (в секундах) 

За замовчуванням: 40 с 

 

На відміну від версій VeriSoft <5.0, тепер 

потрібно задавати загальну тривалість 

процедури обнулення. 
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Zeroing Reminder (Графік обнулення) 

 
Період (в годинах), який визначає інтервали 

обнулення 

За замовчуванням: 8 годин. 

 

 
Dose Integration Time (Час інтегрування 

дози) 

 
Час вимірювання для інтегрованих 

вимірювань. Доза буде інтегруватися за цей 

період часу. 

 
Для вимірювань з поворотним блоком або 

інклінометром максимальний налаштовуваний 

час вимірювання обмежений з урахуванням 

очікуваного розміру файлу. Крім того, 

максимальний налаштовуваний час 

вимірювання залежить від встановленого 

інтервалу часу (див. таблицю нижче). 

 

 

інтервал час вимірювання 

100 мс (0 ... 600) с 

200 мс (0 ... 900) с 

400 мс (0 ... 1800) с 

800 мс (0 ... 3600) с 

 
Щоб гарантувати максимальну точність 

розрахункової дози в об'ємі випромінювання 

для вимірювань дози IMAT (з модуляцією 

інтенсивності випромінювання) або VMAT (з 

модуляцією об'єму випромінювання), PTW 

рекомендує час вимірювання ≤ 600 с і 

найкоротші інтервали. Якщо будуть обрані інші 

налаштування, система виведе відповідне 

повідомлення. Знявши відповідний прапорець, 

можна деактивувати повідомлення до 

перезавантаження програмного 

забезпечення. 

Interval Time (Інтервал) 

 
Після кожного інтервалу вимірювань 

встановлюється новий набір значень 

вимірювання (один для кожного каналу). 

За замовчуванням: 400 мс 

Допустимі значення: 100 мс, 200 мс, 400 мс і 

800 мс 

 
Максимальний налаштовуваний час вимірю- 

вання залежить від встановленого інтервалу 

часу (також див. розділ Час інтегрування 

дози). 

 

Залежно від обраного матричного детектора і 

налаштувань для передачі даних, деякі 

значення інтервалу можуть бути недоступні. 
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При малих значеннях потужності дози більш 

тривалі інтервали дають краще 

співвідношення сигнал / шум. З іншого боку, 

більш тривалі інтервали обмежують 

максимальну допустиму потужність дози. 
 

 

 
Trigger Measurement (Вимірювання по 

триггеру) 

(Це не відноситься до 2D-ARRAYseven29 і 2D- 

ARRAY XDR) 

 
Якщо цей параметр обрано, то вимірюванням 

буде управляти зовнішній сигнал тригера. 

 
Вимірювання по триггеру має сенс тільки у 

випадку дуже низьких частот повторення 

імпульсу (PRF). 

Як правило, вимірювання по триггеру 

застосовуються для інтерактивного предста- 

влення профілю при 6 Гц або 12 Гц. 



 
 
 

 

Corrections (Поправки) 

(Це не відноситься до детектора OCTAVIUS 

Detector 1000 SRS) 

 
Референтна температура для поправки до 

щільності повітря 

 

 
Scanned Beam (Скануюче опромінення) 

(Тільки для пристроїв XDR) 

 
Виберіть цей параметр при вимірюванні 

скануючого протонного і важкого іонізуючого 

випромінювання. 

 

 
Drift Suppression (Придушення дрейфу) 

(Тільки для пристроїв XDR) 

 
• Включення і відключення придушення 

дрейфу шляхом установки і зняття прапорця 

Drift Suppression (Придушення дрейфу). 

 
• Якщо включено придушення дрейфу, 

введіть поріг для кожного діапазону 

вимірювань, нижнього і верхнього. 

За замовчуванням: 

Low (Нижній): 30,0E-06 

High (Верхній): 300,0E-06 

 
Натискання кнопки Default (За 

замовчуванням) відновить налаштування 

порогів за замовчуванням. 

 
Для отримання додаткової інформації про 

придушення дрейфу та встановлення порогів 

див. розділ 23.2.3 "Drift Suppression 

(Придушення дрейфу)". 

23.2.3. Drift Suppression 

(Придушення дрейфу) 

(Тільки для пристроїв XDR) 

 
При вимірюванні скануючого протонного і 

важкого іонізуючого випромінювання 

потужність дози вимірюється в кожній окремій 

камері протягом короткого часу опромінення. 

Струм витоку, що існує в часі вимірювання, що 

залишився, буде накопичуватися і буде 

спотворювати значення вимірюваної дози. 

 
Щоб уникнути цього ефекту, можна включити 

придушення дрейфу на вкладці Measurement 

(Вимірювання) і ввести поріг для обох 

діапазонів вимірювання, нижнього і верхнього. 

При інтегруванні дози враховуватися будуть 

тільки значення, що перевищують ці пороги. 

Врахуйте наступні умови: 

 
- Поріг повинен вдвічі перевищувати 

максимальний шум, і він повинен бути 

перетворений з урахуванням налаштованого 

інтервалу (див. наступний приклад). 

 
-  Поріг повинен вводитися в одиницях: [Гр/ 

інтервал]. 

 
Приклад: 

максимальний шум = 80 мГр/ хв 

→ поріг = 160 мГр / хв 

інтервал = 400 мс 

Поріг на інтервал для введення на вкладці 

Measurement (Вимірювання) дорівнює: 
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23.2.4. Налаштування 

інклінометра 

 

Малюнок 81. Вкладка Advanced (Додатково) в 
діалоговому вікні налаштувань 
вимірювань 

 
Вкладка Advanced доступна, тільки якщо 

обрана приналежність Inclinometer (Інклі- 

нометр). 

На цій вкладці можна налаштувати наступні 

параметри: 

 
Gantry Upright Position (Положення гентрі по 

вертикалі) 

Виберіть положення гентрі по вертикалі: 

- 0° 

- 180° 

 
Gantry Rotation Direction (Напрямок 

обертання гентрі) 

Виберіть напрямок обертання гентрі: 

- Clockwise (За годинниковою стрілкою) 

- Counter-clockwise (Проти годинникової 

стрілки) 

Use angle correction table (Використати 

таблицю поправок кута) 

 
Якщо цей параметр обрано, можна 

застосувати поправку кута, використовуючи 

таблиці поправок. 

Для подальшої інформації по створенню 

таблиць для поправки кута див. Додаток C 

"Таблиці поправок для корекції кута в разі 

вимірювань інклінометром". 

... Кнопка для вибору таблиці поправок 

  

ПРИМІТКА 

Цей параметр зазвичай не потрібний для 

вимірювань з фантомом OCTAVIUS. 

 



 
 
 
 

 

23.3. Параметри VeriSoft 23.3.1. Параметри режиму 

порівняння 
При виборі меню Tools → Options (Сервіс - 

Параметри) відкриється діалогове вікно 

Options (Параметри). 

 
За замовчуванням в діалоговому вікні Options 

(Параметри) є 5 вкладок, призначення яких 

описано нижче: 

 
- Compare (Порівняння): 

параметри режиму порівняння 

 
- Data (Дані): 

параметри завантаження матриць 

 
- Advanced (Додатково): 

додаткові параметри 

 
- DICOM: 

налаштування для імпорту даних DICOM 

 
- 4D Dosimetry (4D-дозиметрія): 

налаштування для 4D-дозиметрії 

 
- Classes (Класи): 

визначення класів порівняння для 

статистичної оцінки в програмі PTW Track-it 

 
Якщо існує ліцензія для функції DVH 4D, буде 

відображатися також вкладка DVH з 

налаштуваннями функції DVH 4D. 

 
 

 
Малюнок 82. Вкладка Compare (Порівняння) в 

діалоговому вікні параметрів 

 

 
На вкладці Compare (Порівняння) можна 

налаштувати такі параметри: 

 

 
Налаштування порівняння 

 
В полі переліку Gamma Index calculation 

(Розрахунок гамма-індексу) можна активувати 

(значення за замовчуванням) або 

деактивувати додаткові розширені умови 

(другий і третій прохід) для розрахунку гамма- 

індексу, розробленого авторами Tom Depuydt 

та ін. (Radiotherapy and Oncology 62 (2002) 

309-319) [5]. PTW рекомендує 

використовувати цю можливість. 
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В полі переліку Definition of referenced max. dose 

for dose volumes (Визначення референтної 

максимальної дози для об'ємних наборів доз) 

можна задати референтну точку для порівняння 

об'ємів доз: максимальне значення для всього 

об'ємного набору доз (значення за 

замовчуванням) або максимальне значення для 

відображеного зрізу. Вкладка Compare 

(Порівняння) у вікні порівняння змінюється 

відповідно (див. Розд.15.2.1 "Методи Gamma 2D 

і Gamma 3D"). 

 

 
Налаштування результатів 

 
В панелі Result Settings (Налаштування 

результатів) можна налаштувати наступні 

параметри окремо для кожного режиму 

порівняння: 

 
-  У першому рядку задається максимальне 

значення порівняння, відповідне класифікації 

passed (в діапазоні допуску). 

- У другому і третьому рядках вводяться 

значення порогів для оцінки розрахункових 

значень порівняння. 

 
➔ Якщо виконується умова, введена в 

верхньому полі введення, то 

результат в полі Results (Результати) 

у вікні результатів буде позначений 

зеленою точкою. 

 
➔ Якщо виконується умова, введена в 

нижньому полі введення, то 

результат в полі Results (Результати) 

у вікні результатів буде позначений 

жовтою точкою. 

 
➔ Якщо жодна з умов не виконується, 

то результат в полі Results 

(Результати) у вікні результатів буде 

позначений червоною точкою. 

 

 

 

Для методу Gamma Index (Гамма-індекс) це 

значення фіксоване і не може бути змінене. 
 

ПРИМІТКА 



 
 
 

 

23.3.2. Параметри для 

завантаження матриць 

 

Малюнок 83. Вкладка Data (Дані) в 
діалоговому вікні параметрів 

 
На вкладці Data (Дані) можна налаштувати 

наступні параметри: 

 

 
Data Import (Імпорт даних) 

 
Якщо встановлено прапорець Convert Dose to 

(Перетворити дозу в), і обрано потрібну 

одиницю вимірювання в полі переліку, то 

програма VeriSoft при завантаженні 

перевірить можливість перетворення матриці 

в обрану одиницю вимірювання. 

 
Якщо перетворення можливе, VeriSoft 

автоматично виконає перетворення одиниць. 

Якщо перетворення неможливе, то матриця 

буде завантажена без перетворення. 

Якщо вибрано перетворення в cGy (сГр) або 

mGy (мГр), то значення доз для методу 

Gamma 2D або 3D, введені у вікно порівняння 

на вкладці Compare (Порівняння) (див. Розд. 

15.2.1 "Методи Gamma 2D і Gamma 3D"), 

також будуть перетворені в сГр або мГр. 

 
Якщо встановлено один з прапорців Activate 

data processing batch (Активувати пакет 

обробки даних), програма VeriSoft відкриє 

діалогове вікно для вибору і виконання 

пакетного файлу при завантаженні відповідної 

матриці (див. також розд. 13.9 "Робота в 

пакетному режимі"). 

 

 
2D-дані детектора OCTAVIUS Detector 

1500 

 
Для матриць, виміряних з детектором 

OCTAVIUS Detector 1500, дозвіл профілю 

складає 10 мм. 

 
Якщо знято прапорець Profiles and tables only 

contain measured values (Профілі і таблиці 

містять тільки виміряні значення) 

(налаштування за замовчуванням), то між 

виміряними значеннями будуть визначені 

додаткові інтерпольовані значення, щоб 

отримати дозвіл відображення 5 мм. 

Інтерпольовані значення будуть показані 

тільки в таблиці значень доз у вікні матриці, в 

профілях у вікні результатів і в таблиці значень 

доз у вікні результатів. Інтерпольовані 

значення не будуть розглядатися для аналізу. 

 
Якщо прапорець Profiles and tables only contain 

measured values (Профілі і таблиці містять 

тільки виміряні значення) встановлено, то 

будуть показані тільки виміряні значення. 
 

ПРИМІТКА 

Зміна цього налаштування почне діяти тільки 

після перезавантаження матриць. 
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Загальні відомості 

 
Якщо встановлено прапорець Warn about 

unsaved data (Попереджати про незбережені 

дані), то при виклику команди, яка може 

видалити поточні відображені незбережені 

дані (наприклад, при завантаженні матриць, 

виході з програми VeriSoft), буде виводитися 

попередження з наданням можливості 

зберегти дані. 

23.3.3. Додаткові параметри 
 

 

Малюнок 84. Вкладка Advanced 

(Додатково) в діалоговому 
вікні параметрів 

 
На вкладці Advanced (Додатково) можна 

налаштувати наступні параметри: 

 

 
Miscellaneous (Інше) 

 
В цій панелі можна визначити середню 

область (Average Region) для визначення 

виміряного значення в позиції курсора, 

значення нормалізації або значення фону. 



 
 
 

 

Виберіть один з наступних параметрів: 

 
1 pixel (1 піксель): Значення вимірювання є 

значенням поточного пікселя. 

 
5 pixel (5 пікселів): Значення вимірювання є 

середнім значенням для поточного пікселя і 

пікселів справа, зліва, зверху і знизу. 

 
9 pixel (9 пікселів): Значення вимірювання є 

середнім значенням для поточного пікселя і 

восьми сусідніх пікселів. 

 
Якщо встановлено прапорець Show Patient ID 

(Показати ідентифікатор пацієнта), то 

ідентифікатор пацієнта буде додано до типу 

матриці. Ідентифікатор пацієнта (patient ID) 

береться з завантаженого файлу. 

 

 
Appearance (Оформлення) 

 
В цій панелі можна змінювати схему кольорів 

та колір фону програми VeriSoft. 

За замовчуванням використовується чорна 

схема і сірий фон. 

Налаштування за замовчуванням можна 

відновити натискання кнопок Default Scheme 

(Схема за замовчуванням) і Default 

Background (Фон за замовчуванням). 

 

 
Security (Безпека) 

 
В панелі Security (Безпека) є кнопка Set 

Administration Password (Установка пароля 

адміністрування) для відображення вікна 

пароля адміністрування. 

 
У вікні пароля адміністрування можна 

активувати або деактивувати парольний 

захист. Крім того, можна встановити або 

змінити необхідний пароль. 

 
Додаткову інформацію по паролю 

адміністрування див. в розд. 23.3.4 

"Управління паролями ". 

23.3.4. Управління паролями 

 
Для захисту налаштувань програми від 

несанкціонованої зміни користувачами, 

наступні функції VeriSoft захищені паролем: 

 
-  Зміни в меню Tools → Options (Сервіс - 

Параметри) 

 
- Завантаження проектів 

 
Програма поставляється з деактивованим 

парольним захистом, тобто пароль не задано. 
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23.3.4.1. Активація парольного захисту 

 

• Для активації парольного захисту потрібно 

задати пароль. Для цього клацніть на кнопці 

Set Administration Password (Установка пароля 

адміністрування) 

 
➔ На екрані з'явиться діалогове вікно Set 

Password (Установка пароля): 

 

 
Малюнок 85. Діалогове вікно установки 

пароля 

 
• Введіть новий пароль і повторіть введення 

ще раз. 

 
• Підтвердіть введення натисканням кнопки 

OK. 

 
➔ З цього моменту функції, захищені 

паролем, можуть бути доступні лише 

після введення пароля. 
 

Після запуску програми пароль потрібно 

ввести тільки один раз. 

 
Компанія PTW-Freiburg рекомендує вийти з 

програми VeriSoft і перезапустити її після 

роботи з функціями, захищеними паролем. 

 

23.3.4.2. Зміна пароля або деактивація 

парольного захисту 

 
• Щоб змінити пароль або деактивувати 

парольний захист, клацніть на кнопці Set 

Administration Password (Установка пароля 

адміністрування). 

 
➔ На  екрані  з'явиться  діалогове  вікно 

Change password (Зміна пароля): 

 

 

Малюнок 86. Діалогове вікно зміни пароля 

 

 
• Введіть старий пароль. 

 
• Для зміни пароля введіть новий пароль і 

повторіть введення ще раз. 

 
• Для видалення пароля залиште поля 

введення New Password (Новий пароль) і 

Confirm New Password (Підтвердження нового 

пароля) порожніми. 

 
• Підтвердіть введення натисканням кнопки 

OK. 

 



 
 
 

 

23.3.5. Налаштування для імпорту 

даних DICOM 

 

Малюнок 87. Вкладка DICOM в діалоговому 
вікні параметрів 

 

 
На вкладці DICOM можна налаштувати 

наступні параметри: 

 

 
Multi Frame Images (Багатокадрові 

зображення) 

 
В цій панелі задається напрямок зрізу 

завантаженого об'ємного набору доз, який 

буде розрахований. Для цього виберіть 

потрібний напрямок в полі переліку. Якщо 

обраний напрям збігається з напрямом 

збереженого зрізу, то дані будуть завантажені 

без змін. 

 
Напрямок за замовчуванням: Transversal 

(Поперечний) 

 
Data Import (Імпорт даних) 

 
Якщо потрібно імпортувати дані DICOM 

безпосередньо з мережевого сервера DICOM, 

потрібно налаштувати наступні параметри: 

 
В панелі Remote AESettings (Налаштування 

віддалених AE) (AE = об'єкт програми) 

потрібно налаштувати мережеві параметри 

сервера DICOM. Ці параметри мережі надасть 

адміністратор вашої мережі. 

 
- SCP-Server name (Ім'я SCP-сервера): 

ім'я серверного комп'ютера 

 
- Unique AE title (Унікальне назва AE): 

унікальна назва об'єкта програми сервера 

 
- TCP / IP port (Порт TCP / IP): 

номер порту сервера для доступу DICOM 

SCP (SCP = постачальник класу служби) 

 
В панелі Local AESettings (Налаштування 

локальних AE) (AE = об'єкт програми) потрібно 

налаштувати мережеві параметри вашого 

комп'ютера, тобто клієнта DICOM. Зазвичай 

адміністратор повинен також налаштувати 

мережеві параметри клієнта на сервері 

DICOM, тобто клієнт повинен бути відомий 

серверу. 

 
- Unique AE title (Унікальне назва AE): 

унікальна назва об'єкта програми клієнта 

 
- TCP / IP port (Порт TCP / IP): 

номер порту клієнта для доступу DICOM SCP 

(SCP = постачальник класу служби) 

 

 
Windowing (Управління вікнами) 

 
Встановіть прапорець Apply VOI/LUT 

Transformation (Застосувати перетворення 

VOI / LUT), щоб програма VeriSoft включала 

перетворення VOI / LUT, збережене у файлі 

DICOM, при завантаженні матриці. 
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23.3.6. Налаштування для 4D- 

дозиметрії 

 
 

Малюнок 88. Вкладка 4D Dosimetry (4D- 
дозиметрія) в діалоговому вікні 
параметрів 

 
 

Зміни на вкладці 4D Dosimetry (4D-дозиметрія) 

не розглядатимуться до розрахунку об'єму 

OCTAVIUS 4D в наступний раз. 
 

 

 
На вкладці 4D Dosimetry можна налаштувати 

наступні параметри: 

4D Dosimetry (4D-дозиметрія) 

 
Поля введення для довжин сторін воксела в 

[мм] в напрямку X, Y і Z 

Інформацію щодо визначення системи 

координат див. в розд. 12.6 "Відображення 

панелей об'ємних наборів доз". 

 
Допустимий діапазон: 1,0 ... 10,0 

За замовчуванням: 2,5 

 

Компанія PTW рекомендує налаштувати 

довжини сторін воксела в програмі VeriSoft 

відповідно до значень в системі планування 

променевої терапії. 

 
Поле введення відстані джерело-детектор в 

[см] 

Допустимий діапазон: 70,0 ... 150,0 

За замовчуванням: 100,0 

 
Індикація радіусу поворотного блоку 

OCTAVIUS - 160 мм 

 
Поля введення довжини фантома, що 

використовується для розрахунку доз в разі 

некомпланарного опромінення. 

Допустимий діапазон:  (260 ... 360) мм 

За замовчуванням: 340 мм (для 

приналежності Rotation Unit 

(поворотний блок)) 

260 мм (для 

приналежності Rotation Unit SRS 

(Поворотний блок SRS)) 

 

 

 

Компанія PTW рекомендує налаштування 

довжин фантома в програмі VeriSoft у 

відповідності зі значеннями в системі 

планування променевої терапії. 
 

ПРИМІТКА 



 
 
 

 

Нестандартна 4D- дозиметрія 

 
За допомогою поля переліку в цій панелі 

можна визначити, чи потрібні додаткові 

налаштування або розрахунки для 

обчислення об'ємного набору доз OCTAVIUS 

4D: 

 
- None (Немає) 

Ніякі додаткові налаштування або 

розрахунки не потрібні. 

Налаштування за замовчуванням 

 
- Non coplanar 4D dosimetry (Некомпланарна 

4D-дозиметрія) 

Розрахунок об'ємного набору доз для 

некомпланарного опромінення 

 
- Off-axis 4D dosimetry (4D-дозиметрія зі 

зсувом від осі) 

Розрахунок об'ємного набору доз для 

опромінення при розташуванні поворотного 

блоку не в ізоцентрі 

 
- 4D dosimetry for multiple energies (4D- 

дозиметрія для декількох енергій) 

Розрахунок об'ємного набору доз в разі 

додавання вимірювань, виконаних з різними 

енергіями 

 
Додаткову інформацію див. в розд. 23.3.6.1 

"Подальші розрахунки для 4D-дозиметрії". 

 

 
PDD Directory (Каталог PDD) 

 
Вибір каталогу з файлами PDD 

За замовчуванням файли PDD 

завантажуються з наступного каталогу: 

<PTW documents> \ VeriSoft \ Data \ PDDData 

OCTAVIUS 4D Phantom (Фантом OCTAVIUS 

4D) 

 
Для реконструкції доз в фантомі повинна бути 

відома відносна щільність електронів Electron 

density relative to water (Щільність електронів 

відносно води) для матеріалу фантома. Для 

матеріалу фантома OCTAVIUS 4D ця 

щільність становить 1,016. 

 
Деякі системи планування променевої терапії 

(TPS) використовують інше значення для 

відносної щільності електронів. В цьому 

випадку криві «глибина - доза» для відкритих 

полів у фіксованому положенні гентрі, які 

розраховані за даними TPS, трохи відхиляться 

від кривих, реконструйованих з системою 

OCTAVIUS 4D. Цей ефект буде 

скоректований, якщо ви налаштуєте значення 

відносної щільності електронів в TPS або в 

програмі VeriSoft. Для реконструкції планів 

IMRT це не має великого значення, але дуже 

корисно при введенні системи OCTAVIUS 4D. 

 
Додаткову інформацію щодо визначення 

відносної щільності електронів у вашій системі 

TPS див. Технічний документ D913.200.11, 

опублікований компанією PTW. 

 

 
Створення файлу PDD 

 
В панелі Generate PDD File (Створення файлу 

PDD) можна створити файли PDD, необхідні 

для 4D-дозиметрії. Тут окремі криві «глибина - 

доза» будуть об'єднані в один файл PDD. 

 
Додаткову інформацію див. в розд. 23.3.7 

"Створення файлів PDD". 

 

Кнопка для вибору каталогу ... 
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23.3.6.1. Подальші розрахунки для 4D- 

дозиметрії 

 
В діалоговому вікні Options (Параметри) на 

вкладці 4D Dosimetry можна вибрати один з 

наступних параметрів в панелі Non-Standard 

4D Dosimetry (Нестандартна 4D-дозиметрія), 

якщо необхідні додаткові налаштування і 

розрахунки для обчислення об'ємного набору 

доз OCTAVIUS 4D: 

 

 
Некомпланарна 4D-дозиметрія 

 
Якщо встановлено прапорець Non coplanar 4D 

dosimetry (Некомпланарна 4D-дозиметрія), то 

об'ємний набір доз OCTAVIUS 4D можна 

розрахувати також для некомпланарного 

опромінення. 

 
В діалоговому вікні Select an angle range (Вибір 

діапазону кутів) (див. малюнок 10 або малюнок 

31) для цього відображається поле переліку, 

де можна вибрати або задати кут повороту 

стола пацієнта. 

 
Виконайте необхідне вимірювання OCTAVIUS 

4D з компланарним опроміненням. На основі 

цих даних вимірювання розраховується 

об'ємний набір доз OCTAVIUS 4D для 

некомпланарного опромінення, з урахуванням 

введеного кута повороту процедурного столу. 

 

 
4D-дозиметрія зі зсувом від осі 

 
Якщо ви обрали Off-axis 4D dosimetry (4D- 

дозиметрія зі зсувом від осі), об'ємний набір 

доз OCTAVIUS 4D може бути обчислений 

навіть при розташуванні поворотного блоку не 

в ізоцентрі джерела випромінювання під час 

опромінення. 

В діалоговому вікні Select an angle range 

(Вибір діапазону кутів) (див. малюнок 10 або 

малюнок 31) для цієї мети відображаються три 

поля введення значень зсуву в напрямках Left- 

Right (зліва направо), Target-Gun (мішень- 

джерело) і Bottom-Top (від низу до верху). 

 
Виконайте потрібне вимірювання OCTAVIUS 

4D. На основі цих даних вимірювання 

розраховується об'ємний набір доз OCTAVIUS 

4D з урахуванням введених значень зсуву. 

 

 
4D-дозиметрія для декількох енергій 

 
Якщо ви обрали 4D dosimetry for multiple 

energies (4D-дозиметрія для декількох 

енергій), об'ємний набір доз OCTAVIUS 4D 

може бути розрахований, навіть якщо додані 

вимірювання були виконані з різними 

енергіями. 

 
В діалоговому вікні Select an angle range 

(Вибір діапазону кутів) (див. малюнок 10 або 

малюнок 31), можна вибрати файл PDD, що 

підходить для відповідного вимірювання в 

цьому випадку. 

 
Виконайте потрібні вимірювання OCTAVIUS 

4D. На основі цих даних вимірювання 

розраховується об'ємний набір доз OCTAVIUS 

4D з урахуванням вибраних файлів PPD. 



 
 
 
 

 

23.3.7. Створення файлів PDD 

 
Для розрахунку об'ємного набору доз 

OCTAVIUS 4D з даних вимірювання 

OCTAVIUS 4D потрібно мати файл PDD для 

кожного джерела випромінювання і кожної 

енергії. Цей файл PDD повинен містити криві 

«глибина - доза» для всіх розмірів полів від 

0x0 см до 26x26 см з кроком 1 см. Зазначені 

розміри полів відносяться до площини 

ізоцентра. 

 
ПРИМІТКА 

Якщо ваше джерело випромінювання 

забезпечує тільки розміри полів менші 26x26 

см, ви повинні виміряти криві «глибина - доза» 

до максимально можливого розміру поля. 

Програма VeriSoft також може 

використовувати ці файли PDD. У цьому 

випадку буде виведено відповідний запит. 
 

 

 
В наступних розділах наводиться опис 

створення  файлів  PDD  на  основі  кривих 

«глибина - доза», які виміряні пристроями 

PTW і програмами PTW. 

 
Опис створення файлів PDD на основі кривих 

«глибина - доза», які виміряні сторонніми 

пристроями і сторонніми програмами, див. в 

додаток B "Створення файлів PDD зі 

сторонніми пристроями та стороннім 

програмним забезпеченням". 

23.3.7.1. Вимірювання кривих «глибина - 

доза »за допомогою пристроїв PTW 

і програм PTW 

 
Для вимірювання кривих «глибина - доза» 

компанія PTW рекомендує використовувати 

водний фантом PTW і вимірювальне 

програмне забезпечення PTW MEPHYSTO 

mc². 

 
• Запустіть програму Water Tank Scans (Скан 

резервуара з водою) з навігатора MEPHYSTO. 

 
• Виміряйте криві «глибина - доза» з 

наступними налаштуваннями (додаткові 

відомості по вимірюванню див. в інструкції з 

використання MEPHYSTO mc²): 

 
- SSD (відстань джерело-поверхня): 

- при використанні приналежності Rotation 

Unit (Поворотний блок): 85 см 

- при використанні приналежності Rotation 

Unit SRS (Поворотний блок SRS): 92 см 

 
- обов'язкові розміри поля (в ізоцентрі при 

відстані «джерело - ізоцентр» 100 см): 

 
- при використанні приналежності Rotation 

Unit (Поворотний блок): 4 x 4 см, 5 x 5 см, 

10 x 10 см, 15 x 15 см і 26 x 26 см 

- при використанні приналежності Rotation 

Unit SRS (Поворотний блок SRS): 4 x 4 см, 

5 x 5 см, 8 x 8 см, 10 x 10 см, 14 x 14 см і 18 

x 18 см 

 
Для цього використовуйте іонізаційну камеру, 

тип 31010, включену в стандартну 

конфігурацію водного фантома PTW. 
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- Необов'язкові розміри поля: 

2 x 2 см і 3 x 3 см 

Для цього використовуйте дозиметричний 

діод. Компанія PTW рекомендує 

дозиметричний діод типу 60017. В якості 

альтернативи можна використовувати 

дозиметричний діод T60018 або 

microDiamond T60019. 

 
➔ Кожна крива «глибина - доза» буде 

збережена в окремому mcc-файлі. 

• Завершіть роботу програмного 

забезпечення. 

 
23.3.7.2. Об'єднання кривих «глибина - 

доза» в один файл PDD 

 
Об'єднання кривих «глибина - доза» в один 

файл PDD можливе тільки в тому випадку, 

якщо дотримуються наступні умови: 

 
- Криві «глибина - доза» повинні бути доступні 

принаймні для 3 розмірів полів ≤ 10 см. 

 
-  Параметри вимірювання: метод, енергія, 

клиновидний фільтр, блок, відстань джерело- 

поверхня, кут гентрі, кут коліматора, а також 

зміщення коліматора в поперечній і власній 

поверхні, - повинні бути однаковими для всіх 

кривих «глибина - доза». 

 

 
• Виберіть меню Tools → Options (Сервіс - 

Параметри) і відкрийте вкладку 4D Dosimetry 

(4D-дозиметрія). 

 
• В панелі Generate PDD File (Створення 

файлу PDD) клацніть на кнопці Select folder 

(Вибір папки). 

 
• У стандартному діалоговому вікні Open 

(Відкрити) виберіть каталог з кривими 

«глибина - доза». 

 
➔ Всі криві «глибина - доза», що 

знаходяться в цьому каталозі, будуть 

перераховані. 
 

 

Малюнок 89. Панель створення файлу PDD 
з завантаженими кривими 

«глибина - доза» 



 
 
 
 
 

 

• Якщо потрібно, додайте ще криві «глибина 

- доза» з інших каталогів, натиснувши кнопку 

Add File(s) (Додати файли). 

 
• Виділіть криві «глибина - доза», які не 

потрібні, клацнувши на них (синій фон). 

Видаліть виділені криві «глибина - доза» з 

екрана, натиснувши кнопку Remove file(s) 

(Видалити файли). 

 
• Для видалення всіх кривих «глибина - 

доза» з екрана, клацніть на кнопці Clear 

(Очистити). 

 
• Встановіть прапорці для кривих «глибина - 

доза», які хочете об'єднати в один файл PDD. 

 
• Натисніть кнопку Merge and complete PDD 

file (Об'єднати і завершити файл PDD). 

 

➔ Якщо всі умови виконані, файл PDD 

буде створений і збережений в каталозі, 

вказаному в панелі PDD Directory 

(Каталог PDD). 

Якщо умови не виконані, з'явиться 

повідомлення про помилку. 

23.3.7.3. Створення файлу PDD для нової 

відстані джерело-поверхня (SSD) 

 
Програму VeriSoft можна використовувати для 

створення нового файлу PDD для нової 

відстані джерело-поверхня (SSD) на основі 

файлу PDD для даного SSD. 

 
Для цього необхідно виконання наступних 

умов: 

 
- Обрано тільки один файл PDD. 

 
- Файл PDD містить дані для розмірів поля від 

0x0 см до максимального розміру поля з 

кроком 1 см. 

 
- Дані були виміряні при відстані джерело- 

ізоцентр (SID) 100 см. 

 
- Розміри поля визначені в ізоцентрі. 

 
- Все криві «глибина - доза» в файлі PDD були 

виміряні при однаковому SSD. 

 
- Попереднє значення SSD знаходиться в 

діапазоні (84 ... 100) см. 

 
 

 
• Виберіть меню Tools → Options (Сервіс - 

Параметри) і відкрийте вкладку 4D Dosimetry 

(Дозиметрія 4D). 

 
• В панелі Generate PDD File (Створення 

файлу PDD) клацніть на кнопці Select Folder 

(Вибір папки). 

 
• У стандартному діалоговому вікні Open 

(Відкрити) виберіть папку, в якій знаходиться 

потрібний файл PDD. 
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➔ Будуть перераховані всі файли PDD в 

обраній папці. 

 

 

 
Малюнок 90. Панель створення файлу PDD 

з завантаженими файлами 
PDD 

 
• Виберіть потрібний файл PDD, 

встановивши відповідний прапорець. 

 
• Клацніть на кнопці Create PPDs for new SSD 

(Створення файлів PPD для нового SSD). 

 
• У діалоговому вікні Create PPDs for new 

SSD введіть нове значення SSD. 

Діапазон введення: (85 ... 100) см 

Нове значення SSD може бути менше або 

більше попереднього значення. 

 
➔ Відкриється стандартне діалогове вікно 

Save (Зберегти). Запропоноване ім'я 

файлу складається з імені обраного 

файлу PDD і ідентифікатора "_SSD 

XXXmm". 

 
➔ Після успішного збереження даних 

з'явиться відповідне повідомлення. 

23.3.8. Налаштування для 

гістограм об'ємного набору 

доз (DVH) 
 

Малюнок 91. Вкладка DVH в діалоговому 
вікні параметрів 

 

 
Вкладка DVH (Гістограма об'єму доз) 

відображається тільки при наявності 

ліцензованої функції DVH 4D. 

 

Зміни на вкладці DVH почнуть діяти тільки 

після повторного завантаження даних DVH. 
 



ПРИМІТКА 

 
 
 
 

 

На вкладці Devices (Пристрої) можна 

налаштувати наступні параметри: 

 

 
4D Dosimetry Patient (Пацієнт 4D- 

дозиметрії) 

 
Поле введення для довжин сторін вокселів в 

[мм] Це значення застосовується до довжин 

сторін вокселів в напрямках X, Y і Z. 

Інформацію щодо визначення системи 

координат див. в розд.12.6 "Відображення 

панелей об'ємних наборів доз". 

 
Допустимий діапазон: 1,0 ... 10,0 

За замовчуванням: 2,5 
 

 

Компанія PTW рекомендує налаштувати 

довжини сторін вокселів в програмі VeriSoft 

відповідно до значень в системі планування 

променевої терапії. 

 

 
Data Path (Шлях до даних) 

 
Вибір каталогу, в який будуть автоматично 

зберігатися розрахункові DVH-криві PTW і з 

якого розрахункові DVH-криві PTW будуть 

автоматично завантажуватися 

 
За замовчуванням: 

<PTW documents> \ VeriSoft \ Data \ DVH 

Кнопка для вибору каталогу 

Body Contour (Контур тіла) 

 
Назва контуру тіла має бути введена в поле 

введення Body Contour Name. Ця назва і назва 

в даних TPS (об'єкт RTStruct) повинні бути 

однаковими. Якщо вони різні, в рядку стану 

вікна DVH буде виведено повідомлення про 

помилку, і розрахунок DVH-кривих буде 

неможливий. 

 

 
Correction Value (Значення поправки) 

 
В полі введення kDVH можна ввести 

поправочний коефіцієнт для розрахунку DVH- 

кривих. Доза пацієнта буде помножена на цей 

поправочний коефіцієнт для розрахунку DVH. 

За замовчуванням: 1,0 

 
Деякі коефіцієнти можуть привести до 

систематичної мінімальній різниці між дозою 

пацієнта, реконструйованої програмою 

VeriSoft, і значенням дози, розрахованим 

системою TPS. Двома основними факторами 

цієї різниці є метод калібрування матричного 

детектора і відносна щільність електронів 

поворотного блоку OCTAVIUS, прийняті в 

системі TPS. Відхилення варіюються в 

діапазоні до 3%. Якщо матричний детектор 

завжди калібрується однаковим чином, і 

налаштування щільності фантома в TPS не 

змінюється, то систематичне відхилення буде 

завжди одним і тим же. Воно може бути 

скомпенсоване за допомогою поправочних 

коефіцієнтів kDVH. 

… 
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Поправочний коефіцієнт kDVH можна 

визначити наступним чином: 

 
Порівняйте максимальні значення дози DVH- 

кривих TPS зі значеннями кривих VeriSoft для 

10 планів, які повинні бути максимально 

різними. Розрахуйте середнє значення 

відхилення. Якщо середнє відхилення 

прийняти як коефіцієнт x, то в якості 

поправочного коефіцієнта kDVH введіть 

значення 1 / x. 

Плани, використані для цього розрахунку, 

повинні включати як можна менше тканин 

легень і тільки мінімальні обсяги повітря. 

23.3.9. Визначення класів 

порівняння 

 
Щоб мати можливість виконання статистичних 

оцінок результатів порівняння програми 

VeriSoft з програмою PTW Track-it, кожній 

вивірці плану повинен бути призначено клас 

порівняння. 

 
Клас порівняння визначається його ім'ям і 

пов'язаним джерелом випромінювання. 

 

 

Малюнок 92. Вкладка Classes (Класи) 
діалогового вікна параметрів 
для методу Gamma 2D і 
Gamma 3D 

 

 
На вкладці Classes (Класи) можна 

налаштувати наступні параметри: 



 
 
 
 

 

Administration (Адміністрування) 

 
В панелі Administration (Адміністрування) 

можна створювати і видаляти класи 

порівняння. 

 
Створення класу порівняння: 

 
• У полі переліку Class name (Ім'я класу) 

введіть ім'я для класу порівняння (наприклад, 

H & N). 

 
• У комбінованому полі Radiation unit 

(Джерело випромінювання) введіть пов'язане 

джерело випромінювання (наприклад, Linac1). 

 

➔ Після виходу з цих комбінованих полів в 

полі переліку Class ID (Ідентифікатор 

класу) буде відображено новий клас 

порівняння. Ім'я класу складається з 

двох записів і символу (@) між ними, 

наприклад H & N @ Linac1. 

 

 
Видалення класу порівняння: 

 
• У полі переліку Class ID 

(Ідентифікатор класу) виберіть клас 

порівняння, який хочете видалити, і 

клацніть на кнопці праворуч від поля 

переліку. 

 

➔ Клас порівняння буде видалений без 

запиту підтвердження. 

Видалення імені класу порівняння або 

джерела випромінювання: 

• У комбінованому полі Class name  

(Ім'я класу) або Radiation unit (Джерело 

випромінювання), виберіть запис, який 

хочете видалити, і клацніть на кнопці 

праворуч від поля переліку. 

 

➔ Обраний запис буде видалено без 

запиту підтвердження. 

 
➔ Якщо назва джерела випромінювання 

використовується в ідентифікаторі 

класу, воно не буде видалено 

автоматично. Програма виведе 

відповідне повідомлення. 

 

 
Параметри порівняння 

 
В полі переліку Compare mode (Режим 

порівняння) можна вибрати режим порівняння: 

 
- Gamma 2D і Gamma 3D 

метод «Гамма-індекс» 

 
- Local% Difference 

метод «Локальна різниця у відсотках» 

 
- DoN (% Diff ref Norm. Value) 

метод «Різниця в % від нормалізованого 

значення референтної матриці» 

 
Залежно від обраного режиму порівняння 

можна встановити параметри порівняння, 

згідно з інструкціями в розд. 23.3.9.1 

"Налаштування параметрів порівняння". 
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Налаштування результатів 

 
В панелі Result Settings (Налаштування 

результатів) можна налаштувати наступні 

параметри: 

 
- У першому рядку задається максимальне 

значення порівняння, відповідне класифікації 

passed (в діапазоні допуску). 
 

Для методу Gamma Index (Гамма-індекс) це 

значення фіксоване і не може бути змінено. 
 

 
- У другому і третьому рядках вводяться 

значення порогів для оцінки розрахункових 

значень порівняння. 

➔ Якщо виконується умова, введена в 

верхньому полі введення, то результат 

в полі Results (Результати) у вікні 

результатів буде позначений зеленою 

точкою. 

 
➔ Якщо виконується умова, введена в 

нижньому полі введення, то результат в 

полі Results (Результати) у вікні 

результатів буде позначений жовтою 

точкою. 

 
➔ Якщо жодна з умов не виконується, то 

результат в полі Results (Результати) у 

вікні результатів буде позначений 

червоною точкою. 

23.3.9.1. Налаштування параметрів 

порівняння 

 
Метод Gamma 2D і Gamma 3D 

 
В полі переліку Definition of referenced max. 

dose for dose volumes (Визначення референ- 

тної максимальної дози для об'ємного набору 

доз) можна задати референтну точку для 

порівняння об'ємних наборів: максимальне 

значення для всього об'ємного набору доз 

(значення за замовчуванням) або 

максимальне значення для відображеного 

зрізу. 

 
В полі переліку Gamma Index calculation 

(Розрахунок гамма-індексу) можна активувати 

або деактивувати додаткові розширені умови 

(другий і третій прохід) для розрахунку гамма- 

індексу, розробленого авторами Tom Depuydt 

та ін. (Radiotherapy and Oncology 62 (2002) 

309-319) [5]. PTW рекомендує використову- 

вати цю можливість. 

 
Крім того, можна визначити наступні 

параметри порівняння для методу Gamma 

Index (Гамма-індекс): 

 
- mm Distance-To-Agreement (Відстань до 

заданої точки в мм): 

прийняте просторове відхилення 

 

Якщо в якості порівняльної матриці 

завантажено об'ємний набір доз і обрано 

режим порівняння Gamma 3D (Гамма 3D), 

програма VeriSoft перевірить допустиме 

просторове відхилення у всіх просторових 

напрямах. 
 

 
- % Dose Difference with ref. to (% різниці дози 

відносно): 

допустиме відсоткове відхилення дози 



 
 
 
 

 

- Референтне значення для допустимого 

відсоткового відхилення дози: 

 
- Local dose (Локальна доза): 

доза у відповідній позиції референтної 

матриці 

 
- Max. dose of ... (Макс. доза ...): 

максимальна доза референтної матриці, 

яка залежить від налаштування и в полі 

переліку Definition of referenced max. dose 

for dose volumes (Визначення референтної 

максимальної дози для об'ємного набору 

доз) 

- entire volume (весь об'єм): 

максимальна доза всього об'ємного 

набору доз 

- selected slice (обраний зріз): 

максимальна доза обраного зрізу 

 
- Selected dose (Обрана доза): 

доза в довільній точці референтної матриці 

Введіть бажане значення дози. 

 
- Use increased tolerance (Використовувати 

збільшений допуск): 

Ви можете визначити вищий допуск для 

використання нижче певного порогу. Для 

цього потрібно встановити відповідний 

прапорець і ввести більш високий допуск і 

бажане значення порога. 

- Suppress doses below (Ігнорувати більш 

низькі дози): 

Можна заборонити виконання гамма- 

розрахунку, якщо значення доз референтної 

матриці нижче заданого порогу доз. Для 

цього потрібно встановити відповідний 

прапорець і ввести значення порога в 

відсотках від заданої максимальної дози. 

Максимальна доза залежить від 

налаштування в полі переліку Definition of 

referenced max. dose for dose volumes 

(Визначення референтної макс. дози для 

об'ємних наборів доз). 

Точки, виключені з оцінки, будуть позначені 

як не поціновані, відображені зі значенням 

гамма = 0 в діаграмі і помічені символами 

«---» в таблиці. Точки, виключені з оцінки, не 

розглядаються в статистиці або в гістограмі. 

PTW рекомендує використовувати цей 

параметр, щоб усунути вплив розсіяного 

випромінювання на результати. 

 

 
Метод Local Percentage Difference 

(Локальна різниця у відсотках) і Difference 

in% of Normalization Value of Reference 

Matrix (Різниця в % від нормалізованого 

значення референтної матриці) 

 
Для цих двох режимів порівняння можна також 

заборонити виконання розрахунку, якщо 

значення доз референтної матриці нижче 

заданого порогу. Для цього встановіть 

прапорець і введіть значення порога в % 

максимуму у виміряному зрізі. 

Точки, виключені з оцінки, будуть позначені як 

не поціновані, відображені зі значенням 

порівняння = 0 в діаграмі і помічені символами 

«---» в таблиці. Точки, виключені з оцінки, не 

розглядаються в статистиці або в гістограмі. 
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24. VeriSoft Вікно вимірювань 

 
24.1. Структура вікна вимірювань 

 
 

 

Малюнок 93. Вікно вимірювань 

 
1 Рядок заголовка 

 
2 Рядок меню 

 
3 Панель інструментів 

 
4 Діаграма вимірювань (3D-графіка) 

 
5 Рядок стану (див. Розд. 24.1.2 "Рядок 

стану вікна вимірювань") 

 
6 Діаграма вимірювань з інклінометром 

(тільки в разі вимірювання з поворотним 

блоком або інклінометром) 
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24.1.1. Пояснення щодо кожної 

піктограми на панелі 

інструментів 
 

Зверніть увагу, що наявність видимих кнопок 

або вибраних перемикачів залежить від 

обраного матричного детектора. 
 

 

1. Загальні кнопки 

 Save data (Збереження даних) 

Видалення відображеної кривої 

вимірювання і звільнення порту 

 
Запуск вимірювання (також 

можна натиснути клавішу F5) 

 
Призупинення вимірювання 

(також можна натиснути 

клавішу F6) 

 
Прийняття цих вимірювань і закриття 

вікна вимірювань 

 
Переривання вимірювань і 

закриття вікна вимірювань 

 

 
2. Кнопка з переліком вибору 

 
- Значок, що відображається, показує 

поточний вибір. 

 
- Під час кожного натискання кнопки 

вибирається наступний варіант. На кнопці 

відображається відповідний значок, і буде 

виконуватися відповідна функція. 

 
- Під час кожного натискання кнопки буде 

відображатися меню з усіма варіантами 

вибору для  кнопки. Після вибору варіанту 

на кнопці буде відображатися відповідний 

значок, і буде виконуватися відповідна 

функція. 

 

Вибір параметрів вимірювань: 
 

  Діапазон вимірювань Low (Нижній) 

 Діапазон вимірювань High (Верхній) 

Вибір орієнтації поворотного блоку 

 
нормальна орієнтація поворотного 

блоку, тобто редуктор поворотного 

блоку звернений до джерела 

поворотний блок повернутий на 180 °, 

тобто редуктор поворотного блоку 

звернений до мішені 

 

Вибір місця кріплення інклінометра 

 
Інклінометр встановлений на джерелі 

випромінювання спереду. 

Інклінометр встановлений на джерелі 

випромінювання ззаду (наприклад, на 

апараті Varian Halcyon ™) 
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24.1.2. Рядок стану вікна вимірювань 
 
 
 
 
 
 

1 2 3 4 5 

 

 
Малюнок 94. Рядок стану вікна вимірювань 

1 Індикатор стану, описує поточні дію і стан 4 Серійний номер обраного матричного 

детектора 2 Обраний матричний детектор  

3 Шлях і ім'я завантаженого файлу калібрування 

(Повний шлях і ім'я будуть показані у 

спливаючому вікні, коли покажчик миші 

переміщається по цій області) 

5 Час і значення поточного вимірювання 

для вибраної камери, а також кут гентрі 

(тільки в разі вимірювання з поворотним 

блоком або інклінометром) 

 
 
 
 

Виміряні значення в [Гр *] 

 
Калібрувальні коефіцієнти в файлі калібру- 

вання матричного детектора відносяться до 

якості випромінювання 60Co. Якщо матричні 

детектори використовуються з іншими видами 

випромінювання (не 60Co), слід брати до уваги 

різницю у відгуку. Оскільки відповідні 

поправочні коефіцієнти недоступні, виміряні 

абсолютні значення вказуються в одиницях 

[Гр*]. 



 
 
 
 

 

24.2. Zeroing (Обнулення) 

 
Перед першим запуском вимірювання 

система повинна бути обнулена. Обнулення 

буде автоматично виконуватися для всіх 

діапазонів вимірювань. Для цього виберіть 

меню Measurement → Zero (Вимірювання - 

Обнулення). Поки виконується обнулення, 

відображається вікно вимірювань. 

 
Для процедури обнулення має бути 

встановлено два значення часу в меню Tools 

→ Measurement Options вкладка Measurement 

(Сервіс - Налаштування вимірювань - вкладка 

«Вимірювання») (також див. Розділ 23.2.2 

"Measurement Settings (Налаштування 

вимірювань)"). 

 
24.3. Визначення нульової 

точки (Zero Point) 

інклінометра 

 
При запуску вимірювання з матричним 

детектором та інклінометром спочатку 

потрібно визначити нульову точку 

інклінометра. 

 
• Для цього поверніть гентрі до кута 0°. 

 
• Виберіть пункт меню Measurement → Zero 

Inclinometer (Вимірювання - Обнулення 

інклінометра). 

 

➔ Поточне положення інклінометра буде 

визначено як нульова точка. 
 

- Zeroing Time (Час обнулення) – 

тривалість процедури обнулення 

 

- Zeroing Reminder (Графік обнулення) - 

період, який визначає інтервали між 

обнуленнями 

 

 
Перевірка достовірності 

 
При кожному запуску вимірювання програма 

перевіряє, чи відповідає час, що минув після 

останнього обнулення, встановленому 

графіком обнулення. Якщо встановлений 

період перевищено, VeriSoft викличе 

процедуру обнулення. 

У випадку вимірювання з матричним 

детектором в поворотному блоці нульова 

точка інклінометра визначається за 

допомогою референтного прогону 

поворотного блоку. 
 

 

 

 

Рекомендується обнуляти систему при 

кожному включенні інтерфейсу детектора. 

VeriSoft не перевіряє, вимкнений чи ні 

інтерфейс детектора. 

Дайте пристроям прогрітися і стабілізуватися 

протягом часу, зазначеному у відповідних 

інструкціях з експлуатації. 
 

ПРИМІТКА 
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24.4. Виконання 

вимірювання 

 

 
24.4.1. Налаштування діапазону 

вимірювань 
 

Налаштування діапазону вимірювань 

неможливе для наступних матричних 

детекторів: 

- 2D ARRAYseven29 

- 2D ARRAYXDR 
 

 
В залежності від величини вимірюваної дози 

можна встановити наступні діапазони 

вимірювання: 

 
- Range Low (Нижній діапазон) 

- вимірювання в нижньому діапазоні 

- Range High (Верхній діапазон) 

- вимірювання у верхньому діапазоні 

 
Обидва діапазони вимірювань залежать від 

заданої швидкості вимірювань. 

 
Діапазон вимірювань буде відображено 

 
- у спливаючому вікні при наведенні курсору на 

відповідну кнопку 

 
- у вікні  меню 

 
24.4.2. Визначення орієнтації 

поворотного блоку 

 
При налаштуваннях за 

замовчуванням вказується орієнтація 

Face Out (Лицьові сторони назовні), 

яка є нормальною орієнтацією 

поворотного блоку (нормальний 

напрямок повороту, редуктор 

звернений до джерела). 

 
Якщо потрібно провести вимірювання з 

поворотним блоком, поверненим на 180° 

(зворотний напрямок повороту, редуктор 

звернений до мішені), виконайте наступні дії: 

 
• Встановіть гентрі в положення 0°. 

 
• Виберіть орієнтацію Face In 

(Лицьові сторони всередину). 

 
 
 

 
24.4.3. Вибір місця кріплення 

інклінометра 

 
За замовчуванням для орієнтації 

відображається значення Normal. Це 

означає, що інклінометр встановлено 

на джерелі випромінювання спереду. 

 
Якщо інклінометр встановлено на задній 

стороні джерела випромінювання, наприклад 

апарату Varian Halcyon™, виконайте наступні 

дії: 

 
• Встановіть гентрі в положення 0°. 

 
• Виберіть положення установки 

Reverse (Інверсія). 
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24.4.4. Measuring (Вимірювання) 

 
 

Переконайтеся, що серійний номер 

використовуваного матричного детектора 

збігається з серійним номером, показаним в 

рядку стану. У рядку стану показано серійний 

номер, взятий з файлу калібрування. VeriSoft 

не перевірятиме підключене обладнання. 
 

 

 

 

Якщо буде потрібна процедура обнулення, 

буде виведено відповідне повідомлення, і 

вимірювання не буде розпочато. 

 
По завершенні процедури обнулення 

вимірювання не буде розпочато 

автоматично. В цьому випадку 

запустіть вимірювання, натиснувши 

кнопку Start (Почати) (або клавішу F5) 

або вибравши меню Measurement → 

Start (Вимірювання - Почати). 
 

 

 
➔ Розпочнеться вимірювання. 

VeriSoft буде постійно зчитувати 

накопичені значення дози і відображати 

їх. Якщо дозволено вимірювання з 

поворотним блоком або інклінометром, 

то показання кута гентрі, виміряне 

інклінометром, також буде відображено. 

 

➔ Після закінчення встановленого часу 

вимірювання процес вимірювання буде 

автоматично завершено. 

 
• Вимірювання можна також 

припинити, натиснувши кнопку Stop 

(Зупинити) (або клавішу F6) або 

вибравши меню Measurement → Stop 

(Вимірювання - Зупинити). 

• Коли вимірювання припинено, 

можна прийняти результати 

вимірювання, натиснувши кнопку 

Accept (Прийняти). Після цього вікно 

вимірювань буде закрито. 

 
• При натисканні кнопки Cancel 

(Скасування) вікно вимірювань буде 

закрито без прийняття даних 

вимірювань. 

 
 
 

 
• Почніть вимірювання знову, 

натиснувши кнопку Start (Почати) (або 

клавішу F5) або вибравши меню 

Measurement → Start (Вимірювання - 

Почати). 
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24.5. Видалення 

даних вимірювання 

 
Натисніть кнопку Clear (Очистити) або 

виберіть меню Measurement → Clear 

(Вимірювання - Очистити). Виміряні 

дані будуть видалені з екрану, і порт 

буде звільнений. Після цього доступ до 

підключених пристроїв зможуть 

отримати інші модулі програми. 

 

 

24.6. Зміна 

графічного 

представлення 

• Переміщаючи мишу при натиснутій лівій 

кнопці, можна повертати діаграму в будь- 

якому напрямку. 

 
• Переміщаючи мишу при натиснутій правій 

кнопці, можна збільшувати або зменшувати 

область інтересу на діаграмі. 

 
• Натиснувши колесо прокрутки і 

переміщаючи мишу, можна переміщатися по 

діаграмі в будь-якому напрямку. 

 
• Вибравши пункт Reset (Скидання) в 

контекстному меню, можна відновити 

значення за замовчуванням на діаграмі. 

24.7. Збереження 

даних вимірювання 

 
При необхідності можна зберегти дані 

вимірювань у вікні вимірювань. 

 
Вимірювання з матричним детектором можуть 

бути збережені у форматі MEPHYSTO mcc 

(*.mcc) або в форматі CSV (*.csv). 

 
Вимірювання з матричним детектором в 

поворотному блоці можуть бути збережені у 

форматі xcc (*.xcc), форматі MEPHYSTO mcc 

(*.mcc) або форматі CSV (*.csv). 

 
-  Файл xcc містить виміряні значення доз з 

відповідними кутами гентрі. 

 
-  Файл mcc або файл CSV містять тільки 

виміряні значення доз для поточного 

вимірювання. 

 
Файл CSV можна відкрити в будь-якій програмі 

електронних таблиць. 

 

 
• Для збереження натисніть кнопку 

Save (Зберегти) або виберіть меню 

File → Save (Файл - Зберегти). 

 
• Потім введіть ім'я файлу і каталог в 

стандартному діалоговому вікні Save As 

(Зберегти як). Запропоноване ім'я файлу 

складається з поточної дати і часу. У разі 

вимірювань з поворотним блоком ім'я файлу 

додатково містить мітку «_4D». Можна 

перезаписувати існуючі файли або 

створювати нові файли. 

 
 

 

Відображені значення дози скоректовані з 

урахуванням всіх налаштованих поправок, 

наприклад поправки до щільності повітря. 
 

ПРИМІТКА 



 
 
 
 
 

 

24.8. Параметри вікна 

вимірювань 

 
При виборі меню Tools → Options (Сервіс - 

Параметри) відкриється діалогове вікно 

Options (Параметри). 

 
В діалоговому вікні Options (Параметри) є дві 

вкладки, призначення яких описано нижче: 

 
- Designations (Позначення): 

позначення або назви 

 
- Advanced (Додатково): 

додаткові параметри 

 
24.8.1. Позначення 

 
 

Малюнок 95. Вкладка Designations 
(Позначення) в діалоговому 
вікні параметрів 

 

 
На вкладці Designations вводяться позначення 

(назви) для чотирьох сторін випромінюючого 

пристрою. Ці позначення будуть 

використовуватися для написів на всіх 

діаграмах у вікні вимірювань. 

 
Позначення за замовчуванням: 

Gun (Джерело), Target (Ціль), Left (Ліва) і Right 

(Права). 

Натискання кнопки Default (За замовчуванням) 

відновить ці позначення за замовчуванням. 
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24.8.2. Розширені можливості 

пошуку 
 

Малюнок 96. Вкладка Advanced (Додатково) 
в діалоговому вікні параметрів 

 

 
На вкладці Advanced (Додатково) можна 

налаштувати наступні параметри: 

 

 
Warn about unsaved data 

(Попереджати про незбережені дані) 

 
Якщо цей параметр обрано, то при виклику 

команди, яка видалить поточне незбережене 

вимірювання (наприклад, запускаючи 

вимірювання), буде виводитися поперед- 

ження з наданням можливості зберегти 

вимірювання. 

Warn about deactivated chambers 

(Попереджати про деактивовані камери) 

 
 

Якщо ви виберете файл калібрування, в якому 

деактивовано окремі вимірювальні камери, то 

буде виведено відповідне повідомлення. 

Відображення повідомлення можна 

відключити з самого повідомлення або знявши 

прапорець цього параметра (Виняток: 

деактивована центральна камера). 

Відображення повідомлення можна включити, 

встановивши цей прапорець. 

 
Для отримання додаткової інформації про 

деактивацію вимірювальних камер див. 

інструкцію з використання програми PTW 

ArrayCal. 



 
 

 

Вибір камери 

 
Ввівши рядок і стовпець, ви визначаєте 

вимірювальну камеру матричного детектора, 

виміряне значення якої повинно відображатися 

в рядку стану. 

 
Відображена діаграма повинна допомогти 

визначити правильні рядок і стовпець. 

Діаграма показує положення, що відповідає 

першому рядку і першому стовпцю. 

 
В наступній таблиці показано положення 

центральної камери різних матриць детекторів. 

 

 
Матричний детектор 

Положення 

центральної 

камери 

ряд 
ок 

стовпе 
ць 

OCTAVIUS Detector 729 

2D-ARRAY 
14 14 

OCTAVIUS Detector 1000 SRS 23 23 

OCTAVIUS Detector 1500 27 27 
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24.9. Повідомлення про помилку вимірювання 

 

Повідомлення Причина Спосіб усунення 

Missing Zero 

measurement 

(Відсутнє вимірювання 

обнулення) 

 
Процедура обнулення ще не 

виконана. 

 
Виконайте процедуру обнулення (див. 

розділ 24.2 "Zeroing (Обнулення)"). 

 
Device not found 

(Пристрій не 

знайдено) 

 
Програма не може 

зв'язатися з вимірювальним 

пристроєм. 

Увімкніть пристрій. Перевірте підключення 

кабелів. Переконайтеся, що підключений 

пристрій відповідає пристрою, заданому в 

програмі. 

 
 
Calibration file can not 

be opened (Не 

вдається відкрити 

файл калібрування) 

 
 
 

Файл калібрування відсутній. 

На вкладці Devices (Пристрої), доступній 

через меню Tools → Measurement Options 

(Сервіс - Налаштування вимірювань), 

введіть правильний шлях до файлу 

калібрування підключеного пристрою (див. 

розділ 23.2.1 "Вибір вимірювальних 

пристроїв"). 

 
 

Invalid calibration file 

(Неприпустимий файл 

калібрування) 

 
 

Був обраний файл 

калібрування іншого 

пристрою. 

На вкладці Devices (Пристрої), доступній 

через меню Tools → Measurement Options 

(Сервіс - Налаштування вимірювань), 

введіть правильний шлях до файлу 

калібрування підключеного пристрою (див. 

розділ 23.2.1 "Вибір вимірювальних 

пристроїв"). 

 
Overload detected 

(Виявлено 

перевантаження) 

 
 
Принаймні в одному каналі 

виявлено перевантаження. 

Перевірте, чи перевищує отримана 

потужність дози опромінення номінальний 

корисний діапазон. Якщо ні, пристрій має 

бути повернуто в PTW-Freiburg для 

ремонту. 

 

HV error (Збій високої 

напруги) 

 
Стався збій високої напруги. 

Перезапустіть систему. Якщо проблема 

зберігається, пристрій має бути повернуто в 

PTW-Freiburg для ремонту. 
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25. Налаштування для передачі даних 
 

 

Передача даних можлива за наступними 

каналами зв'язку: 

 
- З'єднання через локальну мережу 

- Пряме з'єднання по інтерфейсу локальної 

мережі 

- Пряме з'єднання по інтерфейсу RS232 

 

PTW рекомендує зв'язок через локальну 

мережу. 

 

 
Щоб вибрати спосіб зв'язку для передачі 

даних і встановити параметри, необхідні в 

кожному випадку, виберіть меню Tools → 

Measurement Options (Сервіс - Налаштування 

вимірювань) і вкладку Devices (Пристрої). 

 

 

Малюнок 97. Вкладка Devices (Пристрої) в 
діалоговому вікні налаштувань 
вимірювань 

 

25.1. Пошук існуючих 

з'єднань 

 
Найлегший спосіб установки налаштувань 

передачі даних - скористатися пошуком 

існуючих підключень за допомогою функції 

Search (Пошук). Додаткову інформацію про 

різні способи зв'язку див. в Розділі 25.2 

"З'єднання по локальній мережі" і в розділі 25.3 

"З'єднання по інтерфейсу RS232 ". 

 
• У діалоговому вікні Measurement Options 

(Налаштування вимірювань) натисніть кнопку 

Search (Пошук). 

 
➔ З'явиться діалогове вікно Devices 

(Пристрої). Діалогове вікно Devices 

містить перелік всіх підключених 

пристроїв: 

-  При пошуку вимірювального пристрою 

будуть відображені всі інтерфейси 

підключеного детектора (див. малюнок 

98). 

-  При пошуку вимірювального пристрою з 

приналежностями (блок керування або 

інклінометр) у верхній області будуть 

показані всі інтерфейси підключеного 

детектора, а в нижній області будуть 

показані всі підключені блоки управління 

або інклінометри (див. малюнок 99). 

 
• Якщо ніякі пристрої не знайдені, включіть 

параметр Advanced Search (Розширений 

пошук) в діалоговому вікні Devices (Пристрої) і 

повторіть пошук, натиснувши кнопку Search. 
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• В якості альтернативи можна налаштувати 

параметри передачі даних, згідно з 

інструкціями в розділі 25.2.3 "Налаштування 

з'єднання по локальній мережі вручну" і розділі 

25.3.2 "Налаштування з'єднання по 

інтерфейсу RS232 вручну ". 

 
• Клацніть на потрібному інтерфейсі 

детектора і приналежності (блок керування 

або інклінометр). 

 
• Натисніть ОК, щоб прийняти 

налаштування. Натискання кнопки Cancel 

(Скасування) відхилить ці налаштування. 

➔ Налаштування інтерфейсу обраного 

детектора і приналежності (блок 

керування або інклінометр) будуть 

відображені в діалоговому вікні 

Measurement Options (Налаштування 

вимірювання). 

 
Додаткову інформацію з проблем функції 

Search (Пошук) див. в розділі 25.2.4 "Усунення 

неполадок - з'єднання по локальної мережі". 

 
 

 

Малюнок 98. Діалогове вікно Devices (Пристрої) для пошуку 
вимірювального пристрою 

 

Малюнок 99. Діалогове вікно Devices (Пристрої) для пошуку 
вимірювального пристрою і приналежностей 
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25.2. З'єднання по 

локальній мережі 
 

З'єднання по локальній мережі можливе тільки 

для наступних пристроїв: 

- інтерфейс детектора з можливістю Ethernet- 

з'єднання 

- блок управління або поворотний блок. 
 

 
 

25.2.1. З'єднання через локальну 

мережу 

• Для цього потрібно підключити і пристрій, і 

комп'ютер до корпоративної локальної мережі 

за допомогою мережевих кабелів. 

 

➔ Пристрій автоматично отримає IP- 

адресу від мережевого сервера за 

допомогою служби DHCP. 

 
Необхідний мережевий кабель входить в 

комплект поставки пристрою. 

25.2.2. Пряме з'єднання по 

інтерфейсу локальної мережі 

• З'єднайте пристрій з комп'ютером 

мережевим кабелем. 

Для з'єднання можна використовувати 

внутрішню мережеву карту комп'ютера або 

іншу мережеву карту. 

• Увімкніть пристрій. 

 
➔ Оскільки пристрій не може знайти 

сервер DHCP, пристрій автоматично 

призначить собі IP-адресу в діапазоні 

169.254.x.x через функцію AutoIP. 

 
• Пристрій і комп'ютер повинні бути в одній 

підмережі, тобто їх IP-адреси повинні бути в 

одному діапазоні. 

Для цього мережева карта комп'ютера також 

повинна призначити собі IP-адресу в діапазоні 

169.254.x.x через AutoIP, або ви повинні 

налаштувати IP-адресу мережевої карти 

вручну. 
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25.2.3. Налаштування з'єднання 

по локальній мережі вручну 

 
• У діалоговому вікні Measurement Options 

(Налаштування вимірювань) на вкладці 

Devices (Пристрої) натисніть відповідну кнопку 

Edit (Змінити) для інтерфейсу детектора або 

блоку управління. 

 

➔ На екрані з'явиться діалогове вікно Edit 

Connection (Редагування з'єднання): 
 

Малюнок 100. Діалогове вікно зміни 
налаштувань для з'єднання по 
локальній мережі 

• Налаштуйте параметри, необхідні для 

з'єднання: 

Type (Тип): 

LAN (локальна мережа) 

Name (Ім'я): 

визначене користувачем ім'я з'єднання 

IP_Address (IP-адреса): 

адреса пристрою в мережі 

 
або 

• Перевірте з'єднання, натиснувши кнопку 

Check (Перевірка). 

 
• Підтвердити налаштування натисканням 

кнопки OK. 

 
• Налаштування інтерфейсу обраного 

детектора будуть відображені в діалоговому 

вікні Measurement Options (Налаштування 

вимірювання). 

 

• Виконайте пошук існуючих з'єднань по 

локальній мережі за допомогою функції Search 

(Пошук), згідно з інструкціями в розділі 25.1 

"Пошук існуючих з'єднань". 

В цьому випадку в діалоговому вікні Devices 

(Пристрої) будуть показані тільки пристрої, 

з'єднані по інтерфейсу Ethernet. 



 
 
 
 

 

25.2.4. Усунення несправностей - 

з'єднання по локальній мережі 

 
Пристрій з'єднано через локальну мережу або 

з'єднано мережевим кабелем прямо з 

комп'ютером, але не виявляється за 

допомогою функції Search (Пошук). 

 
1. Брандмауер Windows перешкоджає пошуку 

пристрою (широкомовній передачі). У цьому 

випадку буде відображене відповідне 

повідомлення. 

Дозвольте в брандмауері Windows мережеві 

запити програмного забезпечення VeriSoft: 

 
• Виберіть вид за категоріями. 

 
• Виберіть Пуск → Панель управління → 

Система і безпека → Брандмауер Windows. 

 
• Виберіть Увімкнути / вимкнути 

брандмауер Windows. 

 
• Вимкніть брандмауер Windows. 

3. У разі прямого з'єднання через інтерфейс 

локальної мережі IP-адреси пристрою і 

комп'ютера не належать одній підмережі 

(діапазон 169.254.x.x). 

Ви повинні налаштувати мережеву карту 

комп'ютера вручну. 

 
Додаткову інформацію див. У технічній 

документації "How to Set Up Network 

Communication" (Як налаштувати мережеві 

комунікації) і "How to Set Up a Network 

Connection" (Як налаштувати мережеві 

з'єднання) на установчому компакт-диску 

VeriSoft або зверніться в PTW. 

 

 

Відключення брандмауера Windows буде 

діяти тільки в цьому сеансі. Після 

перезавантаження комп'ютера і запуску 

нового пошуку за допомогою функції Search 

(Пошук) вам доведеться знову вимкнути 

брандмауер Windows. 
 

 

 
2. У разі прямого з'єднання через інтерфейс 

локальної мережі виникає проблема зв'язку. 

В залежност від мережевої карти комп'ютера 

можна з'єднати пристрій з комп'ютером за 

допомогою мережевого кабелю з 

перехресним адаптером або за допомогою 

перехресного  мережевого  кабелю. 

Перехресний адаптер можна замовити в PTW 

(номер для замовлення L178090). 

ПРИМІТКА 
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25.3. З'єднання по 

інтерфейсу RS232 
 

З'єднання по інтерфейсу RS232 можливе для 

наступних пристроїв: 

- інтерфейс детектора 

- інклінометр 
 

 
 

25.3.1. З'єднання по інтерфейсу 

RS232 

• З'єднайте пристрій прямо з комп'ютером за 

допомогою кабелю RS232. 

 
Необхідний кабель RS232 входить в комплект 

поставки пристрою. 

 

 

25.3.2. Налаштування з'єднання 

по інтерфейсу RS232 вручну 

• У діалоговому вікні Measurement Options 

(Налаштування вимірювань) на вкладці 

Devices (Пристрої) натисніть відповідну кнопку 

Edit (Змінити) для інтерфейсу детектора або 

інклінометра. 

 

➔ На екрані з'явиться діалогове вікно Edit 

Connection (Редагування з'єднання): 
 

Малюнок 101. Діалогове вікно зміни 
налаштувань для з'єднання 
RS232 

 

• Налаштуйте параметри, необхідні для 

з'єднання: 

Type (Тип) : RS232 

Name (Ім'я) : визначене користувачем ім'я 

з'єднання 

COM : використовуваний COM-порт 

або 

• Виконайте пошук існуючих з'єднань по 

інтерфейсу RS232 за допомогою функції 

Search (Пошук), згідно з інструкціями в розділі 

25.1 "Пошук існуючих з'єднань". 

В цьому випадку в діалоговому вікні Devices 

(Пристрої) будуть показані тільки пристрої, 

з'єднані по інтерфейсу RS232. 

 
• Перевірте з'єднання, натиснувши кнопку 

Check (Перевірка). 

 
• Підтвердіть налаштування натисканням 

кнопки OK. 

 
➔ Налаштування інтерфейсу RS232 

обраного детектора будуть відображені 

в діалоговому вікні Measurement Options 

(Налаштування вимірювання). 

 

 
25.3.3. Усунення несправностей - 

з'єднання по інтерфейсу 

RS232 

 
У випадку проблем зі зв'язком див. розділ 26 

"Повідомлення про помилки та усунення 

несправностей". 



 
 

26. Повідомлення про помилки та усунення 
несправностей 

 
Що можна зробити, якщо ... 

 

 
... ізодози не помітні 

Перевірте рівні ізодоз через меню Graphics → Edit Contour Settings 

(Графіка - Зміна налаштувань контуру). 

... число оцінених точок 

доз (Evaluated Dose Points) 

сильно відрізняється від 

числа точок доз? 

 
 

Перевірте налаштоване значення порога у спливаючому вікні 

Compare (Порівняння) вікна порівняння. 

... контрастність 

зображення у відтінках 

сірого не оптимальна 

Використовуйте повзунок у спливаючому вікні Contrast 

(Контрастність) відповідного вікна матриці, щоб налаштувати 

діапазон відображення. 

... режим Zoom 

(Збільшення) 

недоступний? 

 
Режим Zoom доступний, якщо тільки завантажені дві матриці. 

 

 
... представлення 

Histogram (Гістограма) 

або Results (Результати) 

недоступні 

Ці оцінки можливі, якщо тільки завантажені дві матриці, причому 

обидві матриці виражені в однакових одиницях вимірювання. 

- Щоб змінити одиницю вимірювання, виберіть функцію Calibrate 

(Вирівнювання). 

-  Щоб автоматично узгодити значення [Gy] (Гр), [mGy] (мГр) або 

[сGy] (сГр) під час завантаження, використовуйте параметр 

Convert to dose (Перетворити в дозу) в діалоговому вікні 

параметрів. 

... неможливо встановити 

профілі в матрицях 

Майте на увазі, що профіль може бути встановлений тільки в 

позиції, яка доступна в обох матрицях. 

... функція Undo 

(Скасувати дію) 

недоступна 

Скасування дії (Undo) неможливе для функцій Defining the region of 

interest, ROI (Визначення області інтересу, ROI), а також Rotating 

through an arbitrary angle, Rotate (Поворот на довільний кут). 

 
 
 

... функції обробки 

зображення недоступні 

Перевірте режим. 

Ці функції недоступні в режимі Zoom (Збільшення). 

Альтернативний спосіб: спочатку виберіть представлення Zoom 

(Збільшення), а потім виберіть пункт контекстного меню Reset 

(Скидання), щоб повернутися до вихідного представленням 

матриць. 
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... вимірювальна камера 

матричного детектора стає 

дефектною (наприклад, 

вимірювальна камера на 

малюнку 102) 

 
Дефектні вимірювальні камери можуть бути заблоковані за 

допомогою програми PTW ArrayCal. У цьому випадку значення 

для невиміряної позиції розраховується інтерполяцією виміряних 

значень для сусідніх камер. 

 
Додаткову інформацію див. в Інструкції користувача ArrayCal. 

 

 

 

Малюнок 102. Вікно матриці, в якому показано вимірювання з детектором OCTAVIUS Detector 
1000 SRS 

 
1  Позиція вимірювання з відхиленням виміряного значення 



 
 
 
 

 
 
 
 
 

... виникають проблеми 

зв'язку? 

  
Ці відповіді відносяться до матричного детектору, з'єднаного по 

інтерфейсу RS232. 

При використанні довгих кабелів (> 20 м) або повільних драйверів 

інтерфейсу ПК можуть виникати проблеми зв'язку у деяких 

комп'ютерів з високою швидкістю передачі даних (115200 бод). 

Іноді допомагає використання іншого інтерфейсу RS232 (якщо є). 

Або виконайте наступні дії: 

 
• PTW рекомендує використовувати з'єднання по локальній 

мережі (Див. розділ 25 "Налаштування для передачі даних"). 

 
• Якщо це неможливо, може допомогти перехідник USB-RS232 

(наприклад, перехідник LINDY USB-RS232, номер для замовлення 

PTW: L242064). 

 
• Можна також включити параметр Reduce RS232 Baudrate 

(Зменшити швидкість передачі даних через RS232), див. розділ 

23.2.1 "Вибір вимірювальних пристроїв"). Тоді VeriSoft буде 

встановлювати швидкість передачі даних <115200 бод, і тому 

деякі інтервали часу вимірювання більше не будуть доступні. 

 

ПРИМІТКА 

Якщо програма показує порушення зв'язку, то повторна активація 

з'єднання може не мати успіху. Щоб усунути порушення, слід 

тимчасово вибрати більш короткий кабель (<3 м). 



VeriSoftTM 

Загальні відомості 

 

 
 
 

 
 
 

 
... на екрані програми 

VeriSoft виникають 

артефакти (наприклад, 

кольори тексту і фону 

виявляються подібними 

або однаковими). 

 
Перевірте налаштування екрану в панелі управління: 

 
Windows 7: 

 
• Виберіть Пуск → Панель управління → Оформлення та 

персоналізація → Персоналізація. 

або 

Виберіть Персоналізація в контекстному меню робочого столу. 

 
• Виберіть одну із зазначених нижче колірних схем. Компанія 

PTW рекомендує наступні схеми: 

- Windows 7 - спрощений стиль 

- Класична Windows. 

 
Windows 8 / Windows 8.1 / Windows 10: 

 
• Виберіть Панель управління → Оформлення та персоналізація 

→ Персоналізація. 

або 

Виберіть Персоналізація в контекстному меню робочого столу. 

 
• Виберіть колірну схему «Windows», рекомендовану компанією 

PTW. 

 
 

 
... текст, значки або 

VeriSoft 

не відображаються 

повністю? 

 
Перевірте налаштування розміру шрифту в панелі управління: 

 
Windows 7: 

• Виберіть Пуск → Панель управління → Оформлення та 

персоналізація → Екран. 

• Виберіть варіант Дрібний - 100% (за замовчуванням). 

 
Windows 8 / Windows 8.1: 

• Виберіть пункт меню Панель управління → Оформлення та 

персоналізація → Екран. 

• Виберіть варіант Дрібний - 100% (за замовчуванням). 

 
Windows 10: 

• Виберіть пункт меню Панель управління → Оформлення та 

персоналізація → Екран. 

• Виберіть розмір 100% (рекомендований). 
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Додаток A. Перелік даних, експортованих з VeriSoft 
в Track-it 

 
Під час експорту з програми VeriSoft в базу даних Track-it будуть експортуватися дані, представлені 

в наступному переліку, якщо вони можуть бути застосовані для порівняння. 

 

 
Властивості 

 

Назва Тип значення 

Measuring device (Вимірювальний прилад) Текст 

Software (Програмне забезпечення) Текст 

Radiation unit (Джерело випромінювання) Текст 

 
 

Параметри вимірювань 

 

Назва Одиниця Тип значення 

вимірювання 

Class name (Ім'я класу) --- Текст 

Distance to agreement criteria (Відстань до заданої точки) мм 
Число з плаваючою 
комою 

Dose difference criteria (Умови різниці доз) % 
Число з плаваючою 
комою 

Dose difference reference (Референтна різниця доз) --- Текст 

Dose difference reference value (Референтне значення 
різниці доз) 

Гр 
Число з плаваючою 
комою 

Dose evaluation threshold (Поріг для оцінки дози) % 
Число з плаваючою 
комою 

Gamma calculation algorithm (Алгоритм розрахунку гамма) --- Текст 

Gamma index calculation (Розрахунок гамма-індексу) --- Текст 

Increased dose criteria threshold (Збільшений поріг для дози) Гр 
Число з плаваючою 
комою 

Increased dose difference criteria (Збільшена умова різниці 
доз) 

% 
Число з плаваючою 
комою 

Matrix compare mode (Режим порівняння матриць) --- Текст 



 
 

 
Точки даних 

 

Назва Одиниця Тип значення 

вимірювання 

Gamma passing rate (Гамма: частка проходження) % 
Число з плаваючою 
комою 

Max. absolute dose difference (Макс. абсолютна різниця доз) Гр 
Число з плаваючою 
комою 

Max. difference of norm. value (Макс. різниця від 

нормалізованого значення) 
% 

Число з плаваючою 
комою 

Max. gamma value (Макс. значення гамма) --- 
Число з плаваючою 
комою 

Max. local difference (Макс. локальна різниця) % 
Число з плаваючою 
комою 

Mean absolute dose difference (Середня абсолютна різниця 

доз) 
Гр 

Число з плаваючою 
комою 

Mean difference of norm. value (Середня різниця від 

нормалізованого значення) 
% 

Число з плаваючою 
комою 

Mean gamma value (Середнє значення гамма) --- 
Число з плаваючою 
комою 

Mean local difference (Середня локальна різниця) % 
Число з плаваючою 
комою 

Median absolute dose difference (Медіана абсолютної різниці 

доз) 
Гр 

Число з плаваючою 
комою 

Median difference of norm. value (Медіана різниці від 

нормалізованого значення) 
% 

Число з плаваючою 
комою 

Median gamma value (Медіана значення гамма) --- 
Число з плаваючою 
комою 

Median local difference (Медіана локальної різниці) % 
Число з плаваючою 
комою 

Min. absolute dose difference (Мінімальна абсолютна 

різниця доз) 
Гр 

Число з плаваючою 
комою 

Min. difference of norm. value (Мінімальна різниця від 

нормалізованого значення) 
% 

Число з плаваючою 
комою 

Min. gamma value (Мінімальне значення гамма) --- 
Число з плаваючою 
комою 

Min. local difference (Мінімальна локальна різниця) % 
Число з плаваючою 
комою 

Passing rate (Частка проходження) % 
Число з плаваючою 
комою 

Volume gamma passing rate (Об'ємна гамма: частка 

проходження) 
% 

Число з плаваючою 
комою 
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Дані вимірювання 
 
 

Назва Одиниця Тип значення 

вимірювання 

Accessory data set A (Приналежність - набір даних A) --- Текст 

Accessory data set В (Приналежність - набір даних B) --- Текст 

Comparison result.jpg (Результат порівняння.jpg) --- Файл 

Compose offset data set A (Складання зсувів - набір даних 
A) 

мм 
Число з плаваючою 
комою 

Compose offset data set B (Складання зсувів - набір даних 
B) 

мм 
Число з плаваючою 
комою 

Couch angle data set A <x> (Кут повороту столу - набір 
даних A) 

° 
Число з плаваючою 
комою 

Couch angle data set B <x> (Кут повороту столу - набір 
даних B) 

° 
Число з плаваючою 
комою 

Data set A file <x> (Файл набору даних A <x>) --- Текст 

Data set B file <x> (Файл набору даних B <x>) --- Текст 

Dose distribution <slice orientation> slice data set A.jpg 
(Розподіл дози <орієнтація зрізу> - набір даних зрізу A.jpg) 

--- Файл 

Dose distribution <slice orientation> slice data set B.jpg 
(Розподіл дози <орієнтація зрізу> - набір даних зрізу B.jpg) 

--- Файл 

Evaluated dose points (Оцінені точки доз) --- Ціле число 

Evaluated dose points (relative) (Оцінені точки доз 
(відносно)) 

% 
Число з плаваючою 
комою 

Gamma 3D volume histogram.jpg (Гістограма об'єму в 
режимі Gamma 3D.jpg) 

--- Файл 

Gamma 2D / 3D histogram.jpg (Гістограма в режимах 
Gamma 2D / 3D.jpg) 

--- Файл 

Institution (Установа) --- Текст 

Location of max. absolute dose difference (Розташування 
макс. абсолютної різниці доз) 

мм Текст 

Location of max. difference of norm. value (Розташування 
макс. різниці від нормалізованого значення) 

мм Текст 

Location of max. gamma value (Розташування макс. 
значення гамма) 

мм Текст 

Location of max. local difference (Розташування макс. 
локальної різниці) 

мм Текст 

Location of min. absolute dose difference (Розташування мін. 
абсолютної різниці доз) 

мм Текст 

Location of min. difference of norm. value (Розташування мін. 
різниці від нормалізованого значення) 

мм Текст 

Location of min. gamma value (Розташування мін. значення 
гамма) 

мм Текст 

Location of min. local difference (Розташування мін. 
локальної різниці) 

мм Текст 

Measuring device data set A (Вимірювальний прилад - набір 
даних A) 

--- Текст 



 

Назва Одиниця Тип значення 

вимірювання 

Measuring device data set B (Вимірювальний прилад - набір 
даних B) 

--- Текст 

Off-axis shift data set A (Зсув від осі - набір даних A) мм 
Число з плаваючою 
комою 

Off-axis shift data set B (Зсув від осі - набір даних B) мм 
Число з плаваючою 
комою 

Passing criteria: DoN (Умова проходження: різниця в % від 
реф. норм. значення) ≤ 

--- 
Число з плаваючою 
комою 

Passing criteria: Gamma (Умова проходження: гамма) ≤ --- 
Число з плаваючою 
комою 

Passing criteria: Local% Diff (Умова проходження: локальна 
різниця в %) ≤ 

--- 
Число з плаваючою 
комою 

Patient ID (Ідентифікатор пацієнта) --- Текст 

Patient name (Пацієнт – ім'я) --- Текст 

PDD file <x> data set A (Файл PDD <x> набір даних A) --- Текст 

PDD file <x> data set B (Файл PDD <x> - набір даних B) --- Текст 

Phantom length data set A (Довжина фантома - набір даних 
A) 

мм 
Число з плаваючою 
комою 

Phantom length data set B (Довжина фантома - набір даних 
B) 

мм 
Число з плаваючою 
комою 

Physicist (Медичний фізик) --- Текст 

Relative electron density (reconst.) Data set A 
(Відносна щільність електронів (реконстр.) - набір даних A) 

--- 
Число з плаваючою 
комою 

Relative electron density (reconst.) Data set B 
(Відносна щільність електронів (реконстр.) - набір даних B) 

--- 
Число з плаваючою 
комою 

SDD data set A (SDD - набір даних A) мм 
Число з плаваючою 
комою 

SDD data set B (SDD - набір даних B) мм 
Число з плаваючою 
комою 

Slice orientation data set A (Орієнтація зрізу - набір даних A) --- Текст 

Slice orientation data set B (Орієнтація зрізу - набір даних B) --- Текст 

Slice position data set A (Положення зрізу набору даних A) мм 
Число з плаваючою 
комою 

Slice position data set B (Положення зрізу набору даних B) мм 
Число з плаваючою 
комою 

Software ID <x> 
(Ідентифікатор програмного забезпечення <x>) 

--- Текст 

Total dose points (Загальна кількість точок доз) --- Ціле число 

VeriSoft project.vsp (Проект VeriSoft.vsp) --- Файл 

Volume compare isodose levels.csv 
(Файл порівняння - рівні ізодоз в об'ємі) 

--- Файл 

Voxel side length (reconst.) Data set A 
(Довжина сторони воксела (реконстр.) - набір даних A) 

мм 
Число з плаваючою 
комою 

Voxel side length (reconst.) Data set B 
(Довжина сторони воксела (реконстр.) - набір даних B) 

мм 
Число з плаваючою 
комою 
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ПРИМІТКА 

 програмним забезпеченням  
 
 

 

Додаток B. Створення файлів PDD зі сторонніми 
пристроями і стороннім програмним 
забезпеченням 

 

 

Вимірювання кривих «глибина - доза» 

 
• Вимірювання кривих «глибина - доза» з 

наступними налаштуваннями: 

 
- SSD (відстань джерело - поверхня): 

85 см 

 
- обов'язкові розміри поля: 

4 x 4 см, 5 x 5 см, 10 x 10 см, 15 x 15 см і 26 

x 26 см 

 
- необов'язкові розміри поля: 

2 x 2 см і 3 x 3 см 

 
- число точок вимірювання: 

рівновіддалені точки вимірювання з 

відстанню 2 мм 

 
- глибина вимірювання: 

від 0 мм до 300 мм 

 
• Збережіть виміряні значення всіх кривих 

«глибина - доза» в таблиці (наприклад, в 

Microsoft Excel). 

 

 
Перетворення в формат PTW 

 
Виміряні криві «глибина - доза» необхідно 

перетворити в формат PTW. 

• Запустіть програму TPR/TMR and OCR 

Table Generator (Генератор таблиць TPR / 

TMR і OCR) з навігатора MEPHYSTO або 

через меню Start (Пуск) → Program Files → 

PTW → VeriSoft → TableGenerator. 

• Відкрийте один з файлів PDD в каталозі 

<PTW documents> \ VeriSoft \ Data \ PDDData. 
 

За замовчуванням файли PDD 

відповідають відстані джерело - поверхня 

(SSD) 85 або 92 см. Якщо вимірювання 

необхідно виконати при іншому значенні 

SSD, вам слід вручну змінити значення 

параметра SSD в файлі MCC за допомогою 

програми-редактора. Можливість 

автоматичного налаштування SSD в 

програмі TableGenerator відсутня. 
 

 
• Збережіть файл PDD під новим ім'ям. 

 
• Закрийте файл PDD за замовчуванням і 

відкрийте свою копію. 

 
• Видаліть всі стовпці розмірів полів від 

0 x 0 см по 3 x 3 см, від 6 x 6 см до 9 x 9 см, від 

11 x 11 см до 14 x 14 см і від 16 x 16 см до 25 x 

25 см за допомогою клавіші Delete. 

 
• Скопіюйте виміряні значення з таблиці у 

відповідний стовпець в програмі 

TableGenerator. Переконайтеся, що глибини 

вимірювання і виміряні значення у вашій 

таблиці відповідають значенням в програмі 

TableGenerator. 

 
• Збережіть файл. 

 
• Завершіть роботу програмного 

забезпечення. 



програмним забезпеченням 

 
 

 

Завершення файлу PDD 

 
• Запустіть програму TPR / TMR and OCR 

Table Generator (Генератор таблиць TPR / 

TMR і OCR) з навігатора MEPHYSTO або 

через меню Start (Пуск) → Program Files → 

PTW → VeriSoft → TableGenerator. 

 
• Відкрийте mcc-файл, який містить криві 

«глибина - доза». 

 
• Нормалізуйте криві «глибина - доза», 

вибравши меню Scans → Normalize → to 

Individual Maximum (Скан - Нормалізувати - За 

окремим максимуму). 

 
• Збережіть нормалізовані значення. 

 
• Для можливості працювати з 

нормалізованими значеннями потрібно 

закрити файл і відкрити його знову. 

 
• Екстраполюйте значення для 

розміру поля 0 x 0 см. 

Для цього виберіть меню Scans→ 

Extrapolate to 0 x 0 cm² (Скан - 

Екстраполювати для 0 x 0 см²) або 

клацніть на кнопці Extrapolate 

(Екстраполювати). 

➔ Значення для розміру поля 0 x 0 см 

будуть розраховані і вставлені як новий 

стовпець з синім шрифтом. 

• Інтерполюйте значення для всіх 

відсутніх розмірів поля з кроком 1 см. 

Для цього виберіть меню Scans→ 

Interpolate → Columns (Скан - 

інтерполювати - Стовпці) або клацніть 

на кнопці Columns (Стовпці). 

➔ На екрані з'явиться діалогове вікно 

Interpolate Columns (Інтерполяція 

стовпців): 

 

Малюнок 103. Діалогове вікно інтерполяції 
стовпців 

 
• Налаштуйте значення в діалоговому вікні 

Interpolate Columns (Інтерполяція стовпців) 

відповідно до малюнку 103. 

 
• Підтвердіть налаштування натисканням 

кнопки OK. 

 
➔ Значення для відповідного розміру поля 

будуть розраховані і вставлені як нові 

стовпці з синім шрифтом. 

 
• Нормалізуйте криві «глибина - доза», 

вибравши меню Scans → Normalize → to 

Individual Maximum (Скан - Нормалізувати - За 

окремим максимуму). 

 
• Збережіть завершення файли PDD в 

каталозі 

<PTW documents> \ VeriSoft \ Data \ PDDData. 

 
• Створіть файл PDD для кожного джерела 

випромінювання і кожної енергії. Дайте 

файлам PDD зрозумілі однозначні імена 

(Наприклад, X06Linac1.mcc). 

 
• Завершіть роботу програмного 

забезпечення. 
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Додаток C. Таблиці поправок для корекції кута в 
разі вимірювань інклінометром 

 
 

 

Створення таблиць поправок для корекції 

кута є виключним обов'язком користувача. 
 

 
Таблиця поправок для корекції кута може бути 

створена в програмі електронних таблиць 

(наприклад, Microsoft Excel) або в редакторі. 

 
Використовуйте табулятори як роздільники 

полів і збережіть таблицю поправок у вигляді 

текстового файлу з роздільниками - 

табуляторами з розширенням *.cot. 

 

 
Таблиця поправок повинна мати наступну 

структуру (див. також малюнок 104): 

 
- Рядок 1 завжди повинен мати заголовок 

PTW Angle Correction Table (Таблиця корекції 

кута PTW). 

 
- Рядок 2 завжди повинен містити 

ptwDetectorKey (ключ детектора PTW). 

Можливі наступні ключі ptwDetectorKey: 

- Octavius_729 

- Octavius_729XDR 

- Octavius_1000 

- Octavius_1500 

- Octavius_1500XDR 

- Octavius_1500MR 

- 2DArray_729 

- 2DArray_729XDR 

Таблиці поправок з версії VeriSoft < 6.0, які 

були створені за допомогою PTWDeviceKeys 

все ще можуть використовуватися. 
 

 
- Рядки 3 та 4 можуть містити призначені для 

користувача записи або вони можуть бути 

порожніми. 

 
- Рядки з 5 до рядка x містять значення 

поправок. 

- Для кожного стовпця матричного детектора 

повинен бути створений стовпець в 

таблиці поправок. Ім'я стовпця містить 

відстань між вимірювальною камерою і 

центральною камерою в негативному або 

позитивному напрямку. У наступній таблиці 

містяться імена стовпців для відповідних 

матричних детекторів. 

 
-  Рядки з 6 до рядка x містять значення 

поправок для потрібних діапазонів кута. 

Значення поправки завжди відноситься до 

одного стовпця матричного детектора. 

Діапазони кута можуть бути визначені 

користувачем. Можна встановити до 360 

діапазонів кута. 

Приклад. 

Є значення поправки для 15° і 30°: 

Таке ж значення поправки, введене для 

30°, буде призначене всім кутам від 15° до 

≤ 30°. 

Інтерполяція не проводитиметься. 



 
 
 
 

Матричний детектор Відстані Назви стовпців 

вимірювальних 

камер 

OCTAVIUS Detector 729 
10 мм -130 / -120 / -110 / -100 / ... / 100/110/120/130 

2D-ARRAY 

OCTAVIUS Detector 1000 SRS 2,5 мм -55 / -52,5 / -50 / -47,5 / ... / 47,5 / 50 / 52,5 / 55 

OCTAVIUS Detector 1500 5 мм -130 / -125 / -120 / -115 / ... / 115/120/125/130 

 
 

 

 

Малюнок 104. Приклад таблиці поправок для корекції кута детектора OCTAVIUS Detector 729 
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Додаток D. Налаштування для вимірювання з 2D- 
ARRAY XDR 

 
 
 

Зміна електричного поправочного коефіцієнта 

Capacity (Потужність) і коефіцієнта посилення 

GainFactor в файлі конфігурації BeamAdjust 

.xml описано нижче. 

 
Змінюйте ці коефіцієнти тільки в разі 2D- 

ARRAY XDR. 

 
Не змінюйте ці коефіцієнти для інших 

матричних детекторів. 
 

Вимірювання без коригування електричного 

поправочного коефіцієнта Capacity (Потуж- 

ність) і коефіцієнта посилення GainFactor в 

файлі конфігурації BeamAdjust.xml. 

 
Помилкові вимірювання! 

 
У файл конфігурації BeamAdjust.xml введено 

типовий електричний поправочний коефіцієнт 

і коефіцієнт посилення. Ці коефіцієнти 

залежать від апаратної конфігурації системи. 

 
Перед вимірюванням перевірте електричний 

поправочний коефіцієнт Capacity (Потужність) 

і коефіцієнт посилення GainFactor в цьому 

файлі конфігурації і внесіть коригування, якщо 

потрібно. 

 
Правильний електричний поправочний 

коефіцієнт Capacity (Потужність) ви можете 

знайти в сертифікаті калібрування вашого 

пристрою 2D-ARRAY XDR. 

 
Коефіцієнт посилення GainFactor для 

введення дорівнює 1460E-3. 

 

 

Несанкціоновані зміни налаштувань. 

 
Неправильне функціонування! Помилкові 

вимірювання! 

 
В файлі конфігурації BeamAdjust.xml можна 

змінювати тільки налаштування параметрів, 

що описані нижче. 

Зміна інших параметрів може викликати 

неправильне функціонування VeriSoft і 

помилкові вимірювання. 
 

 
Файл конфігурації BeamAdjust.xml знаходить- 

ся в каталозі даних програми 

<PTW application files> \ VeriSoft \ VeriSoft. 

 
• Переконайтеся, що програма VeriSoft 

закрита. 

 
• Відкрийте файл конфігурації 

BeamAdjust.xml в текстовому редакторі 

(Наприклад, Editor). 

 
В файлі конфігурації BeamAdjust.xml міститься 

окрема область для кожного матричного 

детектора з відповідними параметрами (див. 

малюнок 105). 

• Виберіть область введення для 2D- 

ARRAYXDR (1). 

 
• Введіть коефіцієнт посилення GainFactor 

(2) 1460E-3. 

 
• Введіть електричний поправочний 

коефіцієнт Capacity (2), який ви можете знайти 

в сертифікаті калібрування вашого пристрою 

2D-ARRAY XDR. 

 
• Збережіть змінений файл з тим же ім'ям 

файлу в тому ж каталозі. 

ПОПЕРЕДЖЕННЯ 
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Малюнок 105. Файл конфігурації - область налаштувань для 2D-ARRAYXDR 

 
1 Виберіть область введення для 2D-ARRAYXDR 

2 Рядки, в яких встановлені коефіцієнт посилення і потужність 2D-ARRAYXDR 

  


